Red Hat CodeReady Workspaces 2.5 End-user Guide

Using Red Hat CodeReady Workspaces 2.5

Robert Kratky
rkratky@redhat.com

Michal Maléř
mmaler@redhat.com

Fabrice Flore-Thébault
ffloreth@redhat.com

Yana Hontyk
yhontyk@redhat.com
Abstract

Information for users using Red Hat CodeReady Workspaces.
# Table of Contents

**MAKING OPEN SOURCE MORE INCLUSIVE** ................................................. 8

**CHAPTER 1. NAVIGATING CODEREADY WORKSPACES** ................................................................. 9

1.1. NAVIGATING CODEREADY WORKSPACES USING THE DASHBOARD .............................................. 9

   1.1.1. Logging in to CodeReady Workspaces on OpenShift for the first time using OAuth .................. 9

   1.1.2. Logging in to CodeReady Workspaces on OpenShift for the first time registering as a new user .... 9

   1.1.3. Finding CodeReady Workspaces cluster URL using the OpenShift 4 CLI ............................... 10

1.2. IMPORTING CERTIFICATES TO BROWSERS .............................................................................. 10

   1.2.1. Adding certificates to Google Chrome on Linux or Windows .................................................. 10

   1.2.2. Adding certificates to Google Chrome and Safari on macOS .................................................. 11

   1.2.3. Adding certificates to Firefox .................................................................................................. 11

1.3. ACCESSING CODEREADY WORKSPACES FROM OPENSHIFT DEVELOPER PERSPECTIVE ......... 12

   1.3.1. OpenShift Developer Perspective integration with CodeReady Workspaces ............................. 12

   1.3.2. Editing the code of applications running in OpenShift Container Platform using CodeReady Workspaces ............................................................................................................ 13

   1.3.3. Accessing CodeReady Workspaces from Red Hat Applications menu .................................... 14

**CHAPTER 2. CHE-THEIA IDE BASICS** ...................................................................................... 15

2.1. DEFINING CUSTOM COMMANDS FOR CHE-THEIA .................................................................... 15

   2.1.1. Che-Theia task types ................................................................................................................. 15

   2.1.2. Running and debugging ........................................................................................................... 16

   2.1.3. Editing a task and launch configuration ...................................................................................... 20

2.2. VERSION CONTROL .................................................................................................................. 21

   2.2.1. Managing Git configuration: identity .......................................................................................... 21

   2.2.2. Accessing a Git repository using HTTPS .................................................................................... 22

   2.2.3. Accessing a Git repository using a generated SSH key pair ...................................................... 23

   2.2.3.1. Generating an SSH key using the CodeReady Workspaces command palette ...................... 23

   2.2.3.2. Adding the associated public key to a repository or account on GitHub ............................... 23

   2.2.3.3. Adding the associated public key to a Git repository or account on GitLab .......................... 24

2.3. CHE-THEIA TROUBLESHOOTING .............................................................................................. 24

2.4. DIFFERENCES IN HOW CHE-THEIA WEBVIEW WORKS ON A SINGLE-HOST MODE COMPARING TO A MULTI-HOST MODE .................................................................................. 24

   2.4.1. What’s a Webview ....................................................................................................................... 24

   2.4.2. Webview in a multi-host mode .................................................................................................. 25

   2.4.3. Webview in single-host mode .................................................................................................... 25

**CHAPTER 3. DEVELOPER WORKSPACES** .................................................................................... 26

3.1. CONFIGURING A WORKSPACE USING A DEVFILE .................................................................... 27

   3.1.1. What is a devfile ......................................................................................................................... 27

   3.1.2. Creating a workspace from the default branch of a Git repository ......................................... 28

   3.1.3. Creating a workspace from a feature branch of a Git repository ............................................. 28

   3.1.4. Creating a workspace from a publicly accessible standalone devfile using HTTP ....................... 29

   3.1.5. Overriding devfile values using factory parameters ................................................................... 29

   3.1.6. Creating a workspace using crwctl and a local devfile ............................................................ 32

3.2. MAKING A WORKSPACE PORTABLE USING A DEVFILE ....................................................... 33

   3.2.1. A minimal devfile ....................................................................................................................... 33

   3.2.2. Generating workspace names .................................................................................................. 33

   3.2.3. Writing a devfile for a project .................................................................................................... 34

   3.2.3.1. Preparing a minimal devfile .................................................................................................... 34

   3.2.3.2. Specifying multiple projects in a devfile ............................................................................... 35

   3.2.4. Devfile reference ....................................................................................................................... 36

   3.2.4.1. Adding projects to a devfile .................................................................................................... 36
3.2.4.1.1. Project-source type: git
3.2.4.1.2. Project-source type: zip
3.2.4.1.3. Project clone-path parameter: clonePath
3.2.4.2. Adding components to a devfile
3.2.4.2.1. Component type: cheEditor
3.2.4.2.2. Component type: chePlugin
3.2.4.2.3. Specifying an alternative component registry
3.2.4.2.4. Specifying a component by linking to its descriptor
3.2.4.2.5. Tuning chePlugin component configuration
3.2.4.2.6. Component type: kubernetes
3.2.4.2.7. Overriding container entrypoints
3.2.4.2.8. Overriding container environment variables
3.2.4.2.9. Specifying mount-source option
3.2.4.2.10. Component type: dockerimage
3.2.4.2.11. Mounting project sources
3.2.4.2.12. Container Entrypoint
3.2.4.2.13. Persistent Storage
3.2.4.2.14. Specifying container memory limit for components
3.2.4.2.15. Specifying container memory request for components
3.2.4.2.16. Specifying container CPU limit for components
3.2.4.2.17. Specifying container CPU request for components
3.2.4.2.18. Environment variables
3.2.4.2.19. Endpoints
3.2.4.2.20. OpenShift resources
3.2.4.3. Adding commands to a devfile
3.2.4.3.1. CodeReady Workspaces-specific commands
3.2.4.3.2. Editor-specific commands
3.2.4.3.3. Command preview URL
3.2.4.3.3.1. Setting the default way of opening preview URLs
3.2.4.4. Devfile attributes
3.2.4.4.1. Attribute: editorFree
3.2.4.4.2. Attribute: persistVolumes (ephemeral mode)
3.2.4.4.3. Attribute: asyncPersist (asynchronous storage)
3.2.4.4.4. Attribute: mergePlugins
3.2.5. Objects supported in Red Hat CodeReady Workspaces 2.5
3.3. CREATING AND CONFIGURING A NEW CODEREADY WORKSPACES 2.5 WORKSPACE
3.3.1. Creating a new workspace from the dashboard
3.3.2. Adding projects to your workspace
3.3.3. Configuring the workspace and adding tools
3.3.3.1. Adding plug-ins
3.3.3.2. Defining the workspace editor
3.3.3.3. Defining specific container images
3.3.3.4. Adding commands to your workspace
3.4. IMPORTING A OPENSHIFT APPLICATION INTO A WORKSPACE
3.4.1. Including a OpenShift application in a workspace devfile definition
3.4.2. Adding a OpenShift application to an existing workspace using the dashboard
3.4.3. Generating a devfile from an existing OpenShift application
3.5. REMOTELY ACCESSING WORKSPACES
3.5.1. Remotely accessing workspaces using oc
3.5.2. Downloading and uploading a file to a workspace using the command-line interface
3.6. CREATING A WORKSPACE FROM CODE SAMPLE
3.6.1. Creating a workspace from Get Started view of User Dashboard
3.6.2. Creating a workspace from Custom Workspace view of User Dashboard
3.6.3. Changing the configuration of an existing workspace 74
3.6.4. Running an existing workspace from the User Dashboard 76
  3.6.4.1. Running an existing workspace from the User Dashboard with the Run button 76
  3.6.4.2. Running an existing workspace from the User Dashboard using the Open button 76
  3.6.4.3. Running an existing workspace from the User Dashboard using the Recent Workspaces 77
3.7. CREATING A WORKSPACE BY IMPORTING THE SOURCE CODE OF A PROJECT 78
  3.7.1. Select a sample from the Dashboard, then change the devfile to include your project 79
  3.7.2. Importing from the Dashboard into an existing workspace 79
    3.7.2.1. Editing the commands after importing a project 80
  3.7.3. Importing to a running workspace using the Git: Clone command 81
  3.7.4. Importing to a running workspace with git clone in a terminal 82
3.8. MOUNTING A SECRET AS A FILE OR AN ENVIRONMENT VARIABLE INTO A WORKSPACE CONTAINER 83
  3.8.1. Mounting a secret as a file into a workspace container 84
  3.8.2. Mounting a secret as an environment variable into a workspace container 86
  3.8.3. Mounting a git credentials store into a workspace container 88
  3.8.4. The use of annotations in the process of mounting a secret into a workspace container 89

CHAPTER 4. CUSTOMIZING DEVELOPER ENVIRONMENTS ........................................ 90
4.1. WHAT IS A CHE-THEIA PLUG-IN 90
  4.1.1. Features and benefits of Che-Theia plug-ins 91
  4.1.2. Che-Theia plug-in concept in detail 91
    4.1.2.1. Client-side and server-side Che-Theia plug-ins 91
    4.1.2.2. Che-Theia plug-in APIs 92
    4.1.2.3. Che-Theia plug-in capabilities 92
    4.1.2.4. VS Code extensions and Eclipse Theia plug-ins 93
  4.1.3. Che-Theia plug-in metadata 93
  4.1.4. Che-Theia plug-in lifecycle 98
  4.1.5. Embedded and remote Che-Theia plug-ins 99
    4.1.5.1. Embedded (local) plug-ins 99
    4.1.5.2. Remote plug-ins 100
    4.1.5.3. Comparison matrix 100
  4.1.6. Remote plug-in endpoint 101
    4.1.6.1. Defining a launch remote plug-in endpoint using Dockerfile 101
      4.1.6.1.1. Using a wrapper script 102
    4.1.6.2. Defining a launch remote plug-in endpoint in a meta.yaml file 103
  4.2. ADDING A VS CODE EXTENSION TO A WORKSPACE 105
    4.2.1. Adding a VS Code extension using the CodeReady Workspaces Plugins panel 105
    4.2.2. Adding a VS Code extension using the workspace configuration 105
  4.3. PUBLISHING METADATA FOR A VS CODE EXTENSION 106
  4.4. TESTING A VISUAL STUDIO CODE EXTENSION IN CODEREADY WORKSPACES 108
    4.4.1. Testing a VS Code extension using GitHub gist 108
    4.4.2. Verifying the VS Code extension API compatibility level 112
  4.5. USING ALTERNATIVE IDES IN CODEREADY WORKSPACES 113
  4.6. ADDING TOOLS TO CODEREADY WORKSPACES AFTER CREATING A WORKSPACE 113
    4.6.1. Additional tools in the CodeReady Workspaces workspace 114
    4.6.2. Adding a language support plug-in to a CodeReady Workspaces workspace 114
  4.7. EDITING A DEVFILE AND PLUG-IN AT RUNTIME 116
    4.7.1. Adding a plug-in at runtime 116
    4.7.2. Adding a devfile at runtime 117

CHAPTER 5. CONFIGURING OAUTH AUTHORIZATION ........................................ 119
5.1. CONFIGURING GITHUB OAUTH 119
5.2. CONFIGURING OPENSHIFT OAUTH

CHAPTER 6. USING ARTIFACT REPOSITORIES IN A RESTRICTED ENVIRONMENT

6.1. USING MAVEN ARTIFACT REPOSITORIES
   6.1.1. Defining repositories in settings.xml
   6.1.2. Defining Maven settings.xml file across workspaces
      6.1.2.1. Openshift 3.11 and OpenShift <1.13
   6.1.3. Using self-signed certificates in Maven projects

6.2. USING GRADLE ARTIFACT REPOSITORIES
   6.2.1. Downloading different versions of Gradle
   6.2.2. Configuring global Gradle repositories
   6.2.3. Using self-signed certificates in Gradle projects

6.3. USING PYTHON ARTIFACT REPOSITORIES
   6.3.1. Configuring Python to use a non-standard registry
   6.3.2. Using self-signed certificates in Python projects

6.4. USING GO ARTIFACT REPOSITORIES
   6.4.1. Configuring Go to use a non-standard registry
   6.4.2. Using self-signed certificates in Go projects

6.5. USING NUGET ARTIFACT REPOSITORIES
   6.5.1. Configuring NuGet to use a non-standard artifact repository
   6.5.2. Using self-signed certificates in NuGet projects

6.6. USING NPM ARTIFACT REPOSITORIES

CHAPTER 7. TROUBLESHOOTING CODEREADY WORKSPACES

7.1. VIEWING CODEREADY WORKSPACES WORKSPACES LOGS
   7.1.1. Viewing logs from language servers and debug adapters
      7.1.1.1. Checking important logs
      7.1.1.2. Detecting memory problems
      7.1.1.3. Logging the client-server traffic for debug adapters
   7.1.1.4. Viewing logs for Python
   7.1.1.5. Viewing logs for Go
      7.1.1.5.1. Finding the gopath
      7.1.1.5.2. Viewing the Debug Console log for Go
      7.1.1.5.3. Viewing the Go logs output in the Output panel
   7.1.1.6. Viewing logs for the NodeDebug NodeDebug2 adapter
   7.1.1.7. Viewing logs for Typescript
      7.1.1.7.1. Enabling the label switched protocol (LSP) tracing
      7.1.1.7.2. Viewing the Typescript language server log
      7.1.1.7.3. Viewing the Typescript logs output in the Output panel
   7.1.1.8. Viewing logs for Java
      7.1.1.8.1. Verifying the state of the Eclipse JDT Language Server
      7.1.1.8.2. Verifying the Eclipse JDT Language Server features
      7.1.1.8.3. Viewing the Java language server log
      7.1.1.8.4. Logging the Java language server protocol (LSP) messages
   7.1.1.9. Viewing logs for Intelephense
      7.1.1.9.1. Logging the Intelephense client-server communication
      7.1.1.9.2. Viewing Intelephense events in the Output panel
   7.1.1.10. Viewing logs for PHP-Debug
   7.1.1.11. Viewing logs for XML
      7.1.1.11.1. Verifying the state of the XML language server
      7.1.1.11.2. Checking XML language server feature flags
      7.1.1.11.3. Enabling XML Language Server Protocol (LSP) tracing
      7.1.1.11.4. Viewing the XML language server log
7.1.1.12. Viewing logs for YAML
7.1.1.12.1. Verifying the state of the YAML language server
7.1.1.12.2. Checking the YAML language server feature flags
7.1.1.12.3. Enabling YAML Language Server Protocol (LSP) tracing
7.1.1.12.4. Viewing YAML Language Server Protocol (LSP) logs in the Output panel
7.1.1.12.5. Viewing logs for Dotnet with NetcoredebugOutput plug-in
7.1.1.12.6. Verifying the state of the NetcoredebugOutput plug-in
7.1.1.12.7. Viewing NetcoredebugOutput plug-in logs in the Output panel
7.1.1.12.8. Viewing logs for Camel
7.1.1.12.9. Verifying the state of the Camel language server
7.1.1.12.10. Viewing Camel logs in the Output panel
7.1.1.13. Viewing logs for Dotnet with Omnisharp-Theia plug-in
7.1.1.13.1. Omnisharp-Theia plug-in
7.1.1.13.2. Verifying the state of the Omnisharp-Theia plug-in language server
7.1.1.13.3. Checking Omnisharp Che-Theia plug-in language server features
7.1.1.13.4. Viewing Omnisharp-Theia plug-in logs in the Output panel
7.1.1.13.5. Viewing logs for Camel
7.1.1.13.6. Verifying the state of the Camel language server
7.1.1.13.7. Viewing Camel logs in the Output panel
7.1.1.13.8. Viewing Che-Theia IDE logs
7.1.1.13.9. Viewing Che-Theia editor logs using the OpenShift CLI
7.2. TROUBLESHOOTING SLOW WORKSPACES
7.2.1. Improving workspace start time
7.2.2. Improving workspace runtime performance
7.3. TROUBLESHOOTING NETWORK PROBLEMS
7.3.1. Enabling the WebSocket protocol
7.3.2. Troubleshooting WebSocket Secure connections
7.4. STARTING A CODEREADY WORKSPACES WORKSPACE IN DEBUG MODE
7.5. RESTARTING A CODEREADY WORKSPACES WORKSPACE IN DEBUG MODE AFTER START FAILURE

CHAPTER 8. OPENSIFT CONNECTOR OVERVIEW
8.1. FEATURES OF OPENSIFT CONNECTOR
8.2. INSTALLING OPENSIFT CONNECTOR IN CODEREADY WORKSPACES
8.3. AUTHENTICATING WITH OPENSIFT CONNECTOR FROM CODEREADY WORKSPACES
8.4. CREATING COMPONENTS WITH OPENSIFT CONNECTOR IN CODEREADY WORKSPACES
8.5. CONNECTING SOURCE CODE FROM GITHUB TO AN OPENSIFT COMPONENT USING OPENSIFT CONNECTOR

CHAPTER 9. TELEMETRY OVERVIEW
9.1. USE CASES
9.2. HOW IT WORKS
9.3. CREATING A TELEMETRY PLUGIN
9.3.1. Getting Started
9.3.2. Creating a new Maven project
9.3.3. Running the application
9.3.4. Creating a concrete implementation of AnalyticsManager and adding specialized logic
9.3.5. Implementing isEnabled()
9.3.6. Implementing onEvent()
9.3.7. Implementing increaseDuration()
9.3.8. Implementing onActivity()
9.3.9. Implementing destroy()
9.3.10. Packaging the Quarkus application
9.3.11. Creating a meta.yaml for your plug-in
9.3.12. Updating CodeReady Workspaces to reference your telemetry plug-in
MAKING OPEN SOURCE MORE INCLUSIVE

Red Hat is committed to replacing problematic language in our code, documentation, and web properties. We are beginning with these four terms: master, slave, blacklist, and whitelist. Because of the enormity of this endeavor, these changes will be implemented gradually over several upcoming releases. For more details, see our CTO Chris Wright’s message.
CHAPTER 1. NAVIGATING CODEREADY WORKSPACES

This chapter describes available methods to navigate Red Hat CodeReady Workspaces.

- Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”
- Section 1.2, “Importing certificates to browsers”
- Section 1.3, “Accessing CodeReady Workspaces from OpenShift Developer Perspective”

1.1. NAVIGATING CODEREADY WORKSPACES USING THE DASHBOARD

The Dashboard is accessible on your cluster from a URL like http://<https://codeready-<openshift_deployment_name>.<domain_name>/dashboard/. This section describes how to access this URL on OpenShift.

1.1.1. Logging in to CodeReady Workspaces on OpenShift for the first time using OAuth

This section describes how to log in to CodeReady Workspaces on OpenShift for the first time using OAuth.

Prerequisites

- Contact the administrator of the OpenShift instance to obtain the Red Hat CodeReady Workspaces URL.

Procedure

1. Navigate to the Red Hat CodeReady Workspaces URL to display the Red Hat CodeReady Workspaces login page.
2. Choose the OpenShift OAuth option.
3. The Authorize Access page is displayed.
4. Click on the Allow selected permissions button.
5. Update the account information: specify the Username, Email, First name and Last name fields and click the Submit button.

Validation steps

- The browser displays the Red Hat CodeReady Workspaces Dashboard.

1.1.2. Logging in to CodeReady Workspaces on OpenShift for the first time registering as a new user

This section describes how to log in to CodeReady Workspaces on OpenShift for the first time registering as a new user.

Prerequisites
Contact the administrator of the OpenShift instance to obtain the Red Hat CodeReady Workspaces URL.

Procedure

1. Navigate to the Red Hat CodeReady Workspaces URL to display the Red Hat CodeReady Workspaces login page.

2. Choose the Register as a new user option.

3. Update the account information: specify the Username, Email, First name and Last name field and click the Submit button.

Validation steps

- The browser displays the Red Hat CodeReady Workspaces Dashboard.

1.1.3. Finding CodeReady Workspaces cluster URL using the OpenShift 4 CLI

This section describes how to obtain the CodeReady Workspaces cluster URL using the OpenShift 4 command line interface (CLI). The URL can be retrieved from the OpenShift logs or from the checluster Custom Resource.

Prerequisites

- An instance of Red Hat CodeReady Workspaces running on OpenShift.

- User is located in a CodeReady Workspaces installation project.

Procedure

1. To retrieve the CodeReady Workspaces cluster URL from the checluster CR (Custom Resource), run:

   ```
   $ oc get checluster --output jsonpath='{.items[0].status.cheURL}'
   ```

2. Alternatively, to retrieve the CodeReady Workspaces cluster URL from the OpenShift logs, run:

   ```
   $ oc logs --tail=10 `(oc get pods -o name | grep operator) | grep "available at" | \ awk -F'available at:' '{print $2}' | sed 's/\//\'`
   ```

1.2. IMPORTING CERTIFICATES TO BROWSERS

This section describes how to import a root certificate authority into a web browser to use CodeReady Workspaces with self-signed TLS certificates.

When a TLS certificate is not trusted, the error message "Your CodeReady Workspaces server may be using a self-signed certificate. To resolve the issue, import the server CA certificate in the browser." blocks the login process. To prevent this, add the public part of the self-signed CA certificate into the browser after installing CodeReady Workspaces.

1.2.1. Adding certificates to Google Chrome on Linux or Windows
Procedure

1. Navigate to URL where CodeReady Workspaces is deployed.

2. Save the certificate:
   a. Click the warning or open lock icon on the left of the address bar.
   b. Click **Certificates** and navigate to the **Details** tab.
   c. Select the top-level certificate which is the Root certificate authority and export it:
      - On Linux, click the **Export** button.
      - On Windows, click the **Save to file** button.

3. Go to **Google Chrome Settings**, then to the **Authorities** tab

4. In the left panel, select **Advanced** and continue to **Privacy and security**.

5. At the center of the screen, click **Manage certificates** and navigate to **Authorities** tab.

6. Click the **Import** button and open the saved certificate file.

7. Select **Trust this certificate for identifying websites** and click the **OK** button.

8. After adding the CodeReady Workspaces certificate to the browser, the address bar displays the closed lock icon next to the URL, indicating a secure connection.

**1.2.2. Adding certificates to Google Chrome and Safari on macOS**

Procedure

1. Navigate to URL where CodeReady Workspaces is deployed.

2. Save the certificate:
   a. Click the lock icon on the left of the address bar.
   b. Click **Certificates**.
   c. Select the certificate to use and drag and drop its displayed large icon to the desktop.

3. Open the **Keychain Access** application.

4. Select the **System** keychain and drag and drop the saved certificate file to it.

5. Double-click the imported CA, then go to **Trust** and select **When using this certificate: Always Trust**.

6. Restart the browser for the added certificate to take effect.

**1.2.3. Adding certificates to Firefox**

Procedure

1. Navigate to URL where CodeReady Workspaces is deployed.
2. Save the certificate:
   a. Click the lock icon on the left of the address bar.
   b. Click the > button next to the Connection not secure warning.
   c. Click the More information button.
   d. Click the View Certificate button on the Security tab.
   e. Select the second certificate tab. The certificate Common Name should start with ingress-operator
   f. Click the PEM (cert) link and save the certificate.

3. Navigate to about:preferences, search for certificates, and click View Certificates.

4. Go to the Authorities tab, click the Import button, and open the saved certificate file.

5. Check Trust this CA to identify websites and click OK.

6. Restart Firefox for the added certificate to take effect.

7. After adding the CodeReady Workspaces certificate to the browser, the address bar displays the closed lock icon next to the URL, indicating a secure connection.

1.3. ACCESSING CODEREADY WORKSPACES FROM OPENSIGHT DEVELOPER PERSPECTIVE

OpenShift Container Platform provides a view switcher to make a transition between:

- **Administrator** - The traditional administration-focused console.
- **Developer** - A high-level of abstraction over OpenShift components to allow developers to focus on application development.

The OpenShift Developer Perspective enables a developer-focused view in the OpenShift 4 web console.

**NOTE**

OpenShift Developer Perspective is a default part of OpenShift Container Platform starting with version 4.2.

1.3.1. OpenShift Developer Perspective integration with CodeReady Workspaces

This section provides information about OpenShift Developer Perspective support for CodeReady Workspaces.

When the CodeReady Workspaces Operator is deployed into OpenShift Container Platform 4.2 and later, it creates a ConsoleLink Custom Resource (CR). This adds an interactive link to the Red Hat Applications menu for accessing the CodeReady Workspaces installation using the OpenShift Developer Perspective console.
To access the Red Hat Applications menu, click the three-by-three matrix icon on the main screen of the OpenShift web console. The CodeReady Workspaces Console Link, displayed in the drop-down menu, creates a new workspace or redirects the user to an existing one.

**NOTE**

OpenShift Container Platform console links are not created when CodeReady Workspaces is used with HTTP resources

When installing CodeReady Workspaces with the From Git option, the OpenShift Developer Perspective console link is only created if CodeReady Workspaces is deployed with HTTPS. The console link will not be created if an HTTP resource is used.

### 1.3.2. Editing the code of applications running in OpenShift Container Platform using CodeReady Workspaces

This section describes how to start editing the source code of applications running on OpenShift using CodeReady Workspaces.

**Prerequisites**

- CodeReady Workspaces is deployed on the same OpenShift 4 cluster.

**Procedure**

1. Open the **Topology** view to list all projects.

2. In the **Select an Application** search field, type **workspace** to list all workspaces.

3. Click the workspace to edit.
   The deployments are displayed as graphical circles surrounded by circular buttons. One of these buttons is **Edit Source Code**.

4. To edit the code of an application using CodeReady Workspaces, click the **Edit Source Code** button. This redirects to a workspace with the cloned source code of the application component.
1.3.3. Accessing CodeReady Workspaces from Red Hat Applications menu

This section describes how to access CodeReady Workspaces workspaces from the Red Hat Applications menu on OpenShift Container Platform.

Prerequisites

- The CodeReady Workspaces Operator is available in OpenShift 4.

Procedure

1. Open the Red Hat Applications menu by clicking the three-by-three matrix icon in the upper right corner of the main screen. The drop-down menu displays the available applications.

2. Click the CodeReady Workspaces link to open the CodeReady Workspaces Dashboard.
CHAPTER 2. CHE-THEIA IDE BASICS

This section describes basics workflows and commands for Che-Theia: the native integrated development environment for Red Hat CodeReady Workspaces.

- Section 2.1, “Defining custom commands for Che-Theia”
- Section 2.2, “Version Control”
- Section 2.3, “Che-Theia Troubleshooting”
- Section 2.4, “Differences in how Che-Theia Webview works on a single-host mode comparing to a multi-host mode”

2.1. DEFINING CUSTOM COMMANDS FOR CHE-THEIA

The Che-Theia IDE allows users to define custom commands in a devfile that are then available when working in a workspace.

This is useful, for example, for:

- Simplifying building, running, and debugging projects.
- Allowing lead developers to customize workspaces based on team requirements.
- Reducing time needed to onboard new team members.

See also Section 3.1, “Configuring a workspace using a devfile”.

2.1.1. Che-Theia task types

The following is an example of the commands section of a devfile.

commands:

- name: Package Native App
  actions:
    - type: exec
      component: centos-quarkus-maven
      command: "mvn package -Dnative -Dmaven.test.skip"
      workdir: ${CHE_PROJECTS_ROOT}/quarkus-quickstarts/getting-started

- name: Start Native App
  actions:
    - type: exec
      component: ubi-minimal
      command: ./getting-started-1.0-SNAPSHOT-runner
      workdir: ${CHE_PROJECTS_ROOT}/quarkus-quickstarts/getting-started/target

- name: Attach remote debugger
  actions:
    - type: vscode-launch
      referenceContent: |
        {
          "version": "0.2.0",
        }
CodeReady Workspaces commands

Package Native App and Start Native App
The CodeReady Workspaces commands are to be used to define tasks that will be executed in the workspace container.

- The exec type implies that the CodeReady Workspaces runner is used for command execution. The user can specify the component in whose container the command is executed.

- The command field contains the command line for execution.

- The workdir is the working directory in which the command is executed.

- The component field refers to the container where the command will be executed. The field contains the component alias where the container is defined.

VS Code launch configurations

Attach remote debugger
VS Code launch configurations are usually used to define debugging configuration. To trigger these configurations, press F5 or choose Start Debugging from the Debug menu. The configurations provide information to the debugger, such as the port to connect to for debugging or the type of the application to debug (Node.js, Java, and others.).

- The type is vscode-launch.

- It contains the launch configurations in the VS Code format.

- For more information about VS Code launch configurations, see the Debugging section on the Visual Studio documentation page.

Tasks of type che, also known as exec commands, can be executed from the Terminal→Run Task menu or by selecting them in the My Workspace panel. Other tasks are only available from Terminal→Run Task. Launch configurations are available in the Che-Theia debugger.

2.1.2. Running and debugging

Che-Theia supports the Debug Adapter Protocol. This protocol defines a generic way for how a development tool can communicate with a debugger. It means Che-Theia works with all implementations.

Prerequisites

Procedure
To debug an application:

1. Click **Debug → Add Configuration** to add debugging or launch configuration to the project.

2. From the pop-up menu, select the appropriate configuration for the application that you want to debug.
3. Update the configuration by modifying or adding attributes.

```
{
    "type": "java",
    "name": "Debug (Launch)",
    "request": "launch",
    "cwd": "${workspaceFolder}",
    "console": "internalConsole",
    "stopOnEntry": false,
    "mainClass": "HelloWorld",
    "args": ""
}
```

4. Breakpoints can be toggled by clicking the editor margin.
5. After opening a context menu, use the Edit Breakpoint command to add conditions.

The IDE then displays the Expression input field.

6. To start debugging, click View → Debug.
7. In the **Debug** view, select the configuration and press **F5** to debug the application. Or, start the application without debugging by pressing **Ctrl+F5**.

2.1.3. Editing a task and launch configuration

**Procedure**

To customize the configuration file:

1. Edit the **tasks.json** or **launch.json** configuration files.

2. Add new definitions to the configuration file or modify the existing ones.
3. To customize the task configuration provided by plug-ins, select the Terminal → Configure Tasks menu option, and choose the task to configure. The configuration is then copied to the tasks.json file and is available for editing.

### 2.2. VERSION CONTROL

Red Hat CodeReady Workspaces natively supports the VS Code SCM model. By default, Red Hat CodeReady Workspaces includes the native VS Code Git extension as a Source Code Management (SCM) provider.

#### 2.2.1. Managing Git configuration: identity

The first thing to do before starting to use Git is to set a user name and email address. This is important because every Git commit uses this information.

**Procedure**

- To configure Git identity using the CodeReady Workspaces user interface:
  
  1. Open File > Settings > Open Preferences or press Ctrl+,.

  ![Image showing the CodeReady Workspaces settings window]

  2. In the opened window, navigate to the Git → User sub-section and enter the User mail and User name values.

- To configure Git identity using the command line, open the terminal of the Che-Theia container.

  1. Navigate to the My Workspace view, and open Plugins > theia-ide... > New terminal
2. Execute the following commands:

$ git config --global user.name "John Doe"
$ git config --global user.email johndoe@example.com

Che-Theia permanently stores this information in the current container and restores it for other containers on future workspace starts.

2.2.2. Accessing a Git repository using HTTPS

Procedure

To clone a repository using HTTPS:

1. Use the **clone** command provided by the Visual Studio Code **Git** extension.

Alternatively, use the native Git commands in the terminal to clone a project.

1. Navigate to destination folder using the **cd** command.

2. Use **git clone** to clone a repository:

   $ git clone <link>

2.2.3. Accessing a Git repository using a generated SSH key pair

2.2.3.1. Generating an SSH key using the CodeReady Workspaces command palette

The following section describes a generation of an SSH key using the CodeReady Workspaces command palette and its further use in Git provider communication. This SSH key restricts permissions for the specific Git provider, therefore, the user has to create a unique SSH key for each Git provider in use.

Prerequisites


- An existing workspace defined on this instance of CodeReady Workspaces Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”.

- Personal GitHub account or other Git provider account created.

Procedure

A common SSH key pair that works with all the Git providers is present by default. To start using it, add the public key to the Git provider.

1. Generate an SSH key pair that only works with a particular Git provider:
   
   - In the CodeReady Workspaces IDE, press F1 to open the Command Palette, or navigate to View → Find Command in the top menu. The command palette can be also activated by pressing Ctrl+Shift+p (or Cmd+Shift+p on macOS).
   - Search for SSH: generate key pair for particular host by entering generate into the search box and pressing Enter once filled.
   - Provide the hostname for the SSH key pair such as, for example, github.com. The SSH key pair is generated.

2. Click the View button in the lower-right corner and copy the public key from the editor and add it to the Git provider.
   You can now use another command from the command palette: Clone git repository by providing an SSH secured URL.

2.2.3.2. Adding the associated public key to a repository or account on GitHub

To add the associated public key to a repository or account on GitHub:

1. Navigate to github.com.

2. Click the drop-down arrow next to the user icon in the upper right corner of the window.
3. Click Settings → SSH and GPG keys and then click the New SSH key button.

4. In the Title field, type a title for the key, and in the Key field, paste the public key copied from CodeReady Workspaces.

5. Click the Add SSH key button.

2.2.3.3. Adding the associated public key to a Git repository or account on GitLab

To add the associated public key to a Git repository or account on GitLab:

1. Navigate to gitlab.com.

2. Click the user icon in the upper right corner of the window.

3. Click Settings → SSH Keys.

4. In the Title field, type a title for the key and in the Key field, paste the public key copied from CodeReady Workspaces.

5. Click the Add key button.

2.3. CHE-THEIA TROUBLESHOOTING

This section describes some of the most frequent issues with the Che-Theia IDE.

Che-Theia shows a notification with the following message: Plugin runtime crashed unexpectedly, all plugins are not working, please reload the page. Probably there is not enough memory for the plugins.

This means that one of the Che-Theia plug-ins that are running in the Che-Theia IDE container requires more memory than the container has. To fix this problem, increase the amount of memory for the Che-Theia IDE container:

1. Navigate to the CodeReady Workspaces Dashboard.

2. Select the workspace in which the problem happened.

3. Switch to the Devfile tab.

4. In the components section of the devfile, find a component of the cheEditor type.

5. Add a new property, memoryLimit: 1024M (or increase the value if it already exists).

6. Save changes and restart the workspace.

2.4. DIFFERENCES IN HOW CHE-THEIA WEBVIEW WORKS ON A SINGLE-HOST MODE COMPARING TO A MULTI-HOST MODE

Depending on which Che deployment strategy is used, single-host or multi-host, there’re differences in how Che-Theia Webview API works.

2.4.1. What’s a Webview
Webview Plug-in API allows creating a view within Che-Theia to show an arbitrary HTML content. Internally, it’s implemented with an iframe and service worker.

2.4.2. Webview in a multi-host mode

When Red Hat CodeReady Workspaces is deployed in a multi-host mode, webview content is served on a separate origin. That means it’s isolated from the main Che-Theia context. So, a contributed view has no access:

- to the top-level DOM
- to the Che-Theia state, like local storage, cookies, etc.

2.4.3. Webview in single-host mode

When Red Hat CodeReady Workspaces is deployed in a single-host mode, webview content is loaded through the same origin as the main Che-Theia context. It means that nothing prevents external content from accessing the main Che-Theia in a browser. So, pay extra attention to what content may be loaded by different Plugins that contribute the webviews.
CHAPTER 3. DEVELOPER WORKSPACES

Red Hat CodeReady Workspaces provides developer workspaces with everything needed to a code, build, test, run, and debug applications. To allow that, the developer workspaces provide four main components:

1. The source code of a project.
3. Tool dependencies, needed by developers to work on a project.
4. Application runtime: a replica of the environment where the application runs in production.

Pods manage each component of a CodeReady Workspaces workspace. Therefore, everything running in a CodeReady Workspaces workspace is running inside containers. This makes a CodeReady Workspaces workspace highly portable.

The embedded browser-based IDE is the point of access for everything running in a CodeReady Workspaces workspace. This makes a CodeReady Workspaces workspace easily shareable.

**IMPORTANT**

By default, it is possible to run only one workspace at a time. To increase the number of concurrent workspaces a user can run, patch the checluster:

```
$ oc patch checluster codeready-workspaces -n <user-project-namespace> --type=merge \ 
  -p '{ "spec": { "server": { "customCheProperties": { "CHE_LIMITS_USER_WORKSPACES_RUN_COUNT": "-1" } } } }'
```

For additional information, see: [Users workspace limits](#).

<table>
<thead>
<tr>
<th>Table 3.1. Features and benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Features</strong></td>
</tr>
<tr>
<td>Configuration and installation required</td>
</tr>
<tr>
<td><strong>Embedded tools</strong></td>
</tr>
<tr>
<td>Application runtime provided</td>
</tr>
<tr>
<td>Shareable</td>
</tr>
<tr>
<td>Features</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>Versionable</td>
</tr>
<tr>
<td>Accessible from anywhere</td>
</tr>
</tbody>
</table>

To start a CodeReady Workspaces workspace, following options are available:

- Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”
- Section 3.1, “Configuring a workspace using a devfile”

Use the Dashboard to discover CodeReady Workspaces 2.5:

- Section 3.6, “Creating a workspace from code sample”
- Section 3.7, “Creating a workspace by importing the source code of a project”

Use a devfile as the preferred way to start a CodeReady Workspaces 2.5 workspace:

- Section 3.2, “Making a workspace portable using a devfile”
- Section 3.4, “Importing a OpenShift application into a workspace”

Use the browser-based IDE as the preferred way to interact with a CodeReady Workspaces 2.5 workspace. For an alternative way to interact with a CodeReady Workspaces 2.5 workspace, see: Section 3.5, “Remotely accessing workspaces”.

### 3.1. CONFIGURING A WORKSPACE USING A DEVFILE

To quickly and easily configure a CodeReady Workspaces workspace, use a devfile. For an introduction to devfiles and instructions for their use, see the instructions in this section.

#### 3.1.1. What is a devfile

A devfile is a file that describes and define a development environment:

- The source code.
- The development components, such as browser IDE tools and application runtimes.
- A list of pre-defined commands.
- Projects to clone.

A devfile is a YAML file that CodeReady Workspaces consumes and transforms into a cloud workspace composed of multiple containers. It is possible to store a devfile remotely or locally, in any number of ways, such as:

- In a git repository, in the root folder, or on a feature branch.
- On a publicly accessible web server, accessible through HTTP.
Locally as a file, and deployed using crwctl.

In a collection of devfiles, known as a devfile registry.

When creating a workspace, CodeReady Workspaces uses that definition to initiate everything and run all the containers for the required tools and application runtimes. CodeReady Workspaces also mounts file-system volumes to make source code available to the workspace.

Devfiles can be versioned with the project source code. When there is a need for a workspace to fix an old maintenance branch, the project devfile provides a definition of the workspace with the tools and the exact dependencies to start working on the old branch. Use it to instantiate workspaces on demand.

CodeReady Workspaces maintains the devfile up-to-date with the tools used in the workspace:

- Elements of the project, such as the path, git location, or branch.
- Commands to perform daily tasks such as build, run, test, and debug.
- The runtime environment with its container images needed for the application to run.
- Che-Theia plug-ins with tools, IDE features, and helpers that a developer would use in the workspace, for example, Git, Java support, SonarLint, and Pull Request.

### 3.1.2. Creating a workspace from the default branch of a Git repository

It is possible to create a CodeReady Workspaces workspace by pointing to a devfile that is stored in a Git source repository. The CodeReady Workspaces instance then uses the discovered `devfile.yaml` file to build a workspace using the factory URL (`/f?url=`) API.

**Prerequisites**

- The `devfile.yaml` or `.devfile.yaml` file is located in the root folder of a Git repository that is available over HTTPS. See Section 3.2, “Making a workspace portable using a devfile” for detailed information about creating and using devfiles.

**Procedure**

Run the workspace by opening the following URL: `https://codeready-<openshift_deployment_name>.<domain_name>/f?url=https://<GitRepository>

**Example**


### 3.1.3. Creating a workspace from a feature branch of a Git repository

A CodeReady Workspaces workspace can be created by pointing to devfile that is stored in a Git source repository on a feature branch of the user’s choice. The CodeReady Workspaces instance then uses the discovered devfile to build a workspace.
Prerequisites


- The `devfile.yaml` or `.devfile.yaml` file is located in the root folder of a Git repository, on a specific branch of the user’s choice that is accessible over HTTPS. See Section 3.2, “Making a workspace portable using a devfile” for detailed information about creating and using devfiles.

Procedure

Execute the workspace by opening the following URL:

\`https://codeready-<openshift_deployment_name>.<domain_name>/f?url=<GitHubBranch>`

Example

Use following URL format to open an experimental `quarkus-quickstarts` branch hosted on che.openshift.io.


3.1.4. Creating a workspace from a publicly accessible standalone devfile using HTTP

A workspace can be created using a devfile, the URL of which is pointing to the raw content of the devfile. The CodeReady Workspaces instance then uses the discovered devfile to build a workspace.

Prerequisites


- The publicly-accessible standalone `devfile.yaml` file. See Section 3.2, “Making a workspace portable using a devfile” for detailed information about creating and using devfiles.

Procedure

1. Execute the workspace by opening the following URL:

\`https://codeready-<openshift_deployment_name>.<domain_name>/f?url=https://<yourhosturl>/devfile.yaml`

Example

https://che.openshift.io/f?url=https://gist.githubusercontent.com/themr0c/ef8e59a162748a8be07e900b6401e6a8/raw/8802c20743cde712b2c822521463359a60d1f7a9/devfile.yaml

3.1.5. Overriding devfile values using factory parameters

Values in the following sections of a remote devfile can be overridden using specially constructed additional factory parameters:

- apiVersion
Prerequisites


- A publicly accessible standalone devfile.yaml file. See Section 3.2, “Making a workspace portable using a devfile” for detailed information about creating and using devfiles.

Procedure

1. Open the workspace by navigating to the following URL:

   https://codeready-<openshift_deployment_name>.<domain_name>/f?
   url=https://<hostURL>/devfile.yaml&override.<parameter.path>=<value>

Example of overriding the `generateName` property

Consider the following initial devfile:

```
---
apiVersion: 1.0.0
metadata:
  generateName: golang-
projects:
...
```

To add or override `generateName` value, use the following factory URL:

```
https://che.openshift.io/f?
url=https://gist.githubusercontent.com/themr0c/ef8e59a162748a8be07e900b6401e6a8/raw/8802c20743cde712bbc822521463359a60d1f7a9/devfile.yaml&override.metadata.generateName=myprefix
```

The resulting workspace has the following devfile model:

```
---
apiVersion: 1.0.0
metadata:
  generateName: myprefix
projects:
...
```

Example of overriding project source branch property

Consider the following initial devfile:

```
---
apiVersion: 1.0.0
metadata:
...
generateName: java-mysql-
projects:
  - name: web-java-spring-petclinic
    source:
      type: git
      location: "https://github.com/spring-projects/spring-petclinic.git"

To add or override source branch value, use the following factory URL:

https://che.openshift.io/f?
url=https://gist.githubusercontent.com/themr0c/ef8e59a162748a8be07e900b6401e6a8/raw/8802c20743cde712b8c822521463359a60d1f7a9/devfile.yaml&override.projects.web-java-spring-petclinic.source.branch=1.0.x

The resulting workspace has the following devfile model:

```yaml
apiVersion: 1.0.0
metadata:
  generateName: java-mysql-
projects:
  - name: web-java-spring-petclinic
    source:
      type: git
      location: "https://github.com/spring-projects/spring-petclinic.git"
      branch: 1.0.x
```

Example of overriding or creating an attribute value

Consider the following initial devfile:

```yaml
---
apiVersion: 1.0.0
metadata:
  generateName: golang-
attributes:
  persistVolumes: false
projects:
```

To add or override persistVolumes attribute value, use the following factory URL:

https://che.openshift.io/f?
url=https://gist.githubusercontent.com/themr0c/ef8e59a162748a8be07e900b6401e6a8/raw/8802c20743cde712b8c822521463359a60d1f7a9/devfile.yaml&override.attributes.persistVolumes=true

The resulting workspace has the following devfile model:

```yaml
---
apiVersion: 1.0.0
metadata:
  generateName: golang-
attributes:
    persistVolumes: false
```
When overriding attributes, everything that follows the **attributes** keyword is interpreted as an attribute name, so a user can use dot-separated names:

```text
https://che.openshift.io/f?
url=https://gist.githubusercontent.com/themr0c/ef8e59a162748a8be07e900b6401e6a8/raw/8802c20743cde712bb822521463359a60d1f7a9/devfile.yaml&override.attributes.dot.name.format.attribute=true
```

The resulting workspace has the following devfile model:

```yaml
---
apiVersion: 1.0.0
metadata:
generateName: golang-
attributes:
  dot.name.format.attribute: true
projects:
... 
```

### 3.1.6. Creating a workspace using crwctl and a local devfile

A CodeReady Workspaces workspace can be created by pointing the `crwctl` tool to a locally stored devfile. The CodeReady Workspaces instance then uses the discovered devfile to build a workspace.

**Prerequisites**


- The devfile is available on the local filesystem in the current working directory. See Section 3.2, “Making a workspace portable using a devfile” for detailed information about creating and using devfiles.

**Example**

Download the `devfile.yaml` file from the GitHub repository to the current working directory.

**Procedure**

1. Run a workspace from a devfile using the `workspace:start` parameter with the `crwctl` tool as follows:

   ```bash
   $ crwctl workspace:start --devfile=devfile.yaml
   ```

**Additional resources**
3.2. MAKING A WORKSPACE PORTABLE USING A DEVFILE

To transfer a configured CodeReady Workspaces workspace, create and export the devfile of the workspace and load the devfile on a different host to initialize a new instance of the workspace. For detailed instructions on how to create such a devfile, see below.

3.2.1. A minimal devfile

The following is the minimum content required in a devfile:

- apiVersion
- metadata name

```yaml
apiVersion: 1.0.0
metadata:
  name: crw-in-crw-out
```

For a complete devfile example, see Red Hat CodeReady Workspaces in CodeReady Workspaces devfile.yaml.

**NOTE**

A choice of use of the parameter `generateName` or `name` is optional, but only one of these parameters has to be chosen by a user and defined. When both attributes are specified, `generateName` is ignored. See Section 3.2.2, “Generating workspace names”.

```yaml
metadata:
  generatedName:

or

metadata:
  name:
```

3.2.2. Generating workspace names

To specify a prefix for automatically generated workspace names, set the `generateName` parameter in the devfile:

```yaml
apiVersion: 1.0.0
metadata:
  generateName: crw-
```

The workspace name will be in the `<generateName>YYYYY` format (for example, `che-2y7kp`). Y is random [a-z0-9] character.

The following naming rules apply when creating workspaces:

- When `name` is defined, it is used as the workspace name: `<name>`
When only `generateName` is defined, it is used as the base of the generated name: `<generateName>YYYYY`

**NOTE**
For workspaces created using a factory, defining `name` or `generateName` has the same effect. The defined value is used as the name prefix: `<name>YYYYY` or `<generateName>YYYYY`. When both `generateName` and `name` are defined, `generateName` takes precedence.

### 3.2.3. Writing a devfile for a project

This section describes how to create a minimal devfile for your project and how to include more than one projects in a devfile.

#### 3.2.3.1. Preparing a minimal devfile

A minimal devfile sufficient to run a workspace consists of the following parts:

- Specification version
- Name

**Example of a minimal devfile with no project**

```yaml
apiVersion: 1.0.0
metadata:
  name: minimal-workspace
```

Without any further configuration, a workspace with the default editor is launched along with its default plug-ins, which are configured on the CodeReady Workspaces Server. Che-Theia is configured as the default editor along with the CodeReady Workspaces Machine Exec plug-in. When launching a workspace within a Git repository using a factory, the project from the given repository and branch is be created by default. The project name then matches the repository name.

Add the following parts for a more functional workspace:

- List of components: Development components and user runtimes
- List of projects: Source code repositories
- List of commands: Actions to manage the workspace components, such as running the development tools, starting the runtime environments, and others

**Example of a minimal devfile with a project**

```yaml
apiVersion: 1.0.0
metadata:
  name: petclinic-dev-environment
projects:
- name: petclinic
  source:
    type: git
    location: 'https://github.com/spring-projects/spring-petclinic.git'
```
3.2.3.2. Specifying multiple projects in a devfile

A single devfile can define multiple projects, which are cloned to the desired destination. These projects are created inside a user’s workspace after the workspace is started.

For each project, specify the following:

- The type of the source repository - this can be .git or .zip. For additional information, see the Devfile reference section.

- The location of the source repository - an URL to a Git repository or ZIP archive.

- Optionally, the directory to which the project is cloned. If none is specified, the default directory is used, which is a directory that matches the project name or project Git repository.

Example of a devfile with two projects

In the following example, the projects frontend and backend act as examples of a user’s projects. Each project is located in a separate repository.

- The backend project has a specific requirement to be cloned into the src/github.com/<github-organization>/<backend> directory under the source root, implicitly defined by the CodeReady Workspaces runtime.

- The frontend project will be cloned into the <frontend/> directory under the source root.

```json
components:
  - type: chePlugin
    id: redhat/java/latest

apiVersion: 1.0.0
metadata:
  name: example-devfile
projects:
- name: <frontend>
  source:
    type: git
    location: https://github.com/<github-organization>/<frontend>.git
- name: <backend>
  clonePath: src/github.com/<github-organization>/<backend>
  source:
    type: git
    location: https://github.com/<github-organization>/<backend>.git
```

Additional resources

For a detailed explanation of all devfile component assignments and possible values, see:

- Specification repository

- Detailed json-schema documentation

These sample devfiles are a good source of inspiration:

- Sample devfiles for Red Hat CodeReady Workspaces workspaces used by default in the user interface.
3.2.4. Devfile reference

This section contains devfile reference and instructions on how to use the various elements that devfiles consist of.

3.2.4.1. Adding projects to a devfile

Usually a devfile contains one or more projects. A workspace is created to develop those projects. Projects are added in the `projects` section of devfiles.

Each project in a single devfile must have:

- Unique name
- Source specified

Project source consists of two mandatory values: `type` and `location`.

**type**

The kind of project-source provider.

**location**

The URL of project source.

CodeReady Workspaces supports the following project types:

**git**

Projects with sources in Git. The location points to a clone link.

**github**

Same as `git` but for projects hosted on GitHub only. Use `git` for projects that do not use GitHub-specific features.

**zip**

Projects with sources in a ZIP archive. Location points to a ZIP file.

3.2.4.1.1. Project-source type: git

```yaml
source:
  type: git
  location: https://github.com/eclipse/che.git
  startPoint: master  # 1
  tag: 7.2.0
  commitId: 36fe587
  branch: 7.20.x
  sparseCheckoutDir: core  # 2
```

1. **startPoint**: The general value for `tag`, `commitId`, and `branch`. The `startPoint`, `tag`, `commitId`, and `branch` parameters are mutually exclusive. When more than one is supplied, the following order is used: `startPoint`, `tag`, `commitId`, `branch`.

2. **sparseCheckoutDir**: The template for the sparse checkout Git feature. This is useful when only a part of a project, typically a single directory, is needed.
Example 3.1. `sparseCheckoutDir` parameter settings

- Set to `/my-module/` to create only the root `my-module` directory (and its content).
- Omit the leading slash (`my-module/`) to create all `my-module` directories that exist in the project. Including, for example, `/addons/my-module/`. The trailing slash indicates that only directories with the given name (including their content) are created.
- Use wildcards to specify more than one directory name. For example, setting `module-` checks out all directories of the given project that start with `module-`.

For more information, see Sparse checkout in Git documentation.

3.2.4.1.2. Project-source type: zip

```
source:
  type: zip
  location: http://host.net/path/project-src.zip
```

3.2.4.1.3. Project clone-path parameter: `clonePath`

The `clonePath` parameter specifies the path into which the project is to be cloned. The path must be relative to the `/projects/` directory, and it cannot leave the `/projects/` directory. The default value is the project name.

Example devfile with projects

```
apiVersion: 1.0.0
metadata:
  name: my-project-dev
projects:
- name: my-project-resource
  clonePath: resources/my-project
  source:
    type: zip
    location: http://host.net/path/project-res.zip
- name: my-project
  source:
    type: git
    location: https://github.com/my-org/project.git
    branch: develop
```

3.2.4.2. Adding components to a devfile

Each component in a single devfile must have a unique name.

3.2.4.2.1. Component type: cheEditor

Describes the editor used in the workspace by defining its `id`. A devfile can only contain one component of the `cheEditor` type.
When `cheEditor` is missing, a default editor is provided along with its default plug-ins. The default plug-ins are also provided for an explicitly defined editor with the same `id` as the default one (even if it is a different version). Che-Theia is configured as default editor along with the CodeReady Workspaces Machine Exec plug-in.

To specify that a workspace requires no editor, use the `editorFree:true` attribute in the devfile attributes.

### 3.2.4.2.2. Component type: `chePlugin`

Describes plug-ins in a workspace by defining their `id`. It is allowed to have several `chePlugin` components.

```
components:
  - alias: exec-plugin
    type: chePlugin
    id: eclipse/che-machine-exec-plugin/0.0.1
```

Both types above use an ID, which is slash-separated publisher, name and version of plug-in from the CodeReady Workspaces Plug-in registry.

List of available Eclipse Che plug-ins and more information about registry can be found in the Eclipse Che plug-in registry GitHub repository.

### 3.2.4.2.3. Specifying an alternative component registry

To specify an alternative registry for the `cheEditor` and `chePlugin` component types, use the `registryUrl` parameter:

```
components:
  - alias: exec-plugin
    type: chePlugin
    registryUrl: https://my-customregistry.com
    id: eclipse/che-machine-exec-plugin/0.0.1
```

### 3.2.4.2.4. Specifying a component by linking to its descriptor

An alternative way of specifying `cheEditor` or `chePlugin`, instead of using the editor or plug-in `id` (and optionally an alternative registry), is to provide a direct link to the component descriptor (typically named `meta.yaml`) by using the `reference` field:

```
components:
  - alias: exec-plugin
    type: chePlugin
    reference: https://raw.githubusercontent.com.../plugin/1.0.1/meta.yaml
```
NOTE
It is impossible to mix the id and reference fields in a single component definition; they are mutually exclusive.

3.2.4.2.5. Tuning chePlugin component configuration
A chePlugin component may need to be precisely tuned, and in such case, component preferences can be used. The example shows how to configure JVM using plug-in preferences.

```json
{  "id": "redhat/java/0.38.0",  "type": "chePlugin",  "preferences": {    "java.jdt.ls.vmargs": "-noverify -Xmx1G -XX:+UseG1GC -XX:+UseStringDeduplication"  }}
```

Preferences may also be specified as an array:

```json
{  "id": "redhat/java/0.38.0",  "type": "chePlugin",  "preferences": {    "go.lintFlags": ["--enable-all", "--new"]  }}
```

3.2.4.2.6. Component type: kubernetes
A complex component type that allows to apply configuration from a list of OpenShift components.

The content can be provided through the reference attribute, which points to the file with the component content.

```json
{  "components": [    {      "alias": "mysql",      "type": "kubernetes",      "reference": "petclinic.yaml",      "selector": {        "app.kubernetes.io/name": "mysql",        "app.kubernetes.io/component": "database",        "app.kubernetes.io/part-of": "petclinic"      }    }  ]}
```

Alternatively, to post a devfile with such components to REST API, the contents of the OpenShift List object can be embedded into the devfile using the referenceContent field:

```json
{  "components": [    {      "alias": "mysql",      "type": "kubernetes",      "reference": "petclinic.yaml",      "referenceContent": {        "apiVersion": "v1",        "kind": "List",        "items": [          {            "apiVersion": "v1",            "kind": "Pod",            "metadata": {              "name": "ws"            }          }        ]      }    }  ]}
```
3.2.4.2.7. Overriding container entrypoints

As with the understood by OpenShift).

There can be more containers in the list (contained in Pods or Pod templates of deployments). To select which containers to apply the entrypoint changes to.

The entrypoints can be defined as follows:

```
components:
  - alias: appDeployment
    type: kubernetes
    reference: app-deployment.yaml
    entrypoints:
      - parentName: mysqlServer
        command: ['sleep']
        args: ['infinity']
      - parentSelector:
          app: prometheus
        args: ['-f', '/opt/app/prometheus-config.yaml']
```

The `entrypoints` list contains constraints for picking the containers along with the `command` and `args` parameters to apply to them. In the example above, the constraint is `parentName: mysqlServer`, which will cause the command to be applied to all containers defined in any parent object called `mysqlServer`. The parent object is assumed to be a top level object in the list defined in the referenced file, which is `app-deployment.yaml` in the example above.

Other types of constraints (and their combinations) are possible:

- **containerName**
  - the name of the container
- **parentName**
  - the name of the parent object that (indirectly) contains the containers to override
- **parentSelector**
  - the set of labels the parent object needs to have

A combination of these constraints can be used to precisely locate the containers inside the referenced OpenShift List.

3.2.4.2.8. Overriding container environment variables

To provision or override entrypoints in a OpenShift component, configure it in the following way:

```
components:
  - alias: appDeployment
    type: kubernetes
    reference: app-deployment.yaml
```
This is useful for temporary content or without access to editing the referenced content. The specified environment variables are provisioned into each init container and containers inside all Pods and Deployments.

3.2.4.2.9. Specifying mount-source option

To specify a project sources directory mount into container(s), use the `mountSources` parameter:

```yaml
components:
  - alias: appDeployment
    type: kubernetes
    reference: app-deployment.yaml
    mountSources: true
```

If enabled, project sources mounts will be applied to every container of the given component. This parameter is also applicable for `chePlugin` type components.

3.2.4.2.10. Component type: dockerimage

A component type that allows to define a container image-based configuration of a container in a workspace. A devfile can only contain one component of the `dockerimage` type. The `dockerimage` type of component brings in custom tools into the workspace. The component is identified by its image.

```yaml
components:
  - alias: maven
    type: dockerimage
    image: eclipse/maven-jdk8:latest
    volumes:
      - name: mavenrepo
        containerPath: /root/.m2
    env:
      - name: ENV_VAR
        value: value
    endpoints:
      - name: maven-server
        port: 3101
        attributes:
          protocol: http
          secure: true
          public: true
          discoverable: false
        memoryLimit: 1536M
        command: ["tail"]
        args: ["-f", "/dev/null"]
```

Example of a minimal `dockerimage` component

```yaml
apiVersion: 1.0.0
metadata:
  name: MyDevfile
```
components:
- type: dockerimage
  image: golang
  memoryLimit: 512Mi
  command: ['sleep', 'infinity']

It specifies the type of the component, `dockerimage` and the `image` attribute names the image to be used for the component using the usual Docker naming conventions, that is, the above `type` attribute is equal to `docker.io/library/golang:latest`.

A `dockerimage` component has many features that enable augmenting the image with additional resources and information needed for meaningful integration of the tool provided by the image with Red Hat CodeReady Workspaces.

### 3.2.4.2.11. Mounting project sources

For the `dockerimage` component to have access to the project sources, you must set the `mountSources` attribute to `true`.

```python
apiVersion: 1.0.0
metadata:
  name: MyDevfile
components:
- type: dockerimage
  image: golang
  memoryLimit: 512Mi
  command: ['sleep', 'infinity']
```

The sources is mounted on a location stored in the `CHE_PROJECTS_ROOT` environment variable that is made available in the running container of the image. This location defaults to `/projects`.

### 3.2.4.2.12. Container Entrypoint

The `command` attribute of the `dockerimage` along with other arguments, is used to modify the `entrypoint` command of the container created from the image. In Red Hat CodeReady Workspaces the container is needed to run indefinitely so that you can connect to it and execute arbitrary commands in it at any time. Because the availability of the `sleep` command and the support for the `infinity` argument for it is different and depends on the base image used in the particular images, CodeReady Workspaces cannot insert this behavior automatically on its own. However, you can take advantage of this feature to, for example, start necessary servers with modified configurations, etc.

### 3.2.4.2.13. Persistent Storage

Components of any type can specify the custom volumes to be mounted on specific locations within the image. Note that the volume names are shared across all components and therefore this mechanism can also be used to share file systems between components.

Example specifying volumes for `dockerimage` type:

```python
apiVersion: 1.0.0
metadata:
  name: MyDevfile
components:
- type: dockerimage
  image: golang
```
3.2.4.2.14. Specifying container memory limit for components

To specify a container(s) memory limit for dockerimage, chePlugin, cheEditor, use the memoryLimit parameter:

```
components:
  - alias: exec-plugin
    type: chePlugin
    id: eclipse/che-machine-exec-plugin/0.0.1
    memoryLimit: 1Gi
  - type: dockerimage
    image: eclipse/maven-jdk8:latest
    memoryLimit: 512M
```

This limit will be applied to every container of the given component.

For the cheEditor and chePlugin component types, RAM limits can be described in the plug-in descriptor file, typically named meta.yaml.
If none of them are specified, system-wide defaults will be applied (see description of 
CHE_WORKSPACE_SIDECAR_DEFAULT_MEMORY_LIMIT_MB system property).

3.2.4.2.15. Specifying container memory request for components

To specify a container(s) memory request for chePlugin or cheEditor, use the memoryRequest parameter:

components:
- alias: exec-plugin
  type: chePlugin
  id: eclipse/che-machine-exec-plugin/0.0.1
  memoryLimit: 1Gi
  memoryRequest: 512M
- type: dockerimage
  image: eclipse/maven-jdk8:latest
  memoryLimit: 512M
  memoryRequest: 256M

This limit will be applied to every container of the given component.

For the cheEditor and chePlugin component types, RAM requests can be described in the plug-in descriptor file, typically named meta.yaml.

If none of them are specified, system-wide defaults are applied (see description of 
CHE_WORKSPACE_SIDECAR_DEFAULT_MEMORY_REQUEST_MB system property).

3.2.4.2.16. Specifying container CPU limit for components

To specify a container(s) CPU limit for chePlugin, cheEditor or dockerimage use the cpuLimit parameter:

components:
- alias: exec-plugin
  type: chePlugin
  id: eclipse/che-machine-exec-plugin/0.0.1
  cpuLimit: 1.5
- type: dockerimage
  image: eclipse/maven-jdk8:latest
  cpuLimit: 750m

This limit will be applied to every container of the given component.

For the cheEditor and chePlugin component types, CPU limits can be described in the plug-in descriptor file, typically named meta.yaml.

If none of them are specified, system-wide defaults are applied (see description of 
CHE_WORKSPACE_SIDECAR_DEFAULT_CPU_LIMIT_CORES system property).

3.2.4.2.17. Specifying container CPU request for components

To specify a container(s) CPU request for chePlugin, cheEditor or dockerimage use the cpuRequest parameter:

components:
This limit will be applied to every container of the given component.

For the cheEditor and chePlugin component types, CPU requests can be described in the plug-in descriptor file, typically named meta.yaml.

If none of them are specified, system-wide defaults are applied (see description of CHE_WORKSPACE_SIDECAR_DEFAULT__CPU__REQUEST__CORES system property).

3.2.4.2.18. Environment variables

Red Hat CodeReady Workspaces allows you to configure Docker containers by modifying the environment variables available in component's configuration. Environment variables are supported by the following component types: dockerimage, chePlugin, cheEditor, kubernetes, openshift. In case component has multiple containers, environment variables will be provisioned to each container.

```
apiVersion: 1.0.0
metadata:
  name: MyDevfile
components:
- type: dockerimage
  image: golang
  memoryLimit: 512Mi
  mountSources: true
  command: ['sleep', 'infinity']
  env:
    - name: GOPATH
      value: $(CHE_PROJECTS_ROOT)/go
    - type: cheEditor
      alias: theia-editor
      id: eclipse/che-theia/next
      memoryLimit: 2Gi
      env:
        - name: HOME
          value: $(CHE_PROJECTS_ROOT)
```

**NOTE**

- The variable expansion works between the environment variables, and it uses the Kubernetes convention for the variable references.

- The predefined variables are available for use in custom definitions.

The following environment variables are pre-set by the CodeReady Workspaces server:
- **CHE_PROJECTS_ROOT**: The location of the projects directory (note that if the component does not mount the sources, the projects will not be accessible).

- **CHE_WORKSPACE_LOGS_ROOT__DIR**: The location of the logs common to all the components. If the component chooses to put logs into this directory, the log files are accessible from all other components.

- **CHE_API_INTERNAL**: The URL to the CodeReady Workspaces server API endpoint used for communication with the CodeReady Workspaces server.

- **CHE_WORKSPACE_ID**: The ID of the current workspace.

- **CHE_WORKSPACE_NAME**: The name of the current workspace.

- **CHE_WORKSPACE_NAMESPACE**: The CodeReady Workspaces project of the current workspace. This environment variable is the name of the user or organization that the workspace belongs to. Note that this is different from the OpenShift project to which the workspace is deployed.

- **CHE_MACHINE_TOKEN**: The token used to authenticate the request against the CodeReady Workspaces server.

- **CHE_MACHINE_AUTH_SIGNATURE__PUBLIC__KEY**: The public key used to secure the communication with the CodeReady Workspaces server.

- **CHE_MACHINE_AUTH_SIGNATURE__ALGORITHM**: The encryption algorithm used in the secured communication with the CodeReady Workspaces server.

A devfiles may only need the **CHE_PROJECTS_ROOT** environment variable to locate the cloned projects in the component's container. More advanced devfiles might use the **CHE_WORKSPACE_LOGS_ROOT__DIR** environment variable to read the logs (for example as part of a devfile command). The environment variables used to securely access the CodeReady Workspaces server are mostly out of scope for devfiles and are present only for advanced use cases that are usually handled by the CodeReady Workspaces plug-ins.

### 3.2.4.2.19. Endpoints

Components of any type can specify the endpoints that the Docker image exposes. These endpoints can be made accessible to the users if the CodeReady Workspaces cluster is running using a Kubernetes ingress or an OpenShift route and to the other components within the workspace. You can create an endpoint for your application or database, if your application or database server is listening on a port and you want to be able to directly interact with it yourself or you want other components to interact with it.

Endpoints have several properties as shown in the following example:

```json
apiVersion: 1.0.0
metadata:
  name: MyDevfile
projects:
  - name: my-go-project
clonPath: go/src/github.com/acme/my-go-project
source:
  type: git
  location: https://github.com/acme/my-go-project.git
components:
  - type: dockerimage
    image: golang
```
memoryLimit: **512Mi**  
mountSources: true  
command: ['sleep', 'infinity']  
env:  
  - name: GOPATH  
    value: $(CHE_PROJECTS_ROOT)/go  
  - name: GOCACHE  
    value: /tmp/go-cache
endpoints:  
  - name: web  
    port: **8080**  
    attributes:  
      discoverable: false  
      public: true  
      protocol: http  
  - type: dockerimage  
  image: postgres  
  memoryLimit: **512Mi**  
  env:  
    - name: POSTGRES_USER  
      value: user  
    - name: POSTGRES_PASSWORD  
      value: password  
    - name: POSTGRES_DB  
      value: database
endpoints:  
  - name: postgres  
    port: **5432**  
    attributes:  
      discoverable: true  
      public: false

Here, there are two Docker images, each defining a single endpoint. Endpoint is an accessible port that can be made accessible inside the workspace or also publicly (example, from the UI). Each endpoint has a name and port, which is the port on which certain server running inside the container is listening. The following are a few attributes that you can set on the endpoint:

- **discoverable**: If an endpoint is discoverable, it means that it can be accessed using its name as the host name within the workspace containers (in the OpenShift terminology, a service is created for it with the provided name). 55

- **public**: The endpoint will be accessible outside of the workspace, too (such endpoint can be accessed from the CodeReady Workspaces user interface). Such endpoints are publicized always on port **80** or **443** (depending on whether **tls** is enabled in CodeReady Workspaces).

- **protocol**: For public endpoints the protocol is a hint to the UI on how to construct the URL for the endpoint access. Typical values are **http, https, ws, wss**.

- **secure**: A boolean (defaulting to false) specifying whether the endpoint is put behind a JWT proxy requiring a JWT workspace token to grant access. The JWT proxy is deployed in the same Pod as the server and assumes the server listens solely on the local loopback interface, such as **127.0.0.1**.
WARNING
Listening on any other interface than the local loopback poses a security risk because such server is accessible without the JWT authentication within the cluster network on the corresponding IP addresses.

- **path**: The URL of the endpoint.

IMPORTANT
Currently, it is not possible to specify a non-root path on secure endpoints. If you need your endpoint secured by CodeReady Workspaces, do not specify the path of the endpoint.

- **unsecuredPaths**: A comma-separated list of endpoint paths that are to stay unsecured even if the secure attribute is set to true.

- **cookiesAuthEnabled**: When set to true (the default is false), the JWT workspace token is automatically fetched and included in a workspace-specific cookie to allow requests to pass through the JWT proxy.

WARNING
This setting potentially allows a CSRF attack when used in conjunction with a server using POST requests.

When starting a new server within a component, CodeReady Workspaces autodetects this, and the UI offers to automatically expose this port as a public port. This is useful for debugging a web application, for example. It is impossible to do this for servers that autostart with the container (for example, a database server). For such components, specify the endpoints explicitly.

Example specifying endpoints for **kubernetes/openshift** and **chePlugin/cheEditor** types:

```yaml
apiVersion: 1.0.0
metadata:
  name: MyDevfile
components:
  - type: cheEditor
    alias: theia-editor
    id: eclipse/che-theia/next
    endpoints:
      - name: 'theia-extra-endpoint'
        port: 8880
        attributes:
          discoverable: true
```
3.2.4.2.20. OpenShift resources

To describe complex deployments, include references to OpenShift resource lists in the devfile. The OpenShift resource lists become a part of the workspace.

**IMPORTANT**

- CodeReady Workspaces merges all resources from the OpenShift resource lists into a single deployment.
- Be careful when designing such lists to avoid name conflicts and other problems.

**Table 3.2. Supported OpenShift resources**
<table>
<thead>
<tr>
<th>Platform</th>
<th>Supported resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenShift</td>
<td>deployments, pods, services, persistent volume claims, secrets, ConfigMaps, Routes</td>
</tr>
</tbody>
</table>

The preceding component references a file that is relative to the location of the devfile itself. Meaning, this devfile is only loadable by a CodeReady Workspaces factory to which you supply the location of the devfile and therefore it is able to figure out the location of the referenced OpenShift resource list.

The following is an example of the `postgres.yaml` file.

```yaml
apiVersion: 1.0.0
metadata:
  name: MyDevfile
projects:
  - name: my-go-project
    clonePath: go/src/github.com/acme/my-go-project
    source:
      type: git
      location: https://github.com/acme/my-go-project.git
components:
  - type: kubernetes
    reference: ../relative/path/postgres.yaml
```

```yaml
apiVersion: v1
kind: List
items:
  - apiVersion: v1
    kind: Deployment
    metadata:
      name: postgres
      labels:
        app: postgres
    spec:
      template:
        metadata:
          name: postgres
          app:
            name: postgres
        spec:
          containers:
          - image: postgres
            name: postgres
            ports:
            - name: postgres
              containerPort: 5432
            volumeMounts:
              - name: pg-storage
                mountPath: /var/lib/postgresql/data
          volumes:
          - name: pg-storage
            persistentVolumeClaim:
```
For a basic example of a devfile with an associated OpenShift list, see web-nodejs-with-db-sample on redhat-developer GitHub.

If you use generic or large resource lists from which you will only need a subset of resources, you can select particular resources from the list using a selector (which, as the usual OpenShift selectors, works on the labels of the resources in the list).

```
apiVersion: v1
kind: Service
metadata:
  name: postgres
  labels:
    app: postgres
    name: postgres
spec:
  ports:
  - port: 5432
    targetPort: 5432
  selector:
    app: postgres
```

```
apiVersion: v1
kind: PersistentVolumeClaim
metadata:
  name: pg-storage
  labels:
    app: postgres
spec:
  accessModes:
  -ReadWriteOnce
  resources:
    requests:
      storage: 1Gi
```

For a basic example of a devfile with an associated OpenShift list, see web-nodejs-with-db-sample on redhat-developer GitHub.

If you use generic or large resource lists from which you will only need a subset of resources, you can select particular resources from the list using a selector (which, as the usual OpenShift selectors, works on the labels of the resources in the list).

```
apiVersion: 1.0.0
metadata:
  name: MyDevfile
projects:
  - name: my-go-project
    clonePath: go/src/github.com/acme/my-go-project
    source:
      type: git
      location: https://github.com/acme/my-go-project.git
components:
  - type: kubernetes
    reference: ../relative/path/postgres.yaml
    selector:
      app: postgres
```

Additionally, it is also possible to modify the entrypoints (command and arguments) of the containers present in the resource list. For details of the advanced use case, see Defining specific container images.
3.2.4.3. Adding commands to a devfile

A devfile allows to specify commands to be available for execution in a workspace. Every command can contain a subset of actions, which are related to a specific component in whose container it will be executed.

You can use commands to automate the workspace. You can define commands for building and testing your code, or cleaning the database.

The following are two kinds of commands:

- CodeReady Workspaces specific commands: You have full control over what component executes the command.
- Editor specific commands: You can use the editor-specific command definitions (example: `tasks.json` and `launch.json` in Che-Theia, which is equivalent to how these files work in VS Code).

3.2.4.3.1. CodeReady Workspaces-specific commands

Each CodeReady Workspaces-specific command features:

- An `actions` attribute that specifies a command to execute.
- A `component` attribute that specifies the container in which to execute the command.

The commands are run using the default shell in the container.

```yaml
commands:
- name: build
  actions:
    - type: exec
      component: mysql
      command: mvn clean
      workdir: /projects/spring-petclinic
```

```
apiVersion: 1.0.0
metadata:
  name: MyDevfile
projects:
- name: my-go-project
  clonePath: go/src/github.com/acme/my-go-project
  source:
    type: git
    location: https://github.com/acme/my-go-project.git
components:
- type: dockerimage
  image: golang
  alias: go-cli
  memoryLimit: 512Mi
  mountSources: true
  command: ['sleep', 'infinity']
env:
- name: GOPATH
  value: $(CHE_PROJECTS_ROOT)/go
- name: GOCACHE
```
NOTE

- If a component to be used in a command must have an alias. This alias is used to reference the component in the command definition. Example: alias: go-cli in the component definition and component: go-cli in the command definition. This ensures that Red Hat CodeReady Workspaces can find the correct container to run the command in.

- A command can have only one action.

3.2.4.3.2. Editor-specific commands

If the editor in the workspace supports it, the devfile can specify additional configuration in the editor-specific format. This is dependent on the integration code present in the workspace editor itself and so is not a generic mechanism. However, the default Che-Theia editor within Red Hat CodeReady Workspaces is equipped to understand the tasks.json and launch.json files provided in the devfile.

```json
apiVersion: 1.0.0
metadata:
  name: MyDevfile
projects:
  - name: my-go-project
    clonePath: go/src/github.com/acme/my-go-project
    source:
      type: git
      location: https://github.com/acme/my-go-project.git
    commands:
      - name: tasks
        actions:
          - type: vscode-task
            referenceContent: >
              {
                "version": "2.0.0",
                "tasks": [
                  {
                    "label": "create test file",
                    "type": "shell",
                    "command": "touch ${workspaceFolder}/test.file"
                  }
                ]
              }
This example shows association of a tasks.json file with a devfile. Notice the vscode-task type that instructs the Che-Theia editor to interpret this command as a tasks definition and referenceContent attribute that contains the contents of the file itself. You can also save this file separately from the devfile and use reference attribute to specify a relative or absolute URL to it.
In addition to the `vscode-task` commands, the Che-Theia editor understands `vscode-launch` type using which you can specify the launch configurations.

### 3.2.4.3.3. Command preview URL

It is possible to specify a preview URL for commands that expose web UI. This URL is offered for opening when the command is executed.

```yaml
commands:
  - name: tasks
    previewUrl:
      port: 8080
      path: /myweb
    actions:
      - type: exec
        component: go-cli
        command: "go run webserver.go"
        workdir: ${CHE_PROJECTS_ROOT}/webserver

1. TCP port where the application listens. Mandatory parameter.
2. The path part of the URL to the UI. Optional parameter. The default is root (/).
```

The example above opens `http://__<server-domain>__/myweb`, where `<server-domain>` is the URL to the dynamically created OpenShift Route.

### 3.2.4.3.3.1. Setting the default way of opening preview URLs

By default, a notification that asks the user about the URL opening preference is displayed.

To specify the preferred way of previewing a service URL:

1. Open CodeReady Workspaces preferences in `File → Settings → Open Preferences` and find `che.task.preview.notifications` in the `CodeReady Workspaces` section.

2. Choose from the list of possible values:
   - `on` — enables a notification for asking the user about the URL opening preferences
   - `alwaysPreview` — the preview URL opens automatically in the Preview panel as soon as a task is running
   - `alwaysGoTo` — the preview URL opens automatically in a separate browser tab as soon as a task is running
   - `off` — disables opening the preview URL (automatically and with a notification)

### 3.2.4.4. Devfile attributes

Devfile attributes can be used to configure various features.

#### 3.2.4.4.1. Attribute: editorFree

- name: tasks
  previewUrl:
    port: 8080
    path: /myweb
  actions:
    - type: exec
      component: go-cli
      command: "go run webserver.go"
      workdir: ${CHE_PROJECTS_ROOT}/webserver

Red Hat CodeReady Workspaces 2.5 End-user Guide
When an editor is not specified in a devfile, a default is provided. When no editor is needed, use the `editorFree` attribute. The default value of `false` means that the devfile requests the provisioning of the default editor.

Example of a devfile without an editor

```yaml
apiVersion: 1.0.0
metadata:
  name: petclinic-dev-environment
components:
  - alias: myApp
    type: kubernetes
    reference: my-app.yaml
attributes:
  editorFree: true
```

3.2.4.4.2. Attribute: `persistVolumes` (ephemeral mode)

By default, volumes and PVCs specified in a devfile are bound to a host folder to persist data even after a container restart. To disable data persistence to make the workspace faster, such as when the volume back end is slow, modify the `persistVolumes` attribute in the devfile. The default value is `true`. Set to `false` to use `emptyDir` for configured volumes and PVC.

Example of a devfile with ephemeral mode enabled

```yaml
apiVersion: 1.0.0
metadata:
  name: petclinic-dev-environment
projects:
  - name: petclinic
    source:
      type: git
      location: 'https://github.com/che-samples/web-java-spring-petclinic.git'
attributes:
  persistVolumes: false
```

3.2.4.4.3. Attribute: `asyncPersist` (asynchronous storage)

When `persistVolumes` is set to `false` (see above), the additional attribute `asyncPersist` can be set to `true` to enable asynchronous storage. See [https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/installation_guide/index#configuring-storage-types_crw](https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/installation_guide/index#configuring-storage-types_crw) for more details.

Example of a devfile with asynchronous storage enabled

```yaml
apiVersion: 1.0.0
metadata:
  name: petclinic-dev-environment
projects:
  - name: petclinic
    source:
      type: git
      location: 'https://github.com/che-samples/web-java-spring-petclinic.git'
```

CHAPTER 3. DEVELOPER WORKSPACES
3.2.4.4. Attribute: mergePlugins

This property can be set to manually control how plugins are included in the workspace. When the property `mergePlugins` is set to `true`, Che will attempt to avoid running multiple instances of the same container by combining plugins. The default value when this property is not included in a devfile is governed by the Che configuration property `che.workspace.plugin_broker.default_merge_plugins`; adding the `mergePlugins: false` attribute to a devfile will disable plugin merging for that workspace.

Example of a devfile with plugin merging disabled

```yaml
apiVersion: 1.0.0
metadata:
  name: petclinic-dev-environment
projects:
  - name: petclinic
    source:
      type: git
      location: 'https://github.com/che-samples/web-java-spring-petclinic.git'
attributes:
  mergePlugins: false
```

3.2.5. Objects supported in Red Hat CodeReady Workspaces 2.5

The following table lists the objects that are partially supported in Red Hat CodeReady Workspaces 2.5:

<table>
<thead>
<tr>
<th>Object</th>
<th>API</th>
<th>Kubernetes Infra</th>
<th>OpenShift Infra</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Deploy</td>
<td>ment</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Config</td>
<td>Map</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>PVC</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Secret</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Service</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>
### Ingress

Minishift allows you to create Ingress and it works when the host is specified (OpenShift creates a route for it). But, the loadBalancer IP is not provisioned. To add Ingress support for the OpenShift infrastructure node, generate routes based on the provided Ingress.

<table>
<thead>
<tr>
<th>Object</th>
<th>API</th>
<th>Kubernetes Infra</th>
<th>OpenShift Infra</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ingress</td>
<td>Kubernetes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### Route

The OpenShift recipe must be made compatible with the Kubernetes Infrastructure and, instead of the provided route, generate Ingress.

<table>
<thead>
<tr>
<th>Object</th>
<th>API</th>
<th>Kubernetes Infra</th>
<th>OpenShift Infra</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route</td>
<td>OpenShift</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

### Template

The Kubernetes API does not support templates. A workspace with a template in the recipe starts successfully and the default parameters are resolved.

<table>
<thead>
<tr>
<th>Object</th>
<th>API</th>
<th>Kubernetes Infra</th>
<th>OpenShift Infra</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>OpenShift</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

### Additional resources

- Devfile specifications

### 3.3. CREATING AND CONFIGURING A NEW CODEREADY WORKSPACES 2.5 WORKSPACE

#### 3.3.1. Creating a new workspace from the dashboard

This procedure describes how to create and edit a new CodeReady Workspaces devfile using the Dashboard.

### Prerequisites

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).

### Procedure

To edit the devfile:

1. In the Workspaces window, click the Add Workspace button. The Custom Workspace page should be opened.

2. Scroll down to the Devfile section and edit the devfile using Devfile editor.
See an example below:

**Example - Adding a .git project into a workspace using a devfile**

In the following instance, the project crw acts as the example of a user’s project. A user specifies this project using the `name` attribute of a devfile. The `location` attribute defines the source repository represented by an URL to a Git repository or ZIP archive.

To add a project into the workspace, add or edit the following section:

```
projects:
- name: <crw>
  source:
    type: git
    location: 'https://github.com/<github-organization>/<crw>.git'
```

For additional information, see the Section 3.2.4, “Devfile reference” section.

### 3.3.2. Adding projects to your workspace

**Prerequisites**

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).

- An existing workspace defined on this instance of Red Hat CodeReady Workspaces. See [Creating and configuring a new CodeReady Workspaces 2.5 workspace](#).

**Procedure**

To add a project to your workspace:

1. Navigate to **Workspaces** page and click the workspace you want to update. 
   Here you have two ways to add a project to your workspace:

2. From the **Projects** tab.
   a. Open the **Projects** tab, and then click the **Add Project** button.
   b. Choose if you want to import the project by Git URL or from your GitHub account.
3. From the **Devfile** tab.
   a. Open the **Devfile** tab.
   b. In the **Devfile editor**, add **projects** section with desired project.

For demonstration example, see below:

**Example - Adding a .git project into a workspace using a devfile**

In the following instance, the project **crw** acts as the example of a user’s project. A user specifies this project using the **name** attribute of a devfile. The **location** attribute defines the source repository represented by an URL to a Git repository or ZIP archive.

To add a project into the workspace, add or edit the following section:

```yaml
projects:
  - name: <crw>
    source:
      type: git
      location: 'https://github.com/<github-organization>/<crw>.git'
```

For additional information, see the Section 3.2.4, “Devfile reference” section.

1. Once the project is added, click **Save** button to save this workspace configuration, or click **Apply** button to apply changes to the running workspace.

### 3.3.3. Configuring the workspace and adding tools

#### 3.3.3.1. Adding plug-ins
Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces. See Creating and configuring a new CodeReady Workspaces 2.5 workspace.

Procedure

To add plug-ins to your workspace:

1. Click the **Plugins** tab.
2. Enable the plug-in that you want to add and click the **Save** button.

3.3.3.2. Defining the workspace editor

Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces. See Creating and configuring a new CodeReady Workspaces 2.5 workspace.

Procedure

To define the editor to use with the workspace:

1. Click the **Editors** tab.

   **NOTE**

   The recommended editor for CodeReady Workspaces 2.5 is Che-Theia.

2. Enable the editor to add and click the **Save** button.

3. Click the **Devfile** tab to view the changes.
3.3.3.3. Defining specific container images

Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces. See Creating and configuring a new CodeReady Workspaces 2.5 workspace.

Procedure

To add a new container image:

1. In the Devfile tab, add the following section under the components property:

   ```yaml
   components:
     - mountSources: true
       command:
         - sleep
       args:
         - infinity
       memoryLimit: 1Gi
       alias: maven3-jdk11
       type: dockerimage
       endpoints:
         - name: 8080/tcp
           port: 8080
       volumes:
         - name: projects
           containerPath: /projects
       image: 'maven:3.6.0-jdk-11'
   
   a. Set the type from the original CodeReady Workspaces 2.4 configuration. The following is an example of the resulting file:

   ```yaml
   .. code-block:: yaml

     components:
       - mountSources: true
         command:
           - sleep
         args:
           - infinity
         memoryLimit: 512Mi
         preferences: {}
         volumes: {}
         referenceContent: {}
         apiVersion: v1
         kind: Pod
         metadata:
           name: ws
           spec:
             containers:
               -
                 image: 'rchw/santos_jdk8:latest'
                 name: dev
                 resources:
                   limits: {}
                   memory: 512Mi
                 command:
                   - sleep
                 endpoints: {}
                 mountSources: true
                 type: kubernetes
                 apiVersion: 1.0.0
                 attributes: {}
   ```

2. Add a CodeReady Workspaces 2.4 recipe content to the CodeReady Workspaces 2.5 devfile as referenceContent.
3. Copy the required fields, such as **image**, **volumes**, and **endpoints** from the old workspace. See below:

![Workspace configuration commands in CodeReady Workspaces 2.5](image)

4. If needed, change the **memoryLimit** and **alias** variables. The field **alias** is used to set a name for the component and if not manually set, it is generated from the values of the **image** attribute field.

```
image: 'maven:3.6.0-jdk-11'
alias: maven3-jdk11
```

5. To specify the **RAM** component requirements, set the **memoryLimit**, **memoryRequest**, or both.

```
alias: maven3-jdk11
memoryLimit: 256M
memoryRequest: 128M
```

6. Repeat the steps to add additional container images.

### 3.3.3.4. Adding commands to your workspace

The following image is a demonstration of workspace configuration commands in CodeReady Workspaces 2.5:
Figure 3.1. An example of the Workspace configuration commands in CodeReady Workspaces 2.5

Overview Projects Plugins Editors Devfile

Workspace

```
metadata:
  name: wksp-che7
projects:
  - name: web-spring-java-simple
    source:
      location: 'https://github.com/codenvy-templates/web-spring-java-simple.git'
    type: git
  components:
    - mountSources: false
      id: eclipse/che-machine-exec-plugin/latest
      type: chePlugin
    - mountSources: false
      id: redhat/java/latest
      type: chePlugin
    - mountSources: false
      id: eclipse/che-theia/latest
      type: cheEditor
apiVersion: 1.0.0
```

Prerequisites

- An existing workspace defined on this instance of Red Hat CodeReady Workspaces. See Creating and configuring a new CodeReady Workspaces 2.5 workspace.

Procedure

To define commands to your workspace, edit the workspace devfile:

1. Add or edit the **command** section with the first command. Change the **name** and the **command** fields from the original workspace configuration (see the preceding equivalence table).

   ```yaml
   commands:
   - name: build
     actions:
     - type: exec
       command: mvn clean install
   ``

2. To add a new command or edit command from other devfile, copy the following YAML code into the **command** section and define the a command.

   a. Change the **name** and the **command** fields from the original workspace configuration, as shown in the introduction screenshot of this chapter.

   ```yaml
   - name: build and run
     actions:
     - type: exec
       command: mvn clean install && java -jar
   ```

3. Optionally, add the **component** field into **actions**. This indicates the component alias where the command will be performed.

4. Repeat step 2 to add more commands to the devfile.
5. Click the **Devfile** tab to view the changes.

```
Workspace

  13.   port: 8080
      14.   command:
      15.       - sleep
      16.   args:
      17.       - infinity
      18.   memoryLimit: 1Gi
      19.   type: dockerimage
      20.   volumes:
      21.       - name: projects
                 22.         containerPath: /projects
      23.   image: 'maven:3.6.0-jdk-11'
      24.   alias: maven3-jdk11
      25.   - mountsources: false
      26.   id: redhat/java/latest
      27.   type: chePlugin
      28.   - mountsources: false
      29.   id: eclipse/che-machine-exec-plugin/latest
      30.   type: chePlugin
      31.   - mountsources: false
      32.   id: eclipse/che-theia/latest
      33.   type: cheEditor
      34.   apiVersion: 1.0.0
      35.   commands:
      36.       - name: build
                 37.         actions:
      38.           - workdir: /projects/web-spring-java-simple
                 39.             type: exec
      40.       command: mvn clean install
      41.       component: maven3-jdk11
```

6. Save changes and start the new CodeReady Workspaces 2.5 workspace.

---

3.4. IMPORTING A OPENSHIFT APPLICATION INTO A WORKSPACE

This section describes how to import a OpenShift application into a CodeReady Workspaces workspace.

For demonstration purposes, the section uses a sample OpenShift application having the following two Pods:

- A Node.js application specified by this `nodejs-app.yaml`

---
To run the application on an OpenShift cluster:

```bash
$ node=https://raw.githubusercontent.com/redhat-developer/devfile/master/samples/web-nodejs-with-db-sample/nodejs-app.yaml && \
mongo=https://raw.githubusercontent.com/redhat-developer/devfile/master/samples/web-nodejs-with-db-sample/mongo-db.yaml && \
oc  apply -f ${mongo} && \
oc  apply -f ${node}
```

To deploy a new instance of this application in a CodeReady Workspaces workspace, use one of the following three scenarios:

- Starting from scratch: Writing a new devfile
- Modifying an existing workspace: Using the Dashboard user interface
- From a running application: Generating a devfile with crwctl

### 3.4.1. Including a OpenShift application in a workspace devfile definition

This procedure describes how to define a CodeReady Workspaces workspace devfile to include an OpenShift application.

The devfile format is used to define a CodeReady Workspaces workspace, and its format is described in the Section 3.2, "Making a workspace portable using a devfile" section.

#### Prerequisites


#### Procedure

1. Create the simplest devfile:

```yaml
apiVersion: 1.0.0
metadata:
  name: minimal-workspace
```

   1 Only the name **minimal-workspace** is specified. After the CodeReady Workspaces server processes this devfile, the devfile is converted to a minimal CodeReady Workspaces workspace that only has the default editor (Che-Theia) and the default editor plug-ins, including, for example, the terminal.

2. To add OpenShift applications to a workspace, modify the devfile and add the **OpenShift** component type.
For example, to embed the NodeJS-Mongo application in the **minimal-workspace**:

```yaml
apiVersion: 1.0.0
metadata:
  name: minimal-workspace
components:
  - type: kubernetes
    reference: https://raw.githubusercontent.com/.../mongo-db.yaml
  - alias: nodejs-app
    type: kubernetes
    reference: https://raw.githubusercontent.com/.../nodejs-app.yaml
entrypoints:
  - command: ['sleep']
    args: ['infinity']
```

The **sleep infinity** command is added as the entrypoint of the Node.js application. The command prevents the application from starting at the workspace start phase. This configuration allows the user to start the application when needed for testing or debugging purposes.

3. Add the commands in the devfile to make it easier for a developer to test the application:

```yaml
apiVersion: 1.0.0
metadata:
  name: minimal-workspace
components:
  - type: kubernetes
    reference: https://raw.githubusercontent.com/.../mongo-db.yaml
  - alias: nodejs-app
    type: kubernetes
    reference: https://raw.githubusercontent.com/.../nodejs-app.yaml
entrypoints:
  - command: ['sleep']
    args: ['infinity']
commands:
  - name: run
    actions:
      - type: exec
        component: nodejs-app
        command: cd ${CHE_PROJECTS_ROOT}/nodejs-mongo-app/EmployeeDB/ && npm install && sed -i -- "s/localhost/mongo/g" app.js && node app.js
```

The **run** command added to the devfile is available as a task in Che-Theia from the command palette. When executed, the command starts the Node.js application.

4. Use the devfile to create and start a workspace:

   ```shell
   $ crwctl workspace:start --devfile <devfile-path>
   ```

### 3.4.2. Adding a OpenShift application to an existing workspace using the dashboard

This procedure demonstrates how to modify an existing workspace and import the OpenShift application using the newly created devfile.
Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”.

Procedure

1. After the creation of a workspace, use the **Workspace** menu and then the **Configure workspace** icon to manage the workspace.

2. To modify the workspace details, use the **Devfile** tab. The workspace details are displayed in this tab in the devfile format.

3. To add a OpenShift component, use the **Devfile** editor on the dashboard.

4. For the changes to take effect, save the devfile and restart the CodeReady Workspaces workspace.

3.4.3. Generating a devfile from an existing OpenShift application

This procedure demonstrates how to generate a devfile from an existing OpenShift application using the `crwctl` tool.

Prerequisites
• A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see Installing CodeReady Workspaces.

• The `crwctl` management tool is available. See https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/installation_guide/index#installing-the-crwctl-management-tool.

Procedure

1. To generate a devfile, use:

   ```bash
   $ crwctl devfile:generate
   ```

   It is also possible to generate a devfile from, for example, the NodeJS-MongoDB application that includes the NodeJS component, using the `crwctl devfile:generate` command:

   Example:

   ```bash
   $ crwctl devfile:generate --selector="app=nodejs"
   apiVersion: 1.0.0
   metadata:
     name: crwctl-generated
   components:
     - type: kubernetes
       alias: app=nodejs
       referenceContent: |
         kind: List
         apiVersion: v1
         metadata:
           name: app=nodejs
         items:
           - apiVersion: apps/v1
             kind: Deployment
             metadata:
               labels:
                 app: nodejs
             name: web
   ```

   The Node.js application YAML definition is available in the devfile, inline, using the `referenceContent` attribute.

   • To include support for a language, use the `--language` parameter:

   ```bash
   $ crwctl devfile:generate --selector="app=nodejs" --language="typescript"
   apiVersion: 1.0.0
   metadata:
     name: crwctl-generated
   components:
     - type: kubernetes
       alias: app=nodejs
       referenceContent: |
         kind: List
         apiVersion: v1
         metadata:
           name: app=nodejs
         items:
           - apiVersion: apps/v1
             kind: Deployment
             metadata:
               labels:
                 app: nodejs
             name: web
   ```
2. Use the generated devfile to start a CodeReady Workspaces workspace with `crwctl`.

```bash
$ crwctl workspace:start --devfile=devfile.yaml
```

### 3.5. REMOTELY ACCESSING WORKSPACES

This section describes how to remotely access CodeReady Workspaces workspaces outside of the browser.

CodeReady Workspaces workspaces exist as containers and are, by default, modified from a browser window. In addition to this, there are the following methods of interacting with a CodeReady Workspaces workspace:

- Opening a command line in the workspace container using the OpenShift command-line tool, `oc`
- Uploading and downloading files using the `oc` tool

#### 3.5.1. Remotely accessing workspaces using `oc`

To access CodeReady Workspaces workspaces remotely using OpenShift command-line tool (`oc`), follow the instructions in this section.

**Prerequisites**

- The `oc`, version 1.5.0 or higher, is available. For information about installed version, use:

```bash
$ oc version
Client Version: version.Info{Major:"1", Minor:"15", GitVersion:"v1.15.0"
...
```

**Procedure**

In the example below:

- **workspace7b2wemdf3hx7s3ln.maven-74885cf4d5-kf2q4** is the name of the Pod.
- **crw** is the project.

1. To find the name of the OpenShift project and the Pod that runs the CodeReady Workspaces workspace:

```bash
$ oc get pod -l che.workspace_id --all-namespaces
```

<table>
<thead>
<tr>
<th>NAMESPACE</th>
<th>NAME</th>
<th>READY</th>
<th>STATUS</th>
<th>RESTARTS</th>
<th>AGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>crw</td>
<td>workspace7b2wemdf3hx7s3ln.maven-74885cf4d5-kf2q4</td>
<td>4/4</td>
<td>Running</td>
<td>0</td>
<td>6m4s</td>
</tr>
</tbody>
</table>

2. To find the name of the container:
3. When you have the project, pod name, and the name of the container, use the `oc` command to open a remote shell:

```
$ NAMESPACE=crw
$ POD=workspace7b2wemdf3hx7s3ln.maven-74885cf4d5-kf2q4
$ oc get pod ${POD} -o custom-columns=CONTAINERS:.spec.containers[*].name
CONTAINERS
maven,che-machine-execpau,theia-ide6dj,vscode-javaw92
```

4. From the container, execute the build and run commands (as if from the CodeReady Workspaces workspace terminal):

```
user@workspace7b2wemdf3hx7s3ln $ mvn clean install
[INFO] Scanning for projects...
(…)
```

### 3.5.2. Downloading and uploading a file to a workspace using the command-line interface

This procedure describes how to use the `oc` tool to download or upload files remotely from or to an Red Hat CodeReady Workspaces workspace.

**Prerequisites**

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).
- Remote access to the CodeReady Workspaces workspace you intend to modify. For instructions see Section 3.5, “Remotely accessing workspaces”.
- The `oc`, version 1.5.0 or higher, is available. For information about installed version, use:

```
$ oc version
Client Version: version.Info{Major:"1", Minor:"15", GitVersion:"v1.15.0"
...
```

**Procedure**

The following procedure uses `crw` as an example of a user project.

- To download a local file named `downloadme.txt` from a workspace container to the current home directory of the user, use the following in the CodeReady Workspaces remote shell.

```
$ REMOTE_FILE_PATH=/projects-downloadme.txt
$ NAMESPACE=crw
$ POD=workspace7b2wemdf3hx7s3ln.maven-74885cf4d5-kf2q4
```
To upload a local file named `uploadme.txt` to a workspace container in the `/projects` directory:

```
$ LOCAL_FILE_PATH=./uploadme.txt
$ NAMESPACE=crw
$ POD=workspace7b2wemdf3hx7s3ln.maven-74885cf4d5-kf2q4
$ CONTAINER=maven
$ oc cp ${LOCAL_FILE_PATH} ${NAMESPACE}/${POD}:/projects -c ${CONTAINER}
```

Using the preceding steps, the user can also download and upload directories.

### 3.6. CREATING A WORKSPACE FROM CODE SAMPLE

Every stack includes a sample codebase, which is defined by the devfile of the stack. This section explains how to create a workspace from this code sample in a sequence of three procedures.

1. Creating a workspace from the user dashboard:
   a. Using the **Get Started view**.
   b. Using the **Custom Workspace view**.

2. Changing the configuration of the workspace to add code sample.

3. Running an existing workspace from the user dashboard.

For more information about devfiles, see Section 3.1, “Configuring a workspace using a devfile”.

#### 3.6.1. Creating a workspace from Get Started view of User Dashboard

This section describes how to create a workspace from the User Dashboard.

**Prerequisites**


**Procedure**

1. Navigate to the CodeReady Workspaces Dashboard. See Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”.

2. In the left navigation panel, go to **Get Started**.

3. Click the **Get Started** tab.

4. In the gallery, there is list of samples that may be used to build and run projects.
CHANGING RESOURCE LIMITS

Changing the memory requirements is only possible from the devfile. See Section 3.6.3, "Changing the configuration of an existing workspace".

5. Start the workspace: click the chosen stack card.
Workspace name can be auto-generated based on the underlying devfile of the stack. Generated names always consist of the devfile `metadata.generateName` property as the prefix and four random characters.

### 3.6.2. Creating a workspace from Custom Workspace view of User Dashboard

This section describes how to create a workspace from the User Dashboard.

**Prerequisites**


**Procedure**

1. Navigate to the CodeReady Workspaces Dashboard. See Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”.

2. In the left navigation panel, go to Get Started.

3. Click the Custom Workspace tab.

4. Define a Name for the workspace.

5. In the Devfile section, select the devfile template that will be used to build and run projects.

### CHANGING RESOURCE LIMITS

Changing the memory requirements is only possible from the devfile. See Section 3.6.3, “Changing the configuration of an existing workspace”.
3.6.3. Changing the configuration of an existing workspace

This section describes how to change the configuration of an existing workspace from the User Dashboard.

Prerequisites

- An existing workspace defined on this instance of Red Hat CodeReady Workspaces Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”.

Procedure

1. Navigate to the CodeReady Workspaces Dashboard. See Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”.

2. In the left navigation panel, go to Workspaces.

3. Click the name of a workspace to navigate to the configuration overview page.

4. Click the Overview tab and execute following actions:
   - Change the Workspace name.
   - Select Storage Type.
   - Export the workspace configuration to a file or private cloud.
   - Delete the workspace.

5. In the Projects section, choose the projects to integrate in the workspace.
a. Click the **Add Project** button and do one of the following:

i. Enter the project Git repository URL to integrate in the workspace:

![Image of Add Project button with Git URL field]

ii. Connect your GitHub account and select projects to integrate:

![Image of Add Project button with connected GitHub account]

b. Click the **Add** button.

6. In the **Plugins** section, choose the plug-ins to integrate in the workspace.

**EXAMPLE**

Start with a generic Java-based stack, then add support for Node.js or Python.

7. In the **Editors** section, choose the editors to integrate in the workspace. The CodeReady Workspaces 2.5 editor is based on Che-Theia.

8. From the **Devfile** tab, edit YAML configuration of the workspace. See **Section 3.2, “Making a workspace portable using a devfile”**.

**EXAMPLE: ADD COMMANDS**

```
-XX:AdaptiveSizePolicyWeight=90 -Dsun.zip.disableMemoryMapping=true
-Xes2m -Djava.security.egd=file:/dev/urandom
name: JAVA TOOL OPTIONS
- value: '$(echo $0)\$'
- name: JAVA
- value: '/home/user
name: JAVA
apiVersion: 1.0.0
commands:
  - name: build the project
    actions:
      - type: exec
        command: 'cd $(CHE_PROJECTS_ROOT)/fuse-rest-http-booster && mvn clean install'
        component: maven
  - name: run the services
    actions:
      - type: exec
        command: 'cd $(CHE_PROJECTS_ROOT)/fuse-rest-http-booster && mvn spring-boot:run -DskipTests
        component: maven
  - name: run and debug the services
    actions:
      - type: exec
        command: 'cd $(CHE_PROJECTS_ROOT)/fuse-rest-http-booster && mvn spring-boot:run -DskipTests -Drun.jvmArguments=-Xdebug -Xrunjvm:transport=dt_socket,server=y,suspend=n,address=5005'
        component: maven
```
EXAMPLE: ADD A PROJECT

To add a project into the workspace, add or edit the following section:

```yaml
projects:
  - name: che
    source:
      type: git
    location: 'https://github.com/eclipse/che.git'
```

3.6.4. Running an existing workspace from the User Dashboard

This section describes how to run an existing workspace from the User Dashboard.

3.6.4.1. Running an existing workspace from the User Dashboard with the Run button

This section describes how to run an existing workspace from the User Dashboard using the Run button.

**Prerequisites**

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).
- An existing workspace defined on this instance of Red Hat CodeReady Workspaces [Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”](#).

**Procedure**

1. Navigate to the CodeReady Workspaces Dashboard. See [Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”](#).

2. In the left navigation panel, navigate to Workspaces.

3. Click on the name of a non-running workspace to navigate to the overview page.

4. Click on the Run button in the top right corner of the page.

5. The workspace is started.

6. The browser does not navigate to the workspace.

3.6.4.2. Running an existing workspace from the User Dashboard using the Open button

This section describes how to run an existing workspace from the User Dashboard using the Open button.

**Prerequisites**

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).
- An existing workspace defined on this instance of Red Hat CodeReady Workspaces [Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”](#).
CHAPTER 3. DEVELOPER WORKSPACES

Procedure

1. Navigate to the CodeReady Workspaces Dashboard. See Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”.

2. In the left navigation panel, navigate to Workspaces.

3. Click on the name of a non-running workspace to navigate to the overview page.

4. Click on the Open button in the top right corner of the page.

5. The workspace is started.

6. The browser navigates to the workspace.

3.6.4.3. Running an existing workspace from the User Dashboard using the Recent Workspaces

This section describes how to run an existing workspace from the User Dashboard using the Recent Workspaces.

Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”.

Procedure

1. Navigate to the CodeReady Workspaces Dashboard. See Section 1.1, “Navigating CodeReady Workspaces using the Dashboard”.

2. In the left navigation panel, in the Recent Workspaces section, right-click the name of a non-running workspace and click Run in the contextual menu to start it.
3.7. CREATING A WORKSPACE BY IMPORTING THE SOURCE CODE OF A PROJECT

This section describes how to create a new workspace to edit an existing codebase.

Prerequisites


- An existing workspace with plug-ins related to your development environment defined on this instance of Red Hat CodeReady Workspaces Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”.

You can do it in two ways before starting a workspace:

- Select a sample from the Dashboard, then change the devfile to include your project

- Section 3.1, "Configuring a workspace using a devfile"

To create a new workspace to edit an existing codebase, use one of the following three methods after you have started the workspace:

- Import from the Dashboard into an existing workspace

- Import to a running workspace using the git clone command

- Import to a running workspace using git clone in a terminal
3.7.1. Select a sample from the Dashboard, then change the devfile to include your project

- In the left navigation panel, go to Get Started.
- Click the Custom Workspace tab if it’s not already selected.
- In the Devfile section, select the devfile template that will be used to build and run projects.

In the Devfile editor, update projects section:

**EXAMPLE: ADD A PROJECT**

To add a project into the workspace, add or edit the following section:

```
projects:
- name: che
  source:
    type: git
    location: 'https://github.com/eclipse/che.git'
```

See the Section 3.2.4, “Devfile reference”.

- To open the workspace, click the Create & Open button.

3.7.2. Importing from the Dashboard into an existing workspace
1. Import the project. There are at least two ways to import a project using the **Dashboard**.

   - From the **Dashboard**, select **Workspaces**, then select your workspace by clicking on its name. This will link you to the workspace’s **Overview** tab.

   - Or, use the gear icon. This will link to the **Devfile** tab where you can enter your own YAML configuration.

2. Click the **Projects** tab.

3. Click **Add Project**. You can then import project by a repository Git URL or from GitHub.

   ![Add Project](image)

**NOTE**

You can add a project to a non-running workspace, but you must start the workspace to delete it.

### 3.7.2.1. Editing the commands after importing a project

After you have a project in your workspace, you can add commands to it. Adding commands to your projects allows you to run, debug, or launch your application in a browser.

To add commands to the project:

1. Open the workspace configuration in the **Dashboard**, then select the **Devfile** tab.

2. Open the workspace.
3. To run a command, select Terminal > Run Task from the main menu.

4. To configure commands, select Terminal > Configure Tasks from the main menu.

3.7.3. Importing to a running workspace using the Git: Clone command

To import to a running workspace using the Git: Clone command:

1. Start a workspace, then use the Git: Clone command from the command palette or the Welcome screen to import a project to a running workspace.
2. Open the command palette using **F1** or **CTRL-SHIFT-P**, or from the link in the Welcome screen.

3. Enter the path to the project you want to clone.

3.7.4. **Importing to a running workspace with git clone in a terminal**

In addition to the approaches above, you can also start a workspace, open a **Terminal**, and type **`git clone`** to pull code.
NOTE

Importing or deleting workspace projects in the terminal does not update the workspace configuration, and the change is not reflected in the Project and Devfile tabs in the dashboard.

Similarly, if you add a project using the Dashboard, then delete it with `rm -fr myproject`, it may still appear in the Projects or Devfile tab.

3.8. MOUNTING A SECRET AS A FILE OR AN ENVIRONMENT VARIABLE INTO A WORKSPACE CONTAINER

Secrets are OpenShift objects that store sensitive data such as user names, passwords, authentication tokens, and configurations in an encrypted form.

Users can mount a secret that contains sensitive data in a workspace container. This reapplies the stored data from the secret automatically for every newly created workspace. As a result, the user does not have to provide these credentials and configuration settings manually.

The following section describes how to automatically mount an OpenShift secret in a workspace container and create permanent mount points for components such as:

- Maven configuration, the `settings.xml` file
- SSH key pairs
- AWS authorization tokens
- Git credentials store file

A OpenShift secret can be mounted into a workspace container as:

- A file - This creates automatically mounted Maven settings that will be applied to every new workspace with Maven capabilities.
- An environment variable - This uses SSH key pairs and AWS authorization tokens for automatic authentication.
NOTE

SSH key pairs can also be mounted as a file, but this format is primarily aimed at the settings of the Maven configuration.

The mounting process uses the standard OpenShift mounting mechanism, but it requires additional annotations and labeling for a proper bound of a secret with the required CodeReady Workspaces workspace container.

3.8.1. Mounting a secret as a file into a workspace container

WARNING

On OpenShift 3.11, secrets mounted as file overrides volume mounts defined in the devfile.

This section describes how to mount a secret from the user’s project as a file in single-workspace or multiple-workspace containers of CodeReady Workspaces.

Prerequisites


Procedure

1. Create a new OpenShift secret in the OpenShift project where a CodeReady Workspaces workspace will be created.

   - The labels of the secret that is about to be created must match the set of labels configured in `che.workspace.provision.secret.labels` property of CodeReady Workspaces. The default labels are:

     - `app.kubernetes.io/part-of: che.eclipse.org`
     - `app.kubernetes.io/component: workspace-secret`

   NOTE

   Note that the following example describes variations in the usage of the `target-container` annotation in versions 2.1 and 2.2 of Red Hat CodeReady Workspaces.

   Example:

   ```yaml
   apiVersion: v1
   kind: Secret
   metadata:
     name: mvn-settings-secret
   ```
Annotations must indicate the given secret is mounted as a file, provide the mount path, and, optionally, specify the name of the container in which the secret is mounted. If there is no target-container annotation, the secret will be mounted into all user containers of the CodeReady Workspaces workspace, but this is applicable only for the CodeReady Workspaces version 2.1.

Since the CodeReady Workspaces version 2.2, the target-container annotation is deprecated and the automount-workspace-secret annotation with Boolean values is introduced. Its purpose is to define the default secret mounting behavior, with the ability to be overridden in a devfile. The true value enables the automatic mounting into all workspace containers. In contrast, the false value disables the mounting process until it is explicitly requested in a devfile component using the automountWorkspaceSecrets: true property.

Data of the OpenShift secret may contain several items, whose names must match the desired file name mounted into the container.
This results in a file named `settings.xml` being mounted at the `/home/jboss/.m2/` path of all workspace containers.

The secret's mount path can be overridden for specific components of the workspace using devfile. To change mount path, an additional volume should be declared in a component of the devfile, with name matching overridden secret name, and desired mount path.

```
apiVersion: 1.0.0
metadata:
	components:
		- type: dockerimage
		  alias: maven
		  image: maven:3.11
		  volumes:
		    - name: <secret-name>
		      containerPath: /my/new/path
```

Note that for this kind of overrides, components must declare an alias to be able to distinguish containers which belong to them and apply override path exclusively for those containers.

### 3.8.2. Mounting a secret as an environment variable into a workspace container

The following section describes how to mount a OpenShift secret from the user's project as an environment variable, or variables, into single-workspace or multiple-workspace containers of CodeReady Workspaces.

**Prerequisites**

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).

**Procedure**

1. Create a new OpenShift secret in the k8s project where a CodeReady Workspaces workspace will be created.

   - The labels of the secret that is about to be created must match the set of labels configured in `che.workspace.provision.secret.labels` property of CodeReady Workspaces. By default, it is a set of two labels:

   - `app.kubernetes.io/part-of: che.eclipse.org`
   - `app.kubernetes.io/component: workspace-secret`
Note that the following example describes variations in the usage of the `target-container` annotation in versions 2.1 and 2.2 of Red Hat CodeReady Workspaces.

Example:

```yaml
apiVersion: v1
kind: Secret
metadata:
  name: mvn-settings-secret
  labels:
    app.kubernetes.io/part-of: che.eclipse.org
    app.kubernetes.io/component: workspace-secret
...
```

Annotations must indicate that the given secret is mounted as an environment variable, provides variable names, and optionally, specifies the container name where this mount will be applied. If there is no target-container annotation defined, the secret will be mounted into all user containers of the CodeReady Workspaces workspace, but this is applicable **only for the CodeReady Workspaces version 2.1**.

```yaml
apiVersion: v1
kind: Secret
metadata:
  name: mvn-settings-secret
  annotations:
    che.eclipse.org/target-container: maven
    che.eclipse.org/env-name: FOO_ENV
    che.eclipse.org/mount-as: env
  labels:
...
data:
  mykey: myvalue
```

This results in the environment variable named `FOO_ENV` and the value `myvalue` being provisioned into the container named `maven`.

*Since the CodeReady Workspaces version 2.2*, the `target-container` annotation is deprecated and `automount-workspace-secret` annotation with Boolean values is introduced. Its purpose is to define the default secret mounting behavior, with the ability to be overridden in a devfile. The `true` value enables the automatic mounting into all workspace containers. In contrast, the `false` value disables the mounting process until it is explicitly requested in a devfile component using the `automountWorkspaceSecrets:true` property.

```yaml
apiVersion: v1
kind: Secret
metadata:
  name: mvn-settings-secret
  annotations:
    che.eclipse.org/automount-workspace-secret: true
    che.eclipse.org/env-name: FOO_ENV
    che.eclipse.org/mount-as: env
```
This results in the environment variable named `FOO_ENV` and the value `myvalue` being provisioned into all workspace containers.

If the secret provides more than one data item, the environment variable name must be provided for each of the data keys as follows:

```json
apiVersion: v1
classKind: Secret
metadata:
  name: mvn-settings-secret
  annotations:
    che.eclipse.org/automount-workspace-secret: true
    che.eclipse.org/mount-as: env
    che.eclipse.org/mykey_env-name: FOO_ENV
    che.eclipse.org/otherkey_env-name: OTHER_ENV
labels:
...`

data:
  mykey: myvalue
  otherkey: othervalue
```

This results in two environment variables with names `FOO_ENV`, `OTHER_ENV`, and values `myvalue` and `othervalue`, being provisioned into all workspace containers.

**NOTE**

The maximum length of annotation names in an OpenShift secret is 63 characters, where 9 characters are reserved for a prefix that ends with `/`. This acts as a restriction for the maximum length of the key that can be used for the secret.

### 3.8.3. Mounting a git credentials store into a workspace container

This section describes how to mount git credentials store as secret from the user’s project into the file in single-workspace or multiple-workspace containers of CodeReady Workspaces.

**Prerequisites**

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).

**Procedure**

2. Encode content of the file to the base64 format.
3. Create a new OpenShift secret in the OpenShift project where a CodeReady Workspaces workspace will be created.
The labels of the secret that is about to be created must match the set of labels configured in `che.workspace.provision.secret.labels` property of CodeReady Workspaces. The default labels are:

- `app.kubernetes.io/part-of: che.eclipse.org`
- `app.kubernetes.io/component: workspace-secret`

### 3.8.4. The use of annotations in the process of mounting a secret into a workspace container

Kubernetes annotations and labels are tools used by libraries, tools, and other clients, to attach arbitrary non-identifying metadata to OpenShift native objects.

Labels select objects and connect them to a collection that satisfies certain conditions, where annotations are used for non-identifying information that is not used by OpenShift objects internally.

This section describes OpenShift annotation values used in the process of OpenShift secret mounting in a CodeReady Workspaces workspace.

Annotations must contain items that help identify the proper mounting configuration. These items are:

- **che.eclipse.org/target-container**: *Valid till the version 2.1* The name of the mounting container. If the name is not defined, the secret mounts into all user’s containers of the CodeReady Workspaces workspace.

- **che.eclipse.org/automount-workspace-secret**: *Introduced in the version 2.2.* The main mount selector. When set to `true`, the secret mounts into all user’s containers of the CodeReady Workspaces workspace. When set to `false`, the secret does not mount into containers by default. The value of this attribute can be overridden in devfile components, using the `automountWorkspaceSecrets` boolean property that gives more flexibility to workspace owners. This property requires an alias to be defined for the component that uses it.

- **che.eclipse.org/env-name**: The name of the environment variable that is used to mount a secret.

- **che.eclipse.org/mount-as**: This item describes if a secret will be mounted as an environmental variable or a file. Options: `env` or `file`.

- **che.eclipse.org/<mykeyName>-env-name**: `FOO_ENV`: The name of the environment variable used when data contains multiple items. `mykeyName` is used as an example.
CHAPTER 4. CUSTOMIZING DEVELOPER ENVIRONMENTS

Red Hat CodeReady Workspaces is an extensible and customizable developer-workspaces platform.

You can extend Red Hat CodeReady Workspaces in three different ways:

- **Alternative IDEs** provide specialized tools for Red Hat CodeReady Workspaces. For example, a Jupyter notebook for data analysis. Alternate IDEs can be based on Eclipse Theia or any other web IDE. The default IDE in Red Hat CodeReady Workspaces is Che-Theia.

- **Che-Theia plug-ins** add capabilities to the Che-Theia IDE. They rely on plug-in APIs that are compatible with Visual Studio Code. The plug-ins are isolated from the IDE itself. They can be packaged as files or as containers to provide their own dependencies.

- **Stacks** are pre-configured CodeReady Workspaces workspaces with a dedicated set of tools, which cover different developer personas. For example, it is possible to pre-configure a workbench for a tester with only the tools needed for their purposes.

Figure 4.1. CodeReady Workspaces extensibility

A user can extend CodeReady Workspaces by using **self-hosted** mode, which CodeReady Workspaces provides by default.

- **Section 4.1, “What is a Che-Theia plug-in”**
- **Section 4.5, “Using alternative IDEs in CodeReady Workspaces”**
- **Section 4.2, “Adding a VS Code extension to a workspace”**

4.1. WHAT IS A CHE-THEIA PLUG-IN

A Che-Theia plug-in is an extension of the development environment isolated from the IDE. Plug-ins can be packaged as files or containers to provide their own dependencies.

Extending Che-Theia using plug-ins can enable the following capabilities:

- **Language support**: Extend the supported languages by relying on the [Language Server Protocol](https://microsoft.github.io/language-server-protocol/).
- **Debuggers**: Extend debugging capabilities with the [Debug Adapter Protocol](https://github.com/microsoft/debug-adapter-protocol).
- **Development Tools**: Integrate your favorite linters, and as testing and performance tools.
- **Menus, panels, and commands**: Add your own items to the IDE components.
Themes: Build custom themes, extend the UI, or customize icon themes.

Snippets, formatters, and syntax highlighting: Enhance comfort of use with supported programming languages.

Keybindings: Add new keymaps and popular keybindings to make the environment feel natural.

4.1.1. Features and benefits of Che-Theia plug-ins

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Loading</td>
<td>Plug-ins are loaded at runtime and are already compiled. IDE is loading the plug-in code.</td>
<td>Avoid any compilation time. Avoid post-installation steps.</td>
</tr>
<tr>
<td>Secure Loading</td>
<td>Plug-ins are loaded separately from the IDE. The IDE stays always in a usable state.</td>
<td>Plug-ins do not break the whole IDE if it has bugs. Handle network issue.</td>
</tr>
<tr>
<td>Tools Dependencies</td>
<td>Dependencies for the plug-in are packaged with the plug-in in its own container.</td>
<td>No-installation for tools. Dependencies running into container.</td>
</tr>
<tr>
<td>Code Isolation</td>
<td>Guarantee that plug-ins cannot block the main functions of the IDE like opening a file or typing</td>
<td>Plug-ins are running into separate threads. Avoid dependencies mismatch.</td>
</tr>
</tbody>
</table>

4.1.2. Che-Theia plug-in concept in detail

Red Hat CodeReady Workspaces provides a default web IDE for workspaces: Che-Theia. It is based on Eclipse Theia. It is a slightly different version than the plain Eclipse Theia one because there are functionalities that have been added based on the nature of the Red Hat CodeReady Workspaces workspaces. This version of Eclipse Theia for CodeReady Workspaces is called Che-Theia.

You can extend the IDE provided with Red Hat CodeReady Workspaces by building a Che-Theia plug-in. Che-Theia plug-ins are compatible with any other Eclipse Theia-based IDE.

4.1.2.1. Client-side and server-side Che-Theia plug-ins

The Che-Theia editor plug-ins let you add languages, debuggers, and tools to your installation to support your development workflow. Plug-ins run when the editor completes loading. If a Che-Theia plug-in fails, the main Che-Theia editor continues to work.

Che-Theia plug-ins run either on the client side or on the server side. This is a scheme of the client and server-side plug-in concept:
The same Che-Theia plug-in API is exposed to plug-ins running on the client side (Web Worker) or the server side (Node.js).

4.1.2.2. Che-Theia plug-in APIs

For the purpose of providing tool isolation and easy extensibility in Red Hat CodeReady Workspaces, the Che-Theia IDE has a set of plug-in APIs. The APIs are compatible with Visual Studio Code extension APIs. Usually, Che-Theia can run VS Code extensions as its own plug-ins.

When developing a plug-in that depends on or interacts with components of CodeReady Workspaces workspaces (containers, preferences, factories), use the CodeReady Workspaces APIs embedded in Che-Theia.

4.1.2.3. Che-Theia plug-in capabilities

Che-Theia plug-ins have the following capabilities:

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>Description</th>
<th>Repository</th>
</tr>
</thead>
<tbody>
<tr>
<td>CodeReady Workspaces</td>
<td>Handles the CodeReady Workspaces commands and provides the ability to start</td>
<td>Task plug-in</td>
</tr>
<tr>
<td>Extended Tasks</td>
<td>those into a specific container of the workspace.</td>
<td></td>
</tr>
<tr>
<td>CodeReady Workspaces</td>
<td>Allows to provide terminal for any of the containers of the workspace.</td>
<td>Extended Terminal extension</td>
</tr>
<tr>
<td>Extended Terminal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CodeReady Workspaces</td>
<td>Handles the Red Hat CodeReady Workspaces Factories</td>
<td>Workspace plug-in</td>
</tr>
<tr>
<td>Factory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CodeReady Workspaces</td>
<td>Provides a container view that shows all the containers that are running</td>
<td>Containers plug-in</td>
</tr>
<tr>
<td>Container</td>
<td>in the workspace and allows to interact with them.</td>
<td></td>
</tr>
</tbody>
</table>
4.1.2.4. VS Code extensions and Eclipse Theia plug-ins

A Che–Theia plug-in can be based on a VS Code extension or an Eclipse Theia plug-in.

A Visual Studio Code extension

To repackage a VS Code extension as a Che–Theia plug-in with its own set of dependencies, package the dependencies into a container. This ensures that Red Hat CodeReady Workspaces users do not need to install the dependencies when using the extension. See Section 4.2, “Adding a VS Code extension to a workspace”.

An Eclipse Theia plug-in

You can build a Che–Theia plug-in by implementing an Eclipse Theia plug-in and packaging it to Red Hat CodeReady Workspaces.

Additional resources

- Section 4.1.5, “Embedded and remote Che–Theia plug-ins”

4.1.3. Che–Theia plug-in metadata

Che–Theia plug-in metadata is information about individual plug-ins for the plug-in registry.

The Che–Theia plug-in metadata, for each specific plug-in, is defined in a meta.yaml file.

Here is an overview of all fields that can be available in plugin meta YAML files. This document represents the Plugin meta YAML structure version 3.

The che-plugin-registry repository contains:

Table 4.1. meta.yaml

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>apiVersion</td>
<td>Version 2 and higher where version is 1 supported for backwards compatibility</td>
</tr>
<tr>
<td>category</td>
<td>Available: Category must be set to one of the followings: Editor, Debugger, Formatter, Language, Linter, Snippet, Theme, Other</td>
</tr>
<tr>
<td>description</td>
<td>Short description of plugin’s purpose</td>
</tr>
<tr>
<td>displayName</td>
<td>Name shown in user dashboard</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>deprecate</strong></td>
<td>Optional; section for deprecating plugins in favor of others</td>
</tr>
<tr>
<td></td>
<td>* autoMigrate - boolean</td>
</tr>
<tr>
<td></td>
<td>* migrateTo - new org/plugin-id/version, for example</td>
</tr>
<tr>
<td></td>
<td>redhat/vscode-apache-camel/latest</td>
</tr>
<tr>
<td><strong>firstPublicationDate</strong></td>
<td>Not required to be present in YAML, as if not</td>
</tr>
<tr>
<td></td>
<td>present, it will be generated during Plugin Registry</td>
</tr>
<tr>
<td></td>
<td>dockerimage build</td>
</tr>
<tr>
<td><strong>latestUpdateDate</strong></td>
<td>Not required to be present in YAML, as if not</td>
</tr>
<tr>
<td></td>
<td>present, it will be generated during Plugin Registry</td>
</tr>
<tr>
<td></td>
<td>dockerimage build</td>
</tr>
<tr>
<td><strong>icon</strong></td>
<td>URL of an SVG or PNG icon</td>
</tr>
<tr>
<td><strong>name</strong></td>
<td>Name (no spaces allowed), must match [-a-z0-9]</td>
</tr>
<tr>
<td><strong>publisher</strong></td>
<td>Name of the publisher, must match [-a-z0-9]</td>
</tr>
<tr>
<td><strong>repository</strong></td>
<td>URL for plugin repository, for example, GitHub</td>
</tr>
<tr>
<td><strong>title</strong></td>
<td>Plugin title (long)</td>
</tr>
<tr>
<td><strong>type</strong></td>
<td>Che Plugin, VS Code extension</td>
</tr>
<tr>
<td><strong>version</strong></td>
<td>Version information, for example: 7.5.1, [-.a-z0-9]</td>
</tr>
<tr>
<td><strong>spec</strong></td>
<td>Specifications (see below)</td>
</tr>
</tbody>
</table>

Table 4.2. spec attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>endpoints</strong></td>
<td>Optional; plugin endpoint. See Section 3.2.4.2.19, &quot;Endpoints&quot;</td>
</tr>
<tr>
<td><strong>containers</strong></td>
<td>Optional; sidecar containers for the plug-in. Che</td>
</tr>
<tr>
<td></td>
<td>Plugin and VS Code extension supports only one container</td>
</tr>
<tr>
<td><strong>initContainers</strong></td>
<td>Optional; sidecar init containers for the plug-in</td>
</tr>
<tr>
<td><strong>workspaceEnv</strong></td>
<td>Optional; environment variables for the workspace</td>
</tr>
<tr>
<td><strong>extensions</strong></td>
<td>Optional; Attribute that is required for VS Code and</td>
</tr>
<tr>
<td></td>
<td>Che-Theia plug-ins in a form list of URLs to plug-in artefacts, such as</td>
</tr>
<tr>
<td></td>
<td>.vsix or .theia files</td>
</tr>
</tbody>
</table>
### Table 4.3. `spec.containers`. Notice: `spec.initContainers` has absolutely the same container definition.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Sidecar container name</td>
</tr>
<tr>
<td>image</td>
<td>Absolute or relative container image URL</td>
</tr>
<tr>
<td>memoryLimit</td>
<td>OpenShift memory limit string, for example 512Mi</td>
</tr>
<tr>
<td>memoryRequest</td>
<td>OpenShift memory request string, for example 512Mi</td>
</tr>
<tr>
<td>cpuLimit</td>
<td>OpenShift CPU limit string, for example 2500m</td>
</tr>
<tr>
<td>cpuRequest</td>
<td>OpenShift CPU request string, for example 125m</td>
</tr>
<tr>
<td>env</td>
<td>List of environment variables to set in the sidecar</td>
</tr>
<tr>
<td>command</td>
<td>String array definition of the root process command in the container</td>
</tr>
<tr>
<td>args</td>
<td>String array arguments for the root process command in the container</td>
</tr>
<tr>
<td>volumes</td>
<td>Volumes required by the plug-in</td>
</tr>
<tr>
<td>ports</td>
<td>Ports exposed by the plug-in (on the container)</td>
</tr>
<tr>
<td>commands</td>
<td>Development commands available to the plug-in container</td>
</tr>
<tr>
<td>mountSources</td>
<td>Boolean flag to bind volume with source code /projects to the plug-in container</td>
</tr>
<tr>
<td>initContainers</td>
<td>Optional; init containers for sidecar plugin</td>
</tr>
<tr>
<td>Lifecycle</td>
<td>Container lifecycle hooks. See <code>lifecycle</code> description</td>
</tr>
</tbody>
</table>

### Table 4.4. `spec.containers.env` and `spec.initContainers.env` attributes. Notice: `workspaceEnv` has absolutely the same attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Environment variable name</td>
</tr>
<tr>
<td>value</td>
<td>Environment variable value</td>
</tr>
</tbody>
</table>

### Table 4.5. `spec.containers.volumes` and `spec.initContainers.volumes` attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mountPath</td>
<td>Path to the volume in the container</td>
</tr>
<tr>
<td>name</td>
<td>Volume name</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ephemeral</td>
<td>If true, the volume is ephemeral, otherwise the volume is persisted</td>
</tr>
</tbody>
</table>

Table 4.6. `spec.containers.ports` and `spec.initContainers.ports` attributes

<table>
<thead>
<tr>
<th>exposedPort</th>
<th>Exposed port</th>
</tr>
</thead>
</table>

Table 4.7. `spec.containers.commands` and `spec.initContainers.commands` attributes

<table>
<thead>
<tr>
<th>name</th>
<th>Command name</th>
</tr>
</thead>
<tbody>
<tr>
<td>workingDir</td>
<td>Command working directory</td>
</tr>
<tr>
<td>command</td>
<td>String array that defines the development command</td>
</tr>
</tbody>
</table>

Table 4.8. `spec.endpoints` attributes

<table>
<thead>
<tr>
<th>name</th>
<th>Name (no spaces allowed), must match [-a-z0-9]</th>
</tr>
</thead>
<tbody>
<tr>
<td>public</td>
<td><code>true</code>, <code>false</code></td>
</tr>
<tr>
<td>targetPort</td>
<td>Target port</td>
</tr>
<tr>
<td>attributes</td>
<td>Endpoint attributes</td>
</tr>
</tbody>
</table>

Table 4.9. `spec.endpoints.attributes` attributes

<table>
<thead>
<tr>
<th>protocol</th>
<th>Protocol, example: <code>ws</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td><code>ide</code>, <code>ide-dev</code></td>
</tr>
<tr>
<td>discoverable</td>
<td><code>true</code>, <code>false</code></td>
</tr>
<tr>
<td>secure</td>
<td><code>true</code>, <code>false</code>. If <code>true</code>, then the endpoint is assumed to listen solely on <code>127.0.0.1</code> and is exposed using a JWT proxy</td>
</tr>
<tr>
<td>cookiesAuthEnabled</td>
<td><code>true</code>, <code>false</code></td>
</tr>
<tr>
<td>requireSubdomain</td>
<td><code>true</code>, <code>false</code>. If <code>true</code>, the endpoint is exposed on subdomain in single-host mode.</td>
</tr>
</tbody>
</table>

Table 4.10. `spec.containers.lifecycle` and `spec.initContainers.lifecycle` attributes
**postStart**

The **postStart** event that runs immediately after a Container is started. See postStart and preStop handlers

* **exec**: Executes a specific command, resources consumed by the command are counted against the Container

* **command**: `['/bin/sh', '-c', '/bin/post-start.sh']`

**preStop**

The **preStop** event that runs before a Container is terminated. See postStart and preStop handlers

* **exec**: Executes a specific command, resources consumed by the command are counted against the Container

* **command**: `['/bin/sh', '-c', '/bin/post-start.sh']`

---

**Example meta.yaml for a Che-Theia plug-in: the CodeReady Workspaces machine-exec Service**

```yaml
apiVersion: v2
publisher: eclipse
name: che-machine-exec-plugin
version: 7.9.2

type: Che Plugin
displayName: CodeReady Workspaces machine-exec Service
title: Che machine-exec Service Plugin
description: CodeReady Workspaces Plug-in with che-machine-exec service to provide creation terminal or tasks for Eclipse CHE workspace containers.
icon: https://www.eclipse.org/che/images/logo-eclipseche.svg
repository: https://github.com/eclipse/che-machine-exec/
firstPublicationDate: "2020-03-18"
category: Other

spec:
  endpoints:
  - name: "che-machine-exec"
    public: true
    targetPort: 4444

  attributes:
    protocol: ws
    type: terminal
    discoverable: false
    secure: true
    cookiesAuthEnabled: true

  containers:
  - name: che-machine-exec
    image: "quay.io/eclipse/che-machine-exec:7.9.2"
    ports:
      - exposedPort: 4444
        command: ['/go/bin/che-machine-exec', '--static', '/cloud-shell', '--url', '127.0.0.1:4444']
```

---

CHAPTER 4. CUSTOMIZING DEVELOPER ENVIRONMENTS
Example meta.yaml for a VisualStudio Code extension: the AsciiDoc support extension

```yaml
apiVersion: v2
category: Language
description: This extension provides a live preview, syntax highlighting and snippets for the AsciiDoc format using Asciidoc flavor
displayName: AsciiDoc support
firstPublicationDate: "2019-12-02"
icon: https://www.eclipse.org/che/images/logo-eclipseche.svg
name: vscode-asciidoctor
publisher: joaompinto
repository: https://github.com/asciidoctor/asciidoctor-vscode
title: AsciiDoctor Plug-in
type: VS Code extension
version: 2.7.7
spec:
  extensions:
  - https://github.com/asciidoctor/asciidoctor-vscode/releases/download/v2.7.7/asciidoctor-vscode-2.7.7.vsix
```

4.1.4. Che-Theia plug-in lifecycle

Every time a user starts a Che workspace, a Che-Theia plug-in life cycle process starts. The steps of this process are as follows:

1. CodeReady Workspaces server checks for plug-ins to start from the workspace definition.

2. CodeReady Workspaces server retrieves plug-in metadata, recognizes each plug-in type, and stores them in memory.

3. CodeReady Workspaces server selects a broker according to the plug-in type.

4. The broker processes the installation and deployment of the plug-in. The installation process of the plug-in differs for each specific broker.

**NOTE**

Plug-ins exist in various types. A broker ensures the success of a plug-in deployment by meeting all installation requirements.

Figure 4.3. Che-Theia plug-in lifecycle

<table>
<thead>
<tr>
<th>User</th>
<th>Server</th>
<th>Plug-in lifecycle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create plug-in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Publish plug-in metadata</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Before a CodeReady Workspaces workspace is launched, CodeReady Workspaces server starts the workspace containers:

1. The Che-Theia plug-in broker extracts the information about sidecar containers that a particular plug-in needs from the `.theia` file.
2. The broker sends the appropriate container information to CodeReady Workspaces server.
3. The broker copies the Che-Theia plug-in to a volume to have it available for the Che-Theia editor container.
4. CodeReady Workspaces server then starts all the containers of the workspace.
5. Che-Theia starts in its container and checks the correct folder to load the plug-ins.

**A user experience with Che-Theia plug-in lifecycle**

1. When a user opens a browser tab with Che-Theia, Che-Theia starts a new plug-in session with:
   
   - Web Worker for frontend
   - Node.js for backend

2. Che-Theia notifies all Che-Theia plug-ins with the start of the new session by calling the `start()` function for each triggered plug-in.

3. A Che-Theia plug-in session runs and interacts with the Che-Theia backend and frontend.

4. When the user closes the Che-Theia browser tab, or the session ended on a timeout limit, Che-Theia notifies all plug-ins with the `stop()` function for each triggered plug-in.

### 4.1.5. Embedded and remote Che-Theia plug-ins

Developer workspaces in Red Hat CodeReady Workspaces provide all dependencies needed to work on a project. The application includes the dependencies needed by all the tools and plug-ins used.

Based on the required dependencies, Che-Theia plug-in can run as:

- Embedded, also know as local
- Remote

#### 4.1.5.1. Embedded (local) plug-ins

The Embedded plug-ins are plug-ins without specific dependencies that are injected into the Che-Theia IDE. These plug-ins use the Node.js runtime, which runs in the IDE container.

Examples:

- Code linting
- New set of commands
- New UI components

To include a Che-Theia plug-in or VS Code extension, define a URL to the plug-in `.theia` archive binary in the `meta.yaml` file. See Section 4.2, “Adding a VS Code extension to a workspace”
When starting a workspace, CodeReady Workspaces downloads and unpacks the plug-in binaries and includes them in the Che-Theia editor container. The Che-Theia editor initializes the plug-ins when it starts.

### 4.1.5.2. Remote plug-ins

The plug-in relies on dependencies or it has a back end. It runs in its own sidecar container, and all dependencies are packaged in the container.

A remote Che-Theia plug-in consist of two parts:

- Che-Theia plug-in or VS Code extension binaries. The definition in the `meta.yaml` file is the same as for embedded plug-ins.

- Container image definition, for example, `eclipse/che-theia-dev:nightly`. From this image, CodeReady Workspaces creates a separate container inside a workspace.

Examples:

- Java Language Server

- Python Language Server

When starting a workspace, CodeReady Workspaces creates a container from the plug-in image, downloads and unpacks the plug-in binaries, and includes them in the created container. The Che-Theia editor connects to the remote plug-ins when it starts.

### 4.1.5.3. Comparison matrix

- Embedded plug-ins are those Che-Theia plug-ins or VS Code extensions that do not require extra dependencies inside its container.

- Remote plug-ins are containers that contain a plug-in with all required dependencies.

<table>
<thead>
<tr>
<th></th>
<th>Configure RAM per plug-in</th>
<th>Environment dependencies</th>
<th>Create separated container</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote</strong></td>
<td>TRUE</td>
<td>Plug-in uses dependencies defined in the remote container.</td>
<td>TRUE</td>
</tr>
<tr>
<td><strong>Embedded</strong></td>
<td>FALSE (users can configure RAM for the whole editor container, but not per plug-in)</td>
<td>Plug-in uses dependencies from the editor container; if container does not include these dependencies, the plug-in fails or does not function as expected.</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

Depending on your use case and the capabilities provided by your plug-in, select one of the described running modes.
4.1.6. Remote plug-in endpoint

Red Hat CodeReady Workspaces has a remote plug-in endpoint service to start VS Code Extensions and Che-Theia plug-ins in separate containers. Red Hat CodeReady Workspaces injects the remote plug-in endpoint binaries into each remote plug-in container. This service starts remote extensions and plug-ins defined in the plug-in `meta.yaml` file and connects them to the Che-Theia editor container.

The remote plug-in endpoint creates a plug-in API proxy between the remote plug-in container and the Che-Theia editor container. The remote plug-in endpoint is also an interceptor for some plug-in API parts, which it launches inside a remote sidecar container rather than an editor container. Examples: terminal API, debug API.

The remote plug-in endpoint executable command is stored in the environment variable of the remote plug-in container: `PLUGIN_REMOTE_ENDPOINT_EXECUTABLE`.

Red Hat CodeReady Workspaces provides two ways to start the remote plug-in endpoint with a sidecar image:

- Defining a launch remote plug-in endpoint using a Dockerfile. To use this method, patch an original image and rebuild it.
- Defining a launch remote plug-in endpoint in the plug-in `meta.yaml` file. Use this method to avoid patching an original image.

4.1.6.1. Defining a launch remote plug-in endpoint using Dockerfile

To start a remote plug-in endpoint, set the `PLUGIN_REMOTE_ENDPOINT_EXECUTABLE` environment variable in the Dockerfile.

**Procedure**

- Start a remote plug-in endpoint using the `CMD` command in the Dockerfile:

  **Dockerfile example**

  ```
  FROM fedora:30
  RUN dnf update -y && dnf install -y nodejs htop && node -v
  RUN mkdir /home/jboss
  ENV HOME=/home/jboss
  RUN mkdir /projects 
    && chmod -R g+rwX /projects 
    && chmod -R g+rwX "${HOME}"
  CMD ${PLUGIN_REMOTE_ENDPOINT_EXECUTABLE}
  ```

- Start a remote plug-in endpoint using the `ENTRYPOINT` command in the Dockerfile:

  **Dockerfile example**

  ```
  FROM fedora:30
  ```
RUN dnf update -y && dnf install -y nodejs htop && node -v

RUN mkdir /home/jboss

ENV HOME=/home/jboss

RUN mkdir /projects 
    && chmod -R g+rwX /projects 
    && chmod -R g+rwX "${HOME}"

ENTRYPOINT ${PLUGIN_REMOTE_ENDPOINT_EXECUTABLE}

4.1.6.1.1. Using a wrapper script

Some images use a wrapper script to configure permissions inside the container. The Dockertfile ENTRYPOINT command defines this script, which executes the main process defined in the CMD command of the Dockerfile.

CodeReady Workspaces uses images with a wrapper script to provide permission configurations to different infrastructures protected by advanced security. OpenShift Container Platform is an example of such an infrastructure.

- Example of a wrapper script:

```bash
#!/bin/sh

set -e

export USER_ID=$(id -u)
export GROUP_ID=$(id -g)

if ! whoami >/dev/null 2>&1; then
    echo "${USER_NAME:-user}:x:${USER_ID}:0:${USER_NAME:-user}
    user:${HOME}/bin/sh" >> /etc/passwd
fi

# Grant access to projects volume in case of non root user with sudo rights
if [ "${USER_ID}" -ne 0 ] && command -v sudo >/dev/null 2>&1 && sudo -n true > /dev/null 2>&1; then
    sudo chown "${USER_ID}:${GROUP_ID}" /projects
fi

exec "$@
```

- Example of a Dockerfile with a wrapper script:

**Dockerfile example**

```bash
FROM alpine:3.10.2

ENV HOME=/home/theia

RUN mkdir /projects ${HOME} 
    && chmod -R g+rwX /projects 
    && chmod -R g+rwX "${HOME}"

ENTRYPOINT ${PLUGIN_REMOTE_ENDPOINT_EXECUTABLE}
```
```
echo "Changing permissions on ${f}" && chgrp -R 0 ${f} && 
chmod -R g+rwX ${f}; 
done
ADD entripoint.sh /entrypoint.sh
ENTRYPOINT [ "/entrypoint.sh" ]
CMD $(PLUGIN_REMOTE_ENDPOINT_EXECUTABLE)
```

**Explanation:**

- The container launches the `/entrypoint.sh` script defined in the `ENTRYPOINT` command of the Dockerfile.
- The script configures the permissions and executes the command using `exec $@`.
- `CMD` is the argument for `ENTRYPOINT`, and the `exec $@` command calls `$(PLUGIN_REMOTE_ENDPOINT_EXECUTABLE)`.
- The remote plug-in endpoint then starts in the container after permission configuration.

### 4.1.6.2. Defining a launch remote plug-in endpoint in a `meta.yaml` file

Use this method to re-use images for starting a remote plug-in endpoint without any modifications.

**Procedure**

Modify the plug-in `meta.yaml` file properties `command` and `args`:

- **command** - CodeReady Workspaces uses the `command` properties to override the Dockerfile#ENTRYPOINT value.
- **args** - CodeReady Workspaces uses the `args` properties to override the Dockerfile#CMD value.
- **Example of a YAML file with the `command` and `args` properties modified:**

```yaml
apiVersion: v2
category: Language
description: "Typescript language features"
displayName: Typescript
firstPublicationDate: "2019-10-28"
icon: "https://www.eclipse.org/che/images/logo-eclipseche.svg"
name: typescript
publisher: che-incubator
repository: "https://github.com/Microsoft/vscode"
title: "Typescript language features"
type: "VS Code extension"
version: remote-bin-with-override-entrypoint
spec:
  containers:
  - image: "example/fedora-for-ts-remote-plugin-without-endpoint:latest"
    memoryLimit: 512Mi
    name: vscode-typescript
    command:
      - sh
```
Modify `args` instead of `command` to use an image with a wrapper script pattern and to keep a call of the `entrypoint.sh` script:

```yaml
apiVersion: v2
category: Language
description: "Typescript language features"
displayName: Typescript
firstPublicationDate: "2019-10-28"
icon: "https://www.eclipse.org/che/images/logo-eclipseche.svg"
name: typescript
publisher: che-incubator
repository: "https://github.com/che-incubator/ms-code.typescript"
title: "Typescript language features"
type: "VS Code extension"
version: remote-bin-with-override-entrypoint
spec:
containers:
  - image: "example/fedora-for-ts-remote-plugin-without-endpoint:latest"
    memoryLimit: 512Mi
    name: vscode-typescript
    args:
      - sh
      - -c
      - ${PLUGIN_REMOTE_ENDPOINT_EXECUTABLE}
    extensions:
      - "https://github.com/che-incubator/ms-code.typescript/releases/download/v1.35.1/che-typescript-language-1.35.1.vsix"
```

Red Hat CodeReady Workspaces calls the `entrypoint.sh` wrapper script defined in the `ENTRYPOINT` command of the Dockerfile. The script executes `[ 'sh', '-c', '${PLUGIN_REMOTE_ENDPOINT_EXECUTABLE}' ]` using the `exec "$@"` command.

**NOTE**

By modifying the `command` and `args` properties of the `meta.yaml` file, a user can:

- Execute a service at a container start
- Start a remote plug-in endpoint

To make these actions run at the same time:

1. Start the service.
2. Detach the process.
3. Start the remote plug-in endpoint.
4.2. ADDING A VS CODE EXTENSION TO A WORKSPACE

This section describes how to add a VS Code extension to a workspace using the CodeReady Workspaces Plugins panel or the workspace configuration.

Prerequisites

- The VS Code extension is available in the CodeReady Workspaces plug-in registry, or metadata for the VS Code extension are available. See Section 4.3, “Publishing metadata for a VS Code extension”.

4.2.1. Adding a VS Code extension using the CodeReady Workspaces Plugins panel

Prerequisites


Procedure

To add a VS Code extension using the CodeReady Workspaces Plugins panel:

1. Open the CodeReady Workspaces Plugins panel by pressing CTRL+SHIFT+J or navigate to View/Plugins.

2. Change the current registry to the registry in which the VS Code extension was added.

3. In the search bar, click the Menu button and then click Change Registry to choose the registry from the list. If the required registry is not in the list, add it using the Add Registry menu option. The registry link points to the plugins segment of the registry, for example: https://my-registry.com/v3/plugins/index.json.

4. To update the list of plug-ins after adding a new registry link, use Refresh command from the search bar menu.

5. Search for the required plug-in using the filter, and then click the Install button.

6. Restart the workspace for the changes to take effect.

4.2.2. Adding a VS Code extension using the workspace configuration

Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”.

The VS Code extension is available in the CodeReady Workspaces plug-in registry, or metadata for the VS Code extension are available. See Section 4.3, “Publishing metadata for a VS Code extension”.

Procedure

To add a VS Code extension using the workspace configuration:

1. Click the Workspaces tab on the Dashboard and select the workspace in which you want to add the plug-in. The Workspace <workspace-name> window is opened showing the details of the workspace.

2. Click the devfile tab.

3. Locate the components section, and add a new entry with the following structure:

   - type: chePlugin
     id: 1

   ID format: <publisher>/<plug-inName>/<plug-inVersion>

   CodeReady Workspaces automatically adds the other fields to the new component.

   Alternatively, you can link to a meta.yaml file hosted on GitHub, using the dedicated reference field.


4. Restart the workspace for the changes to take effect.

### 4.3. PUBLISHING METADATA FOR A VS CODE EXTENSION

To use a VS Code extension in a CodeReady Workspaces workspace, CodeReady Workspaces need to consume metadata describing the extension. The CodeReady Workspaces plugin registry is a static website publishing metadata for common VS Code extensions.

How to publish metadata for an additional extension, not available in the CodeReady Workspaces plugin registry using the extension configuration. meta.yaml file.

Prerequisite

- If the VS Code extension requires it, the required associated container image is available.

Procedure

1. Create a meta.yaml file.

2. Edit the meta.yaml file and provide the necessary information. The file must have the following structure:
Version of the file structure.

1. Name of the plug-in publisher. Must be the same as the publisher in the path.
2. Name of the plug-in. Must be the same as in path.
3. Version of the plug-in. Must be the same as in path.
4. Type of the plug-in. Possible values: Che Plugin, Che Editor, Theia plugin, VS Code extension.
5. A short name of the plug-in.
6. Title of the plug-in.
7. A brief explanation of the plug-in and what it does.
8. The link to the plug-in logo.
9. Optional. The link to the source-code repository of the plug-in.
10. Defines the category that this plug-in belongs to. Should be one of the following: Editor, Debugger, Formatter, Language, Linter, Snippet, Theme, or Other.
11. If this section is omitted, the VS Code extension is added into the Che-Theia IDE container.
12. The Docker image from which the sidecar container will be started. Example: theia-endpoint-image.
The maximum RAM which is available for the sidecar container. Example: "512Mi". This value might be overridden by the user in the component configuration.

The RAM which is given for the sidecar container by default. Example: "256Mi". This value might be overridden by the user in the component configuration.

The maximum CPU amount in cores or millicores (suffixed with "m") which is available for the sidecar container. Examples: "500m", "2". This value might be overridden by the user in the component configuration.

The CPU amount in cores or millicores (suffixed with "m") which is given for the sidecar container by default. Example: "125m". This value might be overridden by the user in the component configuration.

A list of VS Code extensions run in this sidecar container.

3. Publish the meta.yaml file as an HTTP resource by creating a gist on GitHub or GitLab with a file content published there.

4.4. TESTING A VISUAL STUDIO CODE EXTENSION IN CODEREADY WORKSPACES

Visual Studio Code (VS Code) extensions work in a workspace. VS Code extensions can run in the Che-Theia editor container, or in their own isolated and preconfigured containers with their prerequisites.

This section describes how to test a VS Code extension in CodeReady Workspaces with workspaces and how to review the compatibility of VS Code extensions to check whether a specific API is available.

NOTE

The extension-hosting sidecar container and the use of the extension in a devfile are optional.

4.4.1. Testing a VS Code extension using GitHub gist

Each workspace can have its own set of plug-ins. The list of plug-ins and the list of projects to clone are defined in the devfile.yaml file.

For example, to enable an AsciiDoc plug-in from the Red Hat CodeReady Workspaces dashboard, add the following snippet to the devfile:

```
components:
  - id: joaopinto/vscode-asciidoctor/latest
    type: chePlugin
```

To add a plug-in that is not in the default plug-in registry, build a custom plug-in registry. See https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/administration_guide/index#customizing-the-registries_crw, or, alternatively, use GitHub and the gist service.

Prerequisites

A GitHub account.

Procedure

1. Go to the gist webpage and create a README.md file with the following description: Try Bracket Pair Colorizer extension in Red Hat CodeReady Workspaces and content: Example VS Code extension. (Bracket Pair Colorizer is a popular VS Code extension.)

2. Click the Create secret gist button.

3. Clone the gist repository by using the URL from the navigation bar of the browser:

   ```shell
   $ git clone https://gist.github.com/<your-github-username>/<gist-id>
   ```

   **Example of the output of the git clone command**

   ```shell
   git clone https://gist.github.com/85c60c8c439177ac50141d527729b9d9
   Cloning into '85c60c8c439177ac50141d527729b9d9'...
   remote: Enumerating objects: 3, done.
   remote: Counting objects: 100% (3/3), done.
   remote: Total 3 (delta 0), reused 0 (delta 0), pack-reused 0
   Unpacking objects: 100% (3/3), done.
   ```

   Each gist has a unique ID.

4. Change the directory:

   ```shell
   $ cd <gist-directory-name>
   ```

   **Directory name matching the gist ID.**

5. Download the plug-in from the VS Code marketplace or from its GitHub page, and store the plug-in file in the cloned directory.

6. Create a plugin.yaml file in the cloned directory to add the definition of this plug-in.

   **Example of the plugin.yaml file referencing the .vsix binary file extension**

   ```yaml
   apiVersion: v2
   publisher: CoenraadS
   name: bracket-pair-colorizer
   version: 1.0.61
   type: VS Code extension
   displayName: Bracket Pair Colorizer
   title: Bracket Pair Colorizer
description: Bracket Pair Colorizer
sanitize=true
repository: https://github.com/CoenraadS/BracketPair
   ```
This extension requires a basic Node.js runtime, so it is not necessary to add a custom runtime image in `plugin.yaml`.

`{{REPOSITORY}}` is a macro for a pre-commit hook.

7. Define a memory limit and volumes:

```
spec:
  containers:
  - image: "quay.io/eclipse/che-sidecar-java:8-0cfbacb"
    name: vscode-java
    memoryLimit: "1500Mi"
    volumes:
    - mountPath: "/home/theia/.m2"
      name: m2
```

8. Create a `devfile.yaml` that references the `plugin.yaml` file:

```
apiVersion: 1.0.0
metadata:
  generateName: java-maven-
  projects:
  -
    name: console-java-simple
    source:
      type: git
      location: "https://github.com/che-samples/console-java-simple.git"
      branch: java1.11
    components:
      -
        type: chePlugin
        id: redhat/java11/latest
        -
          type: chePlugin
          reference: "{{REPOSITORY}}/plugin.yaml"
    -
      type: dockerimage
      alias: maven
      image: quay.io/eclipse/che-java11-maven:nightly
      memoryLimit: 512Mi
      mountSources: true
      volumes:
      - name: m2
        containerPath: /home/user/.m2
      commands:
      -
        name: maven build
```
actions:
  -
    type: exec
    component: maven
    command: "mvn clean install"
    workdir: $(CHE_PROJECTS_ROOT)/console-java-simple
  -
    name: maven build and run
    actions:
      -
        type: exec
        component: maven
        command: "mvn clean install && java -jar ./target/*.jar"
        workdir: $(CHE_PROJECTS_ROOT)/console-java-simple

Any other devfile definition is also accepted. The important information in this devfile are the lines defining this external component. It means that an external reference defines the plug-in (instead of an ID pointing to a definition in the default plug-in registry).

9. Verify there are 4 files in the current Git directory:

   $ ls -la
   .git
   CoenraadS.bracket-pair-colorizer-1.0.61.vsix
   README.md
   devfile.yaml
   plugin.yaml

10. Before committing the files, add a pre-commit hook to update the {{REPOSITORY}} variable to the public external raw gist link:

   a. Create a .git/hooks/pre-commit file with this content:

   ```bash
   #!/bin/sh

   # get modified files
   FILES=$(git diff --cached --name-only --diff-filter=ACMR "*.yaml" | sed 's| |\ |g')

   # exit fast if no files found
   [ -z "$FILES" ] && exit 0

   # grab remote origin
   origin=$(git config --get remote.origin.url)
   url="${origin}/raw"

   # iterate on files and add the good prefix pattern
   for FILE in "$FILES"; do
     sed -e "s#{{REPOSITORY}}#${url}#g" "$FILE" > "${FILE}.back"
     mv "$FILE.back" "$FILE"
   done

   # Add back to staging
   echo "$FILES" | xargs git add

   exit 0
   ```
The hook replaces the \{{REPOSITORY}} macro and adds the external raw link to the gist.

b. Make the script executable:

```bash
$ chmod u+x .git/hooks/pre-commit
```

11. Commit and push the files:

```bash
# Add files
$ git add *

# Commit
$ git commit -m "Initial Commit for the test of our extension"
[master 98dd370] Initial Commit for the test of our extension
3 files changed, 61 insertions(+)
create mode 100644 CoenraadS.bracket-pair-colorizer-1.0.61.vsix
create mode 100644 devfile.yaml
create mode 100644 plugin.yaml

# and push the files to the main branch
$ git push origin
```

12. Visit the gist website and verify that all links have the correct public URL and do not contain any \{{REPOSITORY}} variables. To reach the devfile:

```bash
$ echo "$(git config --get remote.origin.url)/raw/devfile.yaml"
```

or:

```bash
$ echo "https://<che-server>/f?url=$(git config --get remote.origin.url)/raw/devfile.yaml"
```

### 4.4.2. Verifying the VS Code extension API compatibility level

Che-Theia does not fully support the VS Code extensions API. The vscode-theia-comparator is used to analyze the compatibility between the Che-Theia plug-in API and the VS Code extension API. This tool runs nightly, and the results are published on the vscode-theia-comparator GitHub page.

**Prerequisites**

- Personal GitHub access token. See Creating a personal access token for the command line. A GitHub access token is required to increase the GitHub download limit for your IP address.

**Procedure**

To run the vscode-theia comparator manually:

1. Clone the vscode-theia-comparator repository, and build it using the yarn command.

2. Set the GITHUB_TOKEN environment variable to your token.

3. Execute the yarn run generate command to generate a report.

4. Open the out/status.html file to view the report.
4.5. USING ALTERNATIVE IDES IN CODEREADY WORKSPACES

Extending Red Hat CodeReady Workspaces developer workspaces using different IDEs (integrated development environments) enables:

- Re-purposing the environment for different use cases.
- Providing a dedicated custom IDE for specific tools.
- Providing different perspectives for individual users or groups of users.

Red Hat CodeReady Workspaces provides a default web IDE to be used with the developer workspaces. This IDE is completely decoupled. You can bring your own custom IDE for Red Hat CodeReady Workspaces:

- **Built from Eclipse Theia**, which is a framework to build web IDEs. Example: [Sirius on the web](#).
- **Completely different web IDEs** such as Jupyter, Eclipse Dirigible, or others. Example: [Jupyter in Red Hat CodeReady Workspaces workspaces](#).

**Bringing custom IDE built from Eclipse Theia**

- Creating your own custom IDE based on Eclipse Theia.
- Adding CodeReady Workspaces-specific tools to your custom IDE.
- Packaging your custom IDE into the available editors for CodeReady Workspaces.

**Bringing your completely different web IDE into CodeReady Workspaces**

- Packaging your custom IDE into the available editors for CodeReady Workspaces.

4.6. ADDING TOOLS TO CODEREADY WORKSPACES AFTER CREATING A WORKSPACE

When installed in a workspace, CodeReady Workspaces plug-ins bring new capabilities to CodeReady Workspaces. Plug-ins consist of a Che-Theia plug-in, metadata, and a hosting container. These plug-ins may provide the following capabilities:

- Integrating with other systems, including OpenShift.
- Automating some developer tasks, such as formatting, refactoring, and running automated tests.
- Communicating with multiple databases directly from the IDE.
- Enhanced code navigation, auto-completion and error highlighting.

This chapter provides basic information about installing, enabling, and using CodeReady Workspaces plug-ins in workspaces.

- **Section 4.6.1, "Additional tools in the CodeReady Workspaces workspace”**
- **Section 4.6.2, "Adding a language support plug-in to a CodeReady Workspaces workspace”**
4.6.1. Additional tools in the CodeReady Workspaces workspace

CodeReady Workspaces plug-ins are extensions to the Che-Theia IDE that come bundled with container images. These images contain the native prerequisites of their respective extensions. For example, the oc command-line tool is bundled with a command to install it, which ensures the proper functionality of the OpenShift Connector plug-in, all available in the dedicated image.

Plug-ins can also include metadata to define a description, categorization tags, and an icon. CodeReady Workspaces provides a registry of plug-ins available for installation into the user's workspace.

The Che-Theia IDE is generally compatible with the VS Code extensions API and VS Code extensions are automatically compatible with Che-Theia. These extensions are possible to package as CodeReady Workspaces plug-ins by combining them with their dependencies. By default, CodeReady Workspaces includes a plug-in registry containing common plug-ins.

Adding a plug-in

- Using the Dashboard:
  - Add a plug-in from the plug-in registry using the **Plugins** tab in the **Workspace details** page.
  - Add a plug-in directly into a devfile using the **Devfile** tab. The devfile can also further the plug-in configuration, such as defining memory or CPU usage.

- Using the Che-Theia IDE:
  - By pressing **Ctrl-Shift-J** or by navigating to **View → Plugins**.

Additional resources

- Section 3.2.4.2, “Adding components to a devfile”

4.6.2. Adding a language support plug-in to a CodeReady Workspaces workspace

This procedure describes adding a tool to an existing workspace by enabling a dedicated plug-in from the Dashboard.

To add tools that are available as plug-ins into a CodeReady Workspaces workspace, use one of the following methods:

- **Enable the plug-in from the Dashboard**  **Plugins** tab.
- **Edit the workspace devfile from the Dashboard**  **Devfile** tab.

This procedure uses the Language Support for Java plug-in as an example.

Prerequisites

- A running instance of Red Hat CodeReady Workspaces. To install an instance of Red Hat CodeReady Workspaces, see [Installing CodeReady Workspaces](#).
- An existing workspace defined in this instance of Red Hat CodeReady Workspaces; see:
  - Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace”
• Section 3.6.2, “Creating a workspace from Custom Workspace view of User Dashboard”

- The workspace must be in a **stopped** state. To stop a workspace,
  b. In the **Dashboard**, click the **Workspaces** menu to open the workspaces list and locate the workspace.
  c. On the same row with the displayed workspace, on the right side of the screen, click the **square Stop** button to stop the workspace.
  d. Wait a few seconds for the workspace to stop (the workspace’s icon on the list will turn grey), then configure the workspace by clicking on it.

**Procedure**

To add the plug-in from the Plugin registry to an existing CodeReady Workspaces workspace, use one of the following methods:

- Installing the plug-in from the **Plugins** tab.
  1. Navigate to the **Plugins** tab. The list of available plug-ins is displayed.
  2. Enable the desired plug-in, for example, the Language Support for Java 11, by using the **Enable** slide-toggle. This will add the plug-in’s ID to the workspace’s devfile, enabling the plug-in.
  3. On the bottom right side of the screen, save the changes by clicking the **Save** button. After changes are saved, the workspace can be restarted and will include the new plug-in.

- Installing the plug-in by adding content to the devfile.
  1. Navigate to the **Devfile** tab. The devfile YAML is displayed.
  2. Locate the **components** section of the devfile and add the following lines to add the Java language plugin with Java 8 to the workspace:

```yaml
- id: redhat/java8/latest
  type: chePlugin
```

An example of the final result:

```yaml
components:
- id: redhat/php/latest
  memoryLimit: 1Gi
  type: chePlugin
- id: redhat/php-debugger/latest
  memoryLimit: 256Mi
  type: chePlugin
- mountSources: true
- endpoints:
  - name: 8080/tcp
    port: 8080
    memoryLimit: 512Mi
    type: dockerimage
```
4.7. EDITING A DEVFILE AND PLUG-IN AT RUNTIME

An alternative to building a custom registry image is to:

1. Start a registry
2. Modify its content at runtime

This approach is simpler and faster. But the modifications are lost as soon as the container is deleted.

4.7.1. Adding a plug-in at runtime

Procedure

To add a plug-in:

1. Check out the plugin registry sources.

$$
git clone https://github.com/redhat-developer/codeready-workspaces; \ cd codeready-workspaces/dependencies/che-plugin-registry$$

2. Create a `meta.yaml` in some local folder. This can be done from scratch or by copying from an existing plug-in’s `meta.yaml` file.

$$
PLUGIN="v3/plugins/new-org/new-plugin/0.0.1"; \ mkdir -p ${PLUGIN}; cp v3/plugins/che-incubator/cpptools/0.1/* ${PLUGIN}/; \ echo "${PLUGIN##*/}" > ${PLUGIN}/../latest.txt
$$

3. If copying from an existing plug-in, make changes to the `meta.yaml` file to suit your needs. Make sure the new plug-in has a unique `title`, `displayName` and `description`. Update the `firstPublicationDate` to today’s date.

4. These fields in `meta.yaml` must match the path defined in `PLUGIN` above.

<table>
<thead>
<tr>
<th>volumes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- name: composer</td>
</tr>
<tr>
<td>containerPath: (prod-home)/.composer</td>
</tr>
<tr>
<td>- name: symfony</td>
</tr>
<tr>
<td>containerPath: (prod-home)/.symfony</td>
</tr>
<tr>
<td>alias: php</td>
</tr>
<tr>
<td>image: ‘quay.io/eclipse/che-php-7.nightly’</td>
</tr>
<tr>
<td>- id: redhat/java8/latest</td>
</tr>
<tr>
<td>type: chePlugin</td>
</tr>
</tbody>
</table>

3. On the bottom right side of the screen, save the changes by clicking the **Save** button. After changes are saved, the workspace can be restarted and will include the new plug-in.
5. Get the name of the Pod that hosts the plug-in registry container. To do this, filter the `component=plugin-registry` label:

```bash
$ PLUGIN_REG_POD=$(oc get -o custom-columns=NAME:.metadata.name --no-headers pod -l component=plugin-registry)
```

6. Regenerate the registry’s `index.json` file to include the new plug-in.

```bash
$ cd codeready-workspaces/dependencies/che-plugin-registry; \
   "$PWD/build/scripts/generate_latest_metas.sh" v3 && \
   "$PWD/build/scripts/check_plugins_location.sh" v3 && \
   "$PWD/build/scripts/set_plugin_dates.sh" v3 && \
   "$PWD/build/scripts/check_plugins_viewer_mandatory_fields.sh" v3 && \
   "$PWD/build/scripts/index.sh" v3 > v3/plugins/index.json
```

7. Copy the new `index.json` and `meta.yaml` files from the new local plug-in folder to the container.

```bash
$ cd codeready-workspaces/dependencies/che-plugin-registry; \
   LOCAL_FILES=":$PWD/$PLUGIN/meta.yaml $(pwd)/v3/plugins/index.json"; \
   oc exec $PLUGIN_REG_POD -i -t -- mkdir -p /var/www/html/$PLUGIN; \
   for f in $LOCAL_FILES; do e=${f/$(pwd)//}; echo "Upload $f -> /var/www/html/$e"; \
   oc cp "$f" $PLUGIN_REG_POD:/var/www/html/$e; done
```

8. The new plug-in can now be used from the existing CodeReady Workspaces instance of the plug-in registry. To discover it, go to the CodeReady Workspaces dashboard, then click the `Workspaces` link. From there, click the gear icon to configure one of your workspaces. Select the `Plugins` tab to see the updated list of available plug-ins.

### 4.7.2. Adding a devfile at runtime

**Procedure**

To add a devfile:

1. Check out the devfile registry sources.

```bash
$ git clone https://github.com/redhat-developer/codeready-workspaces; \
   cd codeready-workspaces/dependencies/che-devfile-registry
```

2. Create a `devfile.yaml` and `meta.yaml` in some local folder. This can be done from scratch or by copying from an existing devfile.

```bash
$ STACK="new-stack"; \
   mkdir -p devfiles/$STACK; cp devfiles/03_web-nodejs-simple/* devfiles/$STACK/
```

3. If copying from an existing devfile, make changes to the devfile to suit your needs. Make sure the new devfile has a unique `displayName` and `description`.

4. Get the name of the Pod that hosts the devfile registry container. To do this, filter the `component=devfile-registry` label:

```bash
$ DEVFILE_REG_POD=$(oc get -o custom-columns=NAME:.metadata.name --no-headers pod -l component=devfile-registry)
```
5. Regenerate the registry’s `index.json` file to include the new devfile.

```
$ cd codeready-workspaces/dependencies/che-devfile-registry; \n  "$(pwd)/build/scripts/check_mandatory_fields.sh" devfiles; \n  "$(pwd)/build/scripts/index.sh" > index.json
```

6. Copy the new `index.json`, `devfile.yaml` and `meta.yaml` files from the new local devfile folder to the container.

```
$ cd che-devfile-registry; \n  oc exec ${DEVFILE_REG_POD} -i -t -- mkdir -p /var/www/html/devfiles/${STACK}; \n  oc cp $(pwd)/devfiles/${STACK}/meta.yaml ${DEVFILE_REG_POD}:/var/www/html/devfiles/${STACK}/meta.yaml; \n  oc cp $(pwd)/devfiles/${STACK}/devfile.yaml ${DEVFILE_REG_POD}:/var/www/html/devfiles/${STACK}/devfile.yaml; \n  oc cp $(pwd)/index.json ${DEVFILE_REG_POD}:/var/www/html/devfiles/index.json
```

7. The new devfile can now be used from the existing CodeReady Workspaces instance of the devfile registry. To discover it, go to the CodeReady Workspaces dashboard, then click the `Workspaces` link. From there, click `Add Workspace` to see the updated list of available devfiles.
CHAPTER 5. CONFIGURING OAUTH AUTHORIZATION

This section describes how to connect Red Hat CodeReady Workspaces as an OAuth application to supported OAuth providers.

- Section 5.1, “Configuring GitHub OAuth”
- Section 5.2, “Configuring OpenShift OAuth”

5.1. CONFIGURIGN GITHUB OAUTH

OAuth for GitHub allows for automatic SSH key upload to GitHub.

Procedure

- Set up the GitHub OAuth client. The Authorization callback URL is filled in the next steps.
  1. Go to the RH-SSO administration console and select the Identity Providers tab.
  2. Select the GitHub identity provider in the drop-down list.
  3. Paste the Redirect URL to the Authorization callback URL of the GitHub OAuth application.
  4. Fill the Client ID and Client Secret from the GitHub oauth app.
  6. Enable Store Tokens.
  7. Save the changes of the Github Identity provider and click Register application in the GitHub oauth app page.

5.2. CONFIGURING OPENSHIFT OAUTH

For users to interact with OpenShift, they must first authenticate to the OpenShift cluster. OpenShift OAuth is a process in which users prove themselves to a cluster through an API with obtained OAuth access tokens.

Authentication with the Chapter 8, OpenShift Connector overview is a possible way for CodeReady Workspaces users to authenticate with an OpenShift cluster.

The following section describes the OpenShift OAuth configuration options and its use with a CodeReady Workspaces.

Prerequisites

- The oc tool is available.
- Openshift identity providers are configured on the cluster. See the Understanding identity provider configuration.
Procedure

- OpenShift OAuth will be enabled by default, deploy CodeReady Workspaces using OperatorHub or the crwctl, see the crwctl server:deploy specification chapter.
CHAPTER 6. USING ARTIFACT REPOSITORIES IN A RESTRICTED ENVIRONMENT

This section describes how to manually configure various technology stacks to work with artifacts from in-house repositories using self-signed certificates.

- Section 6.1, "Using Maven artifact repositories"
- Section 6.2, "Using Gradle artifact repositories"
- Section 6.3, "Using Python artifact repositories"
- Section 6.4, "Using Go artifact repositories"
- Section 6.5, "Using NuGet artifact repositories"
- Section 6.6, "Using npm artifact repositories"

6.1. USING MAVEN ARTIFACT REPOSITORIES

Maven downloads artifacts that are defined in two locations:

- Artifact repositories defined in a pom.xml file of the project. Configuring repositories in pom.xml is not specific to Red Hat CodeReady Workspaces. For more information, see the Maven documentation about the POM.

- Artifact repositories defined in a settings.xml file. By default, settings.xml is located at `~/.m2/settings.xml`.

6.1.1. Defining repositories in settings.xml

To specify your own artifact repositories at example.server.org, use the settings.xml file. To do that, ensure, that settings.xml is present in all the containers that use Maven tools, in particular the Maven container and the Java plug-in container.

By default, settings.xml is located at the `<home dir>/.m2` directory which is already on persistent volume in Maven and Java plug-in containers and you don’t need to re-create the file each time you restart the workspace if it isn’t in ephemeral mode.

In case you have another container that uses Maven tools and you want to share `<home dir>/.m2` folder with this container, you have to specify the custom volume for this specific component in the devfile:

```yaml
apiVersion: 1.0.0
metadata:
  name: MyDevfile
components:
  - type: chePlugin
    alias: maven-tool
    id: plugin/id
    volumes:
      - name: m2
        containerPath: <home dir>/m2
```

Procedure
1. Configure your **settings.xml** file to use artifact repositories at example.server.org:

```xml
<settings>
  <profiles>
    <profile>
      <id>my-nexus</id>
      <pluginRepositories>
        <pluginRepository>
          <id>my-nexus-snapshots</id>
          <releases>
            <enabled>false</enabled>
          </releases>
          <snapshots>
            <enabled>true</enabled>
          </snapshots>
          <url>http://example.server.org/repository/maven-snapshots/</url>
        </pluginRepository>
        <pluginRepository>
          <id>my-nexus-releases</id>
          <releases>
            <enabled>true</enabled>
          </releases>
          <snapshots>
            <enabled>false</enabled>
          </snapshots>
          <url>http://example.server.org/repository/maven-releases/</url>
        </pluginRepository>
        <repositories>
          <repository>
            <id>my-nexus-snapshots</id>
            <releases>
              <enabled>false</enabled>
            </releases>
            <snapshots>
              <enabled>true</enabled>
            </snapshots>
            <url>http://example.server.org/repository/maven-snapshots/</url>
          </repository>
          <repository>
            <id>my-nexus-releases</id>
            <releases>
              <enabled>true</enabled>
            </releases>
            <snapshots>
              <enabled>false</enabled>
            </snapshots>
            <url>http://example.server.org/repository/maven-releases/</url>
          </repository>
        </repositories>
      </pluginRepositories>
    </profile>
    <activeProfiles>
      <activeProfile>my-nexus</activeProfile>
    </activeProfiles>
  </profiles>
</settings>
```
6.1.2. Defining Maven settings.xml file across workspaces

To use your own settings.xml file across all your workspaces, create a Secret object (with a name of your choice) in the same project as the workspace. Put the contents of the required settings.xml in the data section of the Secret (possibly along with other files that should reside in the same directory). Labelling and annotating this Secret according to Section 3.8.1, “Mounting a secret as a file into a workspace container” ensures that the contents of the Secret is mounted into the workspace Pod. Note that you need to restart any previously running workspaces for them to use this Secret.

Prerequisites

This is required to set your private credentials to a Maven repository. See the Maven documentation Settings.xml#Servers for additional information.

To mount this settings.xml:

**Procedure**

1. Convert settings.xml to base64:

   ```
   $ cat settings.xml | base64
   ```

2. Copy the output to a new file, secret.yaml, which also defines needed annotations and labels:

   ```yaml
   apiVersion: v1
   kind: Secret
   metadata:
     name: maven-settings-secret
     labels:
       app.kubernetes.io/part-of: che.eclipse.org
       app.kubernetes.io/component: workspace-secret
   annotations:
     che.eclipse.org/automount-workspace-secret: true
     che.eclipse.org/mount-path: /home/jboss/.m2
     che.eclipse.org/mount-as: file
   type: Opaque
   data:
     settings.xml: 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
3. Create this secret in the cluster:

```bash
$ oc apply -f secret.yaml
```

4. Start a new workspace. You will see `/home/jboss/.m2/settings.xml` with your original content in the `maven` container.

### 6.1.2.1. Openshift 3.11 and OpenShift <1.13

On OpenShift 3.11, it’s impossible to have multiple VolumeMounts at same path so having devfile with volume `/home/jboss/.m2` and secret at `/home/jboss/.m2/settings.xml` would resolve into the conflict. On these clusters use `/home/jboss/.m2/repository` as a volume for maven repository in the devfile:

```yaml
apiVersion: 1.0.0
metadata:
  ...
components:
  - type: dockerimage
    alias: maven
    image: maven:3.11
    volumes:
      - name: m2
        containerPath: /home/jboss/.m2/repository
  ...
```

### 6.1.3. Using self-signed certificates in Maven projects

Internal artifact repositories often do not have a certificate signed by an authority that is trusted by default in Java. They are usually signed by an internal company authority or are self-signed. Configure your tools to accept these certificates by adding them to the Java truststore.

**Procedure**

1. Obtain a server certificate file from the repository server. It is often a file named `tls.crt`.
   
a. Create a Java truststore file:

```bash
$ keytool -import -file tls.crt -alias nexus -keystore truststore.jks -storepass changeit
```

Trust this certificate? [no]: yes
Certificate was added to keystore
Owner: CN=example.com
Issuer: CN=example.com
Serial number: 80ca0f6980c6019a
Valid from: Thu Feb 06 11:00:29 CET 2020 until: Fri Feb 05 11:00:29 CET 2021
Certificate fingerprints:
SHA256:
0A:A0:31:33:29
Signature algorithm name: SHA256withRSA
Subject Public Key Algorithm: 4096-bit RSA key
Version: 3

Extensions:

#1: ObjectId: 2.5.29.17 Criticality=false
SubjectAlternativeName [ 
  DNSName: *.apps.example.com
]

Trust this certificate? [no]: yes
Certificate was added to keystore

b. Upload the truststore file to /projects/maven/truststore.jks to make it available for all containers.

2. Add the truststore file.

- In the Maven container:
  a. Add the `javax.net.ssl` system property to the `MAVEN_OPTS` environment variable:

```bash
- mountSources: true
  alias: maven
  type: dockerimage
  ...
  env:
    - name: MAVEN_OPTS
      value: >-
        -Duser.home=/projects/maven
        -Djavax.net.ssl.trustStore=/projects/truststore.jks
```

b. Restart the workspace.

- In the Java plug-in container:
  In the devfile, add the `javax.net.ssl` system property for the Java language server:

```yaml
components:
  - id: redhat/java11/latest
    type: chePlugin
    preferences:
      java.jdt.ls.vmargs: >-
        -noverify -Xmx1G -XX:+UseG1GC -XX:+UseStringDeduplication
        -Duser.home=/projects/maven
        -Djavax.net.ssl.trustStore=/projects/truststore.jks
```

6.2. USING GRADLE ARTIFACT REPOSITORIES

6.2.1. Downloading different versions of Gradle
The recommended way to download any version of Gradle is by using the Gradle Wrapper script. If your project does not have a `gradle/wrapper` directory, run `$ gradle wrapper` to configure the Wrapper.

**Prerequisites**

- The Gradle Wrapper is present in your project.

**Procedure**

To download a Gradle version from a non-standard location, change your Wrapper settings in `/projects/<your_project>/gradle/wrapper/gradle-wrapper.properties`:

- Change the `distributionUrl` property to point to a URL of the Gradle distribution ZIP file:

  ```properties
  distributionUrl=http://<url_to_gradle>/gradle-6.1-bin.zip
  ```

Alternatively, you may place a Gradle distribution zip file locally in `/project/gradle` in your workspace.

- Change the `distributionUrl` property to point to a local address of the Gradle distribution zip file:

  ```properties
  distributionUrl=file:/projects/gradle/gradle-6.1-bin.zip
  ```

**6.2.2. Configuring global Gradle repositories**

Use an initialization script to configure global repositories for the workspace. Gradle performs extra configuration before projects are evaluated, and this configuration is used in each Gradle project from the workspace.

**Procedure**

To set global repositories for Gradle that could be used in each Gradle project in the workspace, create an `init.gradle` script in the `~/.gradle/` directory:

```groovy
allprojects {
    repositories {
        mavenLocal ()
        maven {
            url "http://repo.mycompany.com/maven"
            credentials {
                username "admin"
                password "my_password"
            }
        }
    }
}
```

This file configures Gradle to use a local Maven repository with the given credentials.
6.2.3. Using self-signed certificates in Gradle projects

Internal artifact repositories often do not have a certificate signed by an authority that is trusted by default in Java. They are usually signed by an internal company authority or are self-signed. Configure your tools to accept these certificates by adding them to the Java truststore.

**Procedure**

1. Obtain a server certificate file from the repository server. It is often a file named `tls.crt`.
   a. Create a Java truststore file:

   ```sh
   $ keytool -import -file tls.crt -alias nexus -keystore truststore.jks -storepass changeit
   Trust this certificate? [no]: yes
   Certificate was added to keystore
   Owner: CN=example.com
   Issuer: CN=example.com
   Serial number: 80ca0f6980c6019a
   Valid from: Thu Feb 06 11:00:29 CET 2020 until: Fri Feb 05 11:00:29 CET 2021
   Certificate fingerprints:
   Signature algorithm name: SHA256withRSA
   Subject Public Key Algorithm: 4096-bit RSA key
   Version: 3
   
   Extensions:
   #1: ObjectId: 2.5.29.17 Criticality=false
   SubjectAlternativeName [DNSName: *.apps.example.com]
   
   Trust this certificate? [no]: yes
   Certificate was added to keystore
   
   b. Upload the truststore file to `/projects/gradle/truststore.jks` to make it available for all containers.

2. Add the truststore file in the Gradle container.
   a. Add the `javax.net.ssl` system property to the `JAVA_OPTS` environment variable:

   ```bash
   - mountSources: true
   alias: maven
   type: dockerimage
   ```
6.3. USING PYTHON ARTIFACT REPOSITORIES

6.3.1. Configuring Python to use a non-standard registry

To specify a non-standard repository for use by the Python pip tool, set the `PIP_INDEX_URL` environment variable.

Procedure

- In your devfile, configure the `PIP_INDEX_URL` environment variable for the language support and for the development container components:

```yaml
- id: ms-python/python/latest
  memoryLimit: 512Mi
  type: chePlugin
  env:
    - name: 'PIP_INDEX_URL'
      value: 'https://<username>:<password>@pypi.company.com/simple'
    - mountSources: true
      memoryLimit: 512Mi
      type: dockerimage
      alias: python
      image: 'registry.redhat.io/codeready-workspaces/plugin-java8-rhel8:2.5'
      env:
        - name: 'PIP_INDEX_URL'
          value: 'https://<username>:<password>@pypi.company.com/simple'
```

6.3.2. Using self-signed certificates in Python projects

Internal artifact repositories often do not have a self-signed TLS certificate signed by an authority that is trusted by default. They are usually signed by an internal company authority or are self-signed. Configure your tools to accept these certificates.

Python uses certificates from a file defined in the `PIP_CERT` environment variable.

Procedure

1. Obtain the certificate from the non-standard repository and place the certificate file in the `/projects/ls/rootCA.pem` file to make it accessible from all your containers.
NOTE

pip accepts certificates in the Privacy-Enhanced Mail (PEM) format only. Convert the certificate to the PEM format using OpenSSL if necessary.

2. Configure the devfile:

```
- id: ms-python/python/latest
  memoryLimit: 512Mi
  type: chePlugin
  env:
    - name: 'PIP_INDEX_URL'
      value: 'https://<username>:<password>@pypi.company.com/simple'
    - value: '/projects/tls/rootCA.pem'
      name: 'PIP_CERT'
  - mountSources: true
    memoryLimit: 512Mi
    type: dockerimage
    alias: python
    image: 'registry.redhat.io/codeready-workspaces/plugin-java8-rhel8:2.5'
    env:
      - name: 'PIP_INDEX_URL'
        value: 'https://<username>:<password>@pypi.company.com/simple'
      - value: '/projects/tls/rootCA.pem'
        name: 'PIP_CERT'
```

6.4. USING GO ARTIFACT REPOSITORIES

To configure Go in a restricted environment, use the GOPROXY environment variable and the Athens module datastore and proxy.

6.4.1. Configuring Go to use a non-standard-registry

Athens is a Go module datastore and proxy with many configuration options. It can be configured to act only as a module datastore and not as a proxy. An administrator can upload their Go modules to the Athens datastore and have them available across their Go projects. If a project tries to access a Go module that is not in the Athens datastore, the Go build fails.

- To work with Athens, configure the GOPROXY environment variable in the devfile of your CLI container:

```
components:
  - mountSources: true
    type: dockerimage
    alias: go-cli
    image: 'quay.io/eclipse/che-golang-1.12:7.7.0'
    ...  
    - value: /tmp/.cache
      name: GOCACHE
    - value: 'http://your.athens.host'
      name: GOPROXY
```

6.4.2. Using self-signed certificates in Go projects
Internal artifact repositories often do not have a self-signed TLS certificate signed by an authority that is trusted by default. They are usually signed by an internal company authority or are self-signed. Configure your tools to accept these certificates.

Go uses certificates from a file defined in the `SSL_CERT_FILE` environment variable.

**Procedure**

1. Obtain the certificate used by the Athens server in the Privacy-Enhanced Mail (PEM) format and place it in the `/projects/tls/rootCA.crt` file to make it accessible from all your containers.

2. Right-click the project explorer and select **Upload files** to upload the `rootCA.crt` certificate file to your Red Hat CodeReady Workspaces workspace.

3. Add the appropriate environment variables to your devfile:

   ```
   components:
   - mountSources: true
type: dockerimage
alias: go-cli
image: 'registry.redhat.io/codeready-workspaces/stacks-golang-rhel8:2.5'
...  
- value: /tmp/.cache
  name: GOCACHE
- value: 'http://your.athens.host'
  name: GOPROXY
- value: '/projects/tls/rootCA.crt'
  name: SSL_CERT_FILE
   ```

**Additional resources**

- GitHub - gomods/athens: A Go module datastore and proxy

### 6.5. USING NUGET ARTIFACT REPOSITORIES

To configure NuGet in a restricted environment, modify the `nuget.config` file and use the `SSL_CERT_FILE` environment variable in the devfile to add self-signed certificates.

#### 6.5.1. Configuring NuGet to use a non-standard artifact repository

NuGet searches for configuration files anywhere between the solution directory and the driver root directory. If you put the `nuget.config` file in the `/projects` directory, the `nuget.config` file defines NuGet behavior for all projects in `/projects`.

**Procedure**

- Create and place the `nuget.config` file in the `/projects` directory.

**Example nuget.config with a Nexus repository hosted at nexus.example.org:**

```xml
<?xml version="1.0" encoding="UTF-8"?>
<configuration>
  <packageSources>
    <add key="nexus2" value="https://nexus.example.org/repository/nuget-hosted/"/>
  </packageSources>
</configuration>
```
6.5.2. Using self-signed certificates in NuGet projects

Internal artifact repositories often do not have a self-signed TLS certificate signed by an authority that is trusted by default. They are usually signed by an internal company authority or are self-signed. Configure your tools to accept these certificates.

Procedure

1. Obtain the certificate file of a non-standard repository and place it in the `/projects/tls/rootCA.crt` file to make it accessible from all your containers.

2. Specify the location of the certificate file in the `SSL_CERT_FILE` environment variable in your devfile for the OmniSharp plug-in and for the .NET container.

Example of the devfile:

```xml
<packageSources>
<packageSourceCredentials>
<nexus2>
  <add key="Username" value="user"/>
  <add key="Password" value="..."/>
</nexus2>
</packageSourceCredentials>
</configuration>
```

6.6. USING NPM ARTIFACT REPOSITORIES

npm is usually configured using the `npm config` command, writing values to the `.npmrc` files. However, configuration values can also be set using the environment variables beginning with `NPM_CONFIG_`.

```xml
<components>
  - id: redhat-developer/che-omnisharp-plugin/latest
    memoryLimit: 1024Mi
    type: chePlugin
    alias: omnisharp
    env:
      - value: /projects/tls/rootCA.crt
        name: SSL_CERT_FILE
    - mountSources: true
    endpoints:
      - name: 5000/tcp
        port: 5000
        memoryLimit: 512Mi
        type: dockerimage
        volumes:
          - name: dotnet
            containerPath: /home/jboss
            alias: dotnet
        image: 'quay.io/eclipse/che-dotnet-2.2:7.7.1'
        env:
          - value: /projects/tls/rootCA.crt
            name: SSL_CERT_FILE
</components>
```
The Javascript/Typescript plug-in used in Red Hat CodeReady Workspaces does not download any artifacts. It is enough to configure npm in the dev-machine component.

Use the following environment variables for configuration:

- The URL for the artifact repository: **NPM_CONFIG_REGISTRY**
- For using a certificate from a file: **NODE_EXTRA_CA_CERTS**

To be able to reference the certificate in a devfile, get a copy of the certificate of the npm repository server and put it inside the `/project` folder.

1. An example configuration for the use of an internal repository with a self-signed certificate:

   ```yaml
   - mountSources: true
   endpoints:
     - name: nodejs
       port: 3000
       memoryLimit: '512Mi'
       type: 'dockerimage'
       alias: 'nodejs'
       image: 'quay.io/eclipse/che-nodejs10-ubi:nightly'
       env:
         - name: NODE_EXTRA_CA_CERTS
           value: '/projects/config/tls.crt'
         - name: NPM_CONFIG_REGISTRY
           value: 'https://snexus-airgap.apps.acme.com/repository/npm-proxy/
```
CHAPTER 7. TROUBLESHOOTING CODEREADY WORKSPACES

This section provides troubleshooting procedures for the most frequent issues a user can come in conflict with.

Additional resources
- Section 7.1, “Viewing CodeReady Workspaces workspaces logs”
- Section 7.2, “Troubleshooting slow workspaces”
- Section 7.3, “Troubleshooting network problems”
- Section 7.4, “Starting a CodeReady Workspaces workspace in debug mode”
- Section 7.5, “Restarting a CodeReady Workspaces workspace in debug mode after start failure”

7.1. VIEWING CODEREADY WORKSPACES WORKSPACES LOGS

This section describes how to view CodeReady Workspaces workspaces logs.

7.1.1. Viewing logs from language servers and debug adapters

7.1.1.1. Checking important logs

This section describes how to check important logs.

Procedure

1. In the OpenShift web console, click Applications → Pods to see a list of all the active workspaces.

2. Click on the name of the running Pod where the workspace is running. The Pod screen contains the list of all containers with additional information.

3. Choose a container and click the container name.

   **NOTE**

   The most important logs are the theia-ide container and the plug-ins container logs.

4. On the container screen, navigate to the Logs section.

7.1.1.2. Detecting memory problems

This section describes how to detect memory problems related to a plug-in running out of memory. The following are the two most common problems related to a plug-in running out of memory:

The plug-in container runs out of memory

This can happen during plug-in initialization when the container does not have enough RAM to
execute the entrypoint of the image. The user can detect this in the logs of the plug-in container. In this case, the logs contain **OOMKilled**, which implies that the processes in the container requested more memory than is available in the container.

**A process inside the container runs out of memory without the container noticing this**

For example, the Java language server (Eclipse JDT Language Server, started by the vscode-java extension) throws an **OutOfMemoryException**. This can happen any time after the container is initialized, for example, when a plug-in starts a language server or when a process runs out of memory because of the size of the project it has to handle.
To detect this problem, check the logs of the primary process running in the container. For example, to check the log file of Eclipse JDT Language Server for details, see the relevant plug-in-specific sections.

### 7.1.1.3. Logging the client-server traffic for debug adapters

This section describes how to log the exchange between Che-Theia and a debug adapter into the **Output** view.

**Prerequisites**

- A debug session must be started for the **Debug adapters** option to appear in the list.

**Procedure**

1. Click **File → Settings** and then open **Preferences**.
2. Expand the **Debug** section in the **Preferences** view.
3. Set the **trace** preference value to **true** (default is **false**).
4. All the communication events are now logged.
5. To watch these events, click **View → Output** and select **Debug adapters** from the drop-down list at the upper right corner of the **Output** view.

### 7.1.1.4. Viewing logs for Python

This section describes how to view logs for the Python language server.

**Procedure**

- Navigate to the **Output** view and select **Python** in the drop-down list.

### 7.1.1.5. Viewing logs for Go

This section describes how to view logs for the Go language server.

#### 7.1.1.5.1. Finding the gopath
This section describes how to find where the `GOPATH` variable points to.

**Procedure**

- Execute the `Go: Current GOPATH` command.

```
> Go: Current GOPATH
```

```
$GOPATH
```

/go:/projects is the current GOPATH.

### 7.1.1.5.2. Viewing the Debug Console log for Go

This section describes how to view the log output from the Go debugger.

**Procedure**

1. Set the `showLog` attribute to `true` in the debug configuration.

```json
{
    "version": "0.2.0",
    "configurations": [
        {
            "type": "go",
            "showLog": true
        }
    ]
}
```

2. To enable debugging output for a component, add the package to the comma-separated list value of the `logOutput` attribute:

```json
{
    "version": "0.2.0",
    "configurations": [
        {
            "type": "go",
            "showLog": true,
            "logOutput": "debugger,rpc,gdbwire,lldbout,debuglineerr"
        }
    ]
}
```

3. The debug console prints the additional information in the debug console.
7.1.1.5.3. Viewing the Go logs output in the Output panel

This section describes how to view the Go logs output in the Output panel.

**Procedure**

1. Navigate to the Output view.
2. Select Go in the drop-down list.

7.1.1.6. Viewing logs for the NodeDebug NodeDebug2 adapter

**NOTE**

No specific diagnostics exist other than the general ones.

7.1.1.7. Viewing logs for Typescript

7.1.1.7.1. Enabling the label switched protocol (LSP) tracing

**Procedure**

1. To enable the tracing of messages sent to the Typescript (TS) server, in the Preferences view, set the `typescript.tsserver.trace` attribute to `verbose`. Use this to diagnose the TS server issues.
2. To enable logging of the TS server to a file, set the `typescript.tsserver.log` attribute to `verbose`. Use this log to diagnose the TS server issues. The log contains the file paths.

7.1.1.7.2. Viewing the Typescript language server log

This section describes how to view the Typescript language server log.
Procedure

1. To get the path to the log file, see the Typescript Output console:

2. To open log file, use the Open TS Server log command.

7.1.1.7.3. Viewing the Typescript logs output in the Output panel

This section describes how to view the Typescript logs output in the Output panel.

Procedure

1. Navigate to the Output view

2. Select TypeScript in the drop-down list.

7.1.1.8. Viewing logs for Java

Other than the general diagnostics, there are Language Support for Java (Eclipse JDT Language Server) plug-in actions that the user can perform.

7.1.1.8.1. Verifying the state of the Eclipse JDT Language Server

Procedure

Check if the container that is running the Eclipse JDT Language Server plug-in is running the Eclipse JDT Language Server main process.

1. Open a terminal in the container that is running the Eclipse JDT Language Server plug-in (an example name for the container: vscode-javaxxx).

2. Inside the terminal, run the ps aux | grep jdt command to check if the Eclipse JDT Language Server process is running in the container. If the process is running, the output is:

   ```
   usr/lib/jvm/default-jvm/bin/java --add-modules=ALL-SYSTEM --add-opens java.base/java.util
   ```

   This message also shows the VSCode Java extension used. If it is not running, the language server has not been started inside the container.

3. Check all logs described in Checking important logs

7.1.1.8.2. Verifying the Eclipse JDT Language Server features
Procedure

If the Eclipse JDT Language Server process is running, check if the language server features are working:

1. Open a Java file and use the hover or autocomplete functionality. In case of an erroneous file, the user sees Java in the Outline view or in the Problems view.

7.1.1.8.3. Viewing the Java language server log

Procedure

The Eclipse JDT Language Server has its own workspace where it logs errors, information about executed commands, and events.

1. To open this log file, open a terminal in the container that is running the Eclipse JDT Language Server plug-in. You can also view the log file by running the Java: Open Java Language Server log file command.

2. Run `cat <PATH_TO_LOG_FILE>` where `PATH_TO_LOG_FILE` is `/home/theia/.theia/workspace-storage/<workspace_name>/redhat.java/jdt_ws/.metadata/.log`.

7.1.1.8.4. Logging the Java language server protocol (LSP) messages

Procedure

To log the LSP messages to the VS Code Output view, enable tracing by setting the `java.trace.server` attribute to `verbose`.

Additional resources

For troubleshooting instructions, see the VS Code Java Github repository.

7.1.1.9. Viewing logs for Intelephense

7.1.1.9.1. Logging the Intelephense client-server communication

Procedure

To configure the PHP Intelephense language support to log the client-server interexchange in the Output view:

1. Click File → Settings.

2. Open the Preferences view.

3. Expand the Intelephense section and set the `trace.server.verbose` preference value to `verbose` to see all the communication events (the default value is `off`).

7.1.1.9.2. Viewing Intelephense events in the Output panel

This procedure describes how to view Intelephense events in the Output panel.

Procedure
1. Click View → Output
2. Select Intelephense in the drop-down list for the Output view.

7.1.1.10. Viewing logs for PHP-Debug

This procedure describes how to configure the PHP Debug plug-in to log the PHP Debug plug-in diagnostic messages into the Debug Console view. Configure this before the start of the debug session.

Procedure

1. In the launch.json file, add the "log": true attribute to the selected launch configuration.
2. Start the debug session.
3. The diagnostic messages are printed into the Debug Console view along with the application output.

7.1.1.11. Viewing logs for XML

Other than the general diagnostics, there are XML plug-in specific actions that the user can perform.

7.1.1.11.1. Verifying the state of the XML language server

Procedure

1. Open a terminal in the container named vscode-xml-<xxx>.
2. Run ps aux | grep java to verify that the XML language server has started. If the process is running, the output is:

```
java ***/org.eclipse.ls4xml-uber.jar`
```

If is not, see the Checking important logs chapter.

7.1.1.11.2. Checking XML language server feature flags

Procedure

1. Check if the features are enabled. The XML plug-in provides multiple settings that can enable and disable features:
   - xml.format.enabled: Enable the formatter
   - xml.validation.enabled: Enable the validation
   - xml.documentSymbols.enabled: Enable the document symbols
2. To diagnose whether the XML language server is working, create a simple XML element, such as `<hello></hello>`, and confirm that it appears in the Outline panel on the right.
3. If the document symbols do not show, ensure that the xml.documentSymbols.enabled attribute is set to true. If it is true, and there are no symbols, the language server may not be hooked to the editor. If there are document symbols, then the language server is connected to
the editor.

4. Ensure that the features that the user needs, are set to true in the settings (they are set to true by default). If any of the features are not working, or not working as expected, file an issue against the Language Server.

7.1.1.11.3. Enabling XML Language Server Protocol (LSP) tracing

Procedure

To log LSP messages to the VS Code Output view, enable tracing by setting the xml.trace.server attribute to verbose.

7.1.1.11.4. Viewing the XML language server log

Procedure

The log from the language server can be found in the plug-in sidecar at /home/theia/.theia/workspace-storage/<workspace_name>/redhat.vscode-xml/lsp4xml.log.

7.1.1.12. Viewing logs for YAML

This section describes the YAML plug-in specific actions that the user can perform, in addition to the general diagnostics ones.

7.1.1.12.1. Verifying the state of the YAML language server

This section describes how to verify the state of the YAML language server.

Procedure

Check if the container running the YAML plug-in is running the YAML language server.

1. In the editor, open a terminal in the container that is running the YAML plug-in (an example name of the container: vscode-yaml-<xxx>).

2. In the terminal, run the ps aux | grep node command. This command searches all the node processes running in the current container.

3. Verify that a command node **/server.js is running.
The `node` running in the container indicates that the language server is running. If it is not running, the language server has not started inside the container. In this case, see Checking important logs.

### 7.1.12.2. Checking the YAML language server feature flags

**Procedure**

To check the feature flags:

1. Check if the features are enabled. The YAML plug-in provides multiple settings that can enable and disable features, such as:
   - `yaml.format.enable`: Enables the formatter
   - `yaml.validate`: Enables validation
   - `yaml.hover`: Enables the hover function
   - `yaml.completion`: Enables the completion function

2. To check if the plug-in is working, type the simplest YAML, such as `hello: world`, and then open the Outline panel on the right side of the editor.

3. Verify if there are any document symbols. If yes, the language server is connected to the editor.

4. If any feature is not working, make sure that the settings listed above are set to `true` (they are set to `true` by default). If a feature is not working, file an issue against the Language Server.

### 7.1.12.3. Enabling YAML Language Server Protocol (LSP) tracing

**Procedure**

To log LSP messages to the VS Code Output view, enable tracing by setting the `yaml.trace.server`...
To log LSP messages to the VS Code Output view, enable tracing by setting the `yaml.trace.server` attribute to `verbose`.

7.1.1.13. Viewing logs for Dotnet with Omnisharp-Theia plug-in

7.1.1.13.1. Omnisharp-Theia plug-in

CodeReady Workspaces uses the Omnisharp-Theia plug-in as a remote plug-in. It is located at `github.com/redhat-developer/omnisharp-theia-plugin`. In case of an issue, report it, or contribute your fix in the repository.

This plug-in registers `omnisharp-roslyn` as a language server and provides project dependencies and language syntax for C# applications.

The language server runs on .NET SDK 2.2.105.

7.1.1.13.2. Verifying the state of the Omnisharp-Theia plug-in language server

Procedure

To check if the container running the Omnisharp-Theia plug-in is running OmniSharp, execute the `ps aux | grep OmniSharp.exe` command. If the process is running, the following is an example output:

```
/tmp/theia-unpacked/redhat-developer.che-omnisharp-plugin.0.0.1.zcpaqpczwb.omnia...ownsharp/OmniSharp.exe
```

If the output is different, the language server has not started inside the container. Check the logs described in Checking important logs.

7.1.1.13.3. Checking Omnisharp Che-Theia plug-in language server features

Procedure

- If the `OmniSharp.exe` process is running, check if the language server features are working by opening a `.cs` file and trying the hover or completion features, or opening the `Problems` or `Outline` view.

7.1.1.13.4. Viewing Omnisharp-Theia plug-in logs in the Output panel

Procedure

If `Omnisharp.exe` is running, it logs all information in the Output panel. To view the logs, open the Output view and select `C#` from the drop-down list.

7.1.1.14. Viewing logs for Dotnet with NetcoredebugOutput plug-in

7.1.1.14.1. NetcoredebugOutput plug-in

The NetcoredebugOutput plug-in provides the `netcoredbg` tool. This tool implements the VS Code Debug Adapter protocol and allows users to debug .NET applications under the .NET Core runtime.
The container where the NetcoredebugOutput plug-in is running contains Dotnet SDK v.2.2.105.

7.1.14.2. Verifying the state of the NetcoredebugOutput plug-in

Procedure

To test the plug-in initialization:

1. Check if there is a netcoredbg debug configuration in the launch.json file. The following is an example debug configuration:

   ```json
   {
     "type": "netcoredbg",
     "request": "launch",
     "program": "$\{workspaceFolder}/bin/Debug/<target-framework>/<project-name.dll>",
     "args": [],
     "name": ".NET Core Launch (console)",
     "stopAtEntry": false,
     "console": "internalConsole"
   }
   ```

2. To test if it exists, test the autocompletion feature within the braces of the configuration section of the launch.json file. If you can find netcoredbg, the Che-Theia plug-in is correctly initialized. If not, see Checking important logs.

7.1.14.3. Viewing NetcoredebugOutput plug-in logs in the Output panel

This section describes how to view NetcoredebugOutput plug-in logs in the Output panel.

Procedure

- Open the Debug console.

7.1.15. Viewing logs for Camel

7.1.15.1. Verifying the state of the Camel language server

Procedure
The user can inspect the log output of the sidecar container using the Camel language tools that are stored in the vscode-apache-camel<xxx> Camel container.

To verify the state of the language server:

1. Open a terminal inside the vscode-apache-camel<xxx> container.

2. Run the `ps aux | grep java` command. The following is an example language server process:

   ```java
   ```

3. If you cannot find it, see Checking important logs.

### 7.1.15.2. Viewing Camel logs in the Output panel

The Camel language server is a SpringBoot application that writes its log to the `$\{java.io.tmpdir\}/log-camel-lsp.out` file. Typically, `$\{java.io.tmpdir\}` points to the `/tmp` directory, so the filename is `/tmp/log-camel-lsp.out`.

**Procedure**

The Camel language server logs are printed in the Output channel named Language Support for Apache Camel.

**NOTE**

The output channel is created only at the first created log entry on the client side. It may be absent when everything is going well.

### 7.1.2. Viewing Che-Theia IDE logs

This section describes how to view Che-Theia IDE logs.

#### 7.1.2.1. Viewing Che-Theia editor logs using the OpenShift CLI

Observing Che-Theia editor logs helps to get a better understanding and insight over the plug-ins loaded by the editor. This section describes how to access the Che-Theia editor logs using the OpenShift CLI (command-line interface).
Prerequisites

- CodeReady Workspaces is deployed in an OpenShift cluster.
- A workspace is created.
- User is located in a CodeReady Workspaces installation project.

Procedure

1. Obtain the list of the available Pods:

   ```bash
   $ oc get pods
   ```

   Example

   ```bash
   $ oc get pods
   NAME                  READY  STATUS     RESTARTS  AGE
   codeready-9-xz6g8     1/1    Running    1         15h
   workspace0zqb2ew3py4srthh.go-cli-549c3d69-9n4w2 4/4    Running 0  1h
   ```

2. Obtain the list of the available containers in the particular Pod:

   ```bash
   $ oc get pods <name-of-pod> --output jsonpath="{.spec.containers[*].name}"
   ```

   Example:

   ```bash
   $ oc get pods workspace0zqb2ew3py4srthh.go-cli-549c3d69-9n4w2 -o jsonpath="{.spec.containers[*].name}"
   > go-cli che-machine-exechr7 theia-idxzb vscode-gox3r
   ```

3. Get logs from the theia/ide container:

   ```bash
   $ oc logs --follow <name-of-pod> --container <name-of-container>
   ```

   Example:

   ```bash
   $ oc logs --follow workspace0zqb2ew3py4srthh.go-cli-549c3d69-9n4w2 -container theia-idxzb
   >root INFO unzipping the plug-in 'task_plugin.theia' to directory: /tmp/theia-unpacked/task_plugin.theia
   root INFO unzipping the plug-in 'theia_yeoman_plugin.theia' to directory: /tmp/theia-unpacked/theia_yeoman_plugin.theia
   root WARN A handler with prefix term is already registered.
   root INFO [nsfw-watcher: 75] Started watching: /home/theia/.theia
   root WARN e.onStart is slow, took: 367.4600000013015 ms
   root INFO [nsfw-watcher: 75] Started watching: /projects
   root INFO [4f9590c5-e1c5-40d1-b9f8-ec31ec3bdac5] Sync of 9 plugins took: 62.26000000242493 ms
   root INFO [nsfw-watcher: 75] Started watching: /projects
   root INFO [hosted-plugin: 88] PLUGIN_HOST(88) starting instance
   ```
7.2. TROUBLESHOOTING SLOW WORKSPACES

Sometimes, workspaces can take a long time to start. Tuning can reduce this start time. Depending on the options, administrators or users can do the tuning.

This section includes several tuning options for starting workspaces faster or improving workspace runtime performance.

7.2.1. Improving workspace start time

Caching images with Image Puller

*Role: Administrator*

When starting a workspace, OpenShift pulls the images from the registry. A workspace can include many containers meaning that OpenShift pulls Pod’s images (one per container). Depending on the size of the image and the bandwidth, it can take a long time.

Image Puller is a tool that can cache images on each of OpenShift nodes. As such, pre-pulling images can improve start times. See [https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/administration_guide/index#caching-images-for-faster-workspace-start_crw](https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/administration_guide/index#caching-images-for-faster-workspace-start_crw).

Choosing better storage type

*Role: Administrator and user*

Every workspace has a shared volume attached. This volume stores the project files, so that when restarting a workspace, changes are still available. Depending on the storage, attach time can take up to a few minutes, and I/O can be slow.

To avoid this problem, use ephemeral or asynchronous storage. See [https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/installation_guide/index#configuring-storage-types_crw](https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/installation_guide/index#configuring-storage-types_crw).

Installing offline

*Role: Administrator*


Optimizing workspace plug-ins

*Role: User*

When selecting various plug-ins, each plug-in can bring its own sidecar container, which is an OCI image. OpenShift pulls the images of these sidecar containers.

Reduce the number of plug-ins, or disable them to see if start time is faster. See also [https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/administration_guide/index#caching-images-for-faster-workspace-start_crw](https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/administration_guide/index#caching-images-for-faster-workspace-start_crw).

Reducing the number of public endpoints

*Role: Administrator*

For each endpoint, OpenShift is creating OpenShift Route objects. Depending on the underlying configuration, this creation can be slow.
To avoid this problem, reduce the exposure. For example, to automatically detect a new port listening inside containers and redirect traffic for the processes using a local IP address (127.0.0.1), the Che-Theia IDE plug-in has three optional routes.

By reducing the number of endpoints and checking endpoints of all plug-ins, workspace start can be faster.

CDN configuration

The IDE editor uses a CDN (Content Delivery Network) to serve content. Check that the content uses a CDN to the client (or a local route for offline setup). To check that, open Developer Tools in the browser and check for vendors in the Network tab. vendors.<random-id>.js or editor.main.* should come from CDN URLs.

7.2.2. Improving workspace runtime performance

Providing enough CPU resources

Plug-ins consume CPU resources. For example, when a plug-in provides IntelliSense features, adding more CPU resources may lead to better performance. Ensure the CPU settings in the devfile definition, devfile.yaml, are correct:

```yaml
apiVersion: 1.0.0

components:
  - type: chePlugin
    id: id/of/plug-in
    cpuLimit: 1360Mi
    cpuRequest: 100m

1. Specifies the CPU limit for the plug-in.
2. Specifies the CPU request for the plug-in.

Providing enough memory

Plug-ins consume CPU and memory resources. For example, when a plug-in provides IntelliSense features, collecting data can consume all the memory allocated to the container. Providing more memory to the plug-in can increase performance. Ensure about the correctness of memory settings:

- in the plug-in definition - meta.yaml file
- in the devfile definition - devfile.yaml file

```yaml
apiVersion: v2

spec:
  containers:
    - image: "quay.io/my-image"
      name: "vscode-plugin"
```
Choosing better storage type

Use ephemeral or asynchronous storage for faster I/O. See https://access.redhat.com/documentation/en-us/red_hat_codeready_workspaces/2.5/html-single/installation_guide/index#configuring-storage-types_crw.

7.3. TROUBLESHOOTING NETWORK PROBLEMS

Most often, connection problems occur because a firewall, proxy server, corporate network, or other network is configured in a way that blocks CodeReady Workspaces.

This section describes how to prevent or resolve issues related to corporate network policies. The network administrator may be required to enable ports or the WebSockets protocol, which CodeReady Workspaces requires for proper functionality.

Common scenarios:

- Open additional ports for a specific web site.
- Enable WebSockets on the proxy server.

7.3.1. Enabling the WebSocket protocol

Enabling the WebSocket protocol is critical for the proper functionality of CodeReady Workspaces IDE.

While the WebSocket protocol itself is unaware of proxy servers and firewalls, HTTP servers can share their default HTTP and HTTPS ports with a WebSocket server.

- HTTP: port 80
- HTTPS: port 433

Some proxy servers operate with WebSockets by default, but others prevent WebSockets from working correctly, which causes the connection to fail.
In some cases, the proxy server requires the additional configuration, and the specific proxy servers need an upgrade, which allows WebSockets support.

### 7.3.2. Troubleshooting WebSocket Secure connections

Secure WebSocket connections improve confidentiality and also reliability because they reduce the risk of interference by bad proxies. CodeReady Workspaces operates under WebSocket Secure connections by default and usually no action is required. Some customer’s security policy blocks some aspects of the WebSocket protocol that causes problems with proper CodeReady Workspaces functionality. Those problems are however out of scope for CodeReady Workspaces support and have to be solved by a network administrator.

To troubleshoot a failing WebSocket Secure (WSS) connection, use the instructions in this section.

#### Prerequisites

- Using a supported web browser:
  - Chrome
  - Firefox

**NOTE**

Using an unsupported web browser causes a connection interruption, followed by a warning message.

#### Procedure

1. **Check browser support:**
   
   a. Check that the WebSocket protocol is enabled using a realtime web test in one of the supported browsers.
   
   If the problem is not resolved, follow with the next step.

2. **Check proxy servers and firewalls settings:**
   
   a. Ask the system administrator to check if there is a proxy server or firewall that blocks WebSocket Secure (WSS) connections on port 443.
   
   Possible required actions:
   
   - Add an exception to the firewall.
   - Have the proxy intercept WebSocket connection.

#### Verification

Check that the WebSocket protocol is enabled using a realtime web test in one of the supported browsers.

### 7.4. STARTING A CODEREADY WORKSPACES WORKSPACE IN DEBUG MODE

This section describes how to start the Red Hat CodeReady Workspaces workspace in debug mode.

**Prerequisites**
Prerequisites


- An existing workspace defined on this instance of Red Hat CodeReady Workspaces. See Section 3.3, “Creating and configuring a new CodeReady Workspaces 2.5 workspace.”

Procedure

1. Find the target workspace from the recent workspaces. Right-click the workspace name to open a context menu. Select the Run in debug mode item:

   ![Workspace list](image1.png)

2. Click the target workspace to see the logs.

3. The workspace logs are displayed:

   ![Workspace logs](image2.png)

7.5. RESTARTING A CODEREADY WORKSPACES WORKSPACE IN DEBUG MODE AFTER START FAILURE

This section describes how to restart the Red Hat CodeReady Workspaces workspace in debug mode after a failure during workspace start.

Prerequisites

• An existing workspace that failed to start.

Procedure

1. Find the target workspace from the recent workspaces. Click on the target workspace to see the logs:

2. Click the link for restarting in debug mode.

3. Download full logs after start fail with the Download logs link:
CHAPTER 8. OPENSIGHT CONNECTOR OVERVIEW

OpenShift Connector, also referred to as Visual Studio Code OpenShift Connector for Red Hat OpenShift, is a plug-in for CodeReady Workspaces that provides a method for interacting with Red Hat OpenShift 3 or 4 clusters.

OpenShift Connector makes it possible to create, build, and debug applications in the CodeReady Workspaces IDE and then deploy the applications directly to a running OpenShift cluster.

OpenShift Connector is a GUI for the OpenShift Do (odo) utility, which aggregates OpenShift CLI (oc) commands into compact units. As such, OpenShift Connector helps new developers who do not have OpenShift background with creating applications and running them on the cloud. Instead of using several oc commands, the user creates a new component or service by selecting a preconfigured template, such as a Project, an Application, or a Service, and then deploys it as an OpenShift Component to their cluster.

This section provides information about installing, enabling, and basic use of the OpenShift Connector plug-in.

- Section 8.1, “Features of OpenShift Connector”
- Section 8.2, “Installing OpenShift Connector in CodeReady Workspaces”
- Section 8.3, “Authenticating with OpenShift Connector from CodeReady Workspaces”
- Section 8.4, “Creating Components with OpenShift Connector in CodeReady Workspaces”
- Section 8.5, “Connecting source code from GitHub to an OpenShift Component using OpenShift Connector”

8.1. FEATURES OF OPENSIGHT CONNECTOR

The OpenShift Connector plug-in enables the user create, deploy, and push OpenShift Components to an OpenShift Cluster in a GUI.

When used in CodeReady Workspaces, the OpenShift Connector GUI provides the following benefits to its users:

Cluster management

- Logging in to clusters using:
  - Authentication tokens
  - Username and password
  - Auto-login feature when CodeReady Workspaces is authenticated with the OpenShift OAuth service
- Switching contexts between different .kube/config entries directly from the extension view.
- Viewing and managing OpenShift resources as build and deployment configurations from the Explorer view.

Development
Connecting to a local or hosted OpenShift cluster directly from CodeReady Workspaces.

- Quickly updating the cluster with your changes.
- Creating Components, Services, and Routes on the connected cluster.
- Adding storage directly to a component from the extension itself.

**Deployment**

- Deploying to OpenShift clusters with a single click directly from CodeReady Workspaces.
- Navigating to the multiple Routes, created to access the deployed application.
- Deploying multiple interlinked Components and Services directly on the cluster.
- Pushing and watching component changes from the CodeReady Workspaces IDE.
- Streaming logs directly on the integrated terminal view of CodeReady Workspaces.

**Monitoring**

- Working with OpenShift resources directly from the CodeReady Workspaces IDE.
- Starting and resuming build and deployment configurations.
- Viewing and following logs for deployments, pods, and containers.

### 8.2. INSTALLING OPENSSHIFT CONNECTOR IN CODEREADY WORKSPACES

OpenShift Connector is a plug-in designed to create basic OpenShift Components, using CodeReady Workspaces as the editor, and to deploy the Component to an OpenShift cluster. To visually verify that the plug-in is available in your instance, see whether the OpenShift icon is displayed in the CodeReady Workspaces left menu.

To install and enable OpenShift Connector in a CodeReady Workspaces instance, use instructions in this section.

#### Prerequisites


#### Procedure

Install OpenShift Connector in CodeReady Workspaces by adding it as an extension in the CodeReady Workspaces Plugins panel.

1. Open the CodeReady Workspaces Plugins panel by pressing `Ctrl+Shift+J` or by navigating to View → Plugins.

2. Search for `vscode-openshift-connector`, and click the Install button.
3. Restart the workspace for the changes to take effect.
4. The dedicated OpenShift Application Explorer icon is added to the left panel.

8.3. AUTHENTICATING WITH OPENSIFT CONNECTOR FROM CODEREADY WORKSPACES

The following section is relevant only when the OpenShift OAuth service does not already authenticate a CodeReady Workspaces instance; otherwise, the OpenShift Connector plug-in automatically establishes the authentication with the Openshift instance where CodeReady Workspaces runs.

Before the user can develop and push Components from CodeReady Workspaces, they need to authenticate with an OpenShift cluster.

OpenShift Connector offers the following methods for logging in to the OpenShift Cluster from the CodeReady Workspaces instance:

- Using the notification that asks to log in to the OpenShift cluster where CodeReady Workspaces is deployed to.
- Using the Log in to the cluster button.
- Using the Command Palette.

**NOTE**

In CodeReady Workspaces 2.5, OpenShift Connector plug-in requires manual connecting to the target cluster

By default, the OpenShift Connector plug-in logs into the cluster as *inClusterUser*, which may not have the manage project permission. This causes an error message to be displayed when a new project is being created using OpenShift Application Explorer:

```
Failed to create Project with error 'Error: Command failed: "/tmp/vscode-unpacked/redhat.vscode-openshift-connector.latest.qvkozqtkba.openshift-connector-0.1.4-523.vsix/extension/out/tools/linux/odo" project create test-project X projectrequests.project.openshift.io is forbidden
```

To work around this temporary issue, log out from the local cluster and relog in to OpenShift cluster using the OpenShift user’s credentials.

When using a local instance of OpenShift (such as CodeReady Containers or Minishift), the user’s credentials are stored in the workspace `~/.kube/config` file, and may be used for automatic authentication in subsequent logins. In the context of CodeReady Workspaces, the `~/.kube/config` is stored as a part of the plug-in sidecar container.

**Prerequisites**

A CodeReady Workspaces workspace has been created.

The OpenShift Connector plug-in is available.

The OpenShift OAuth provider is configured (only for the auto-login to the OpenShift cluster where CodeReady Workspaces is deployed. See Section 5.2, “Configuring OpenShift OAuth”).

Procedure

1. In the left panel, select the OpenShift Application Explorer icon.
   The OpenShift Connector panel is displayed.

2. Log in using the OpenShift Application Explorer. Use one of the following methods:
   - Click the Log in to cluster button in the top left corner of the pane.
   - Press F1 to open the Command Palette, or navigate to View → Find Command in the top menu.
     Search for OpenShift: Log in to cluster and press Enter.

3. If a You are already logged in a cluster. message appears, click Yes.
   A selection whether to log in using Credentials or Token is displayed at the top of the screen.

4. Select the method to log in to the cluster and follow the login instructions.

   NOTE
   For authenticating with a token, the required token information is in the top right corner of the main OpenShift Container Platform screen, under <User name> → Copy Login Command

8.4. CREATING COMPONENTS WITH OPENSHIFT CONNECTOR IN CODEREADY WORKSPACES

In the context of OpenShift, Components and Services are basic structures that need to be stored in Application, which is a part of the OpenShift project that organizes deployables into virtual folders for better readability.

This chapter describes how to create OpenShift Components in the CodeReady Workspaces using the OpenShift Connector plug-in and push them to an OpenShift cluster.

Prerequisites


- The user is logged in to an OpenShift cluster using the OpenShift Connector plug-in.

Procedure
1. In the OpenShift Connector panel, right-click the row with the red OpenShift icon and select New Project.

2. Enter a name for your project.

3. Right-click the created project and select New Component.

4. When prompted, enter the name for a new OpenShift Application in which the component can be stored.
   The following options of source for your component are displayed:
   a. Git Repository
      This prompts you to specify a Git repository URL and select the intended revision of the runtime.
   b. Binary File
      This prompts you to select a file from the file explorer.
   c. Workspace Directory
      This prompts you to select a folder from the file explorer.

5. Enter the name for the component.

6. Select the component type.

7. Select the component type version.

8. The component is created. Right-click the component, select New URL, and enter a name of your choice.

9. The component is ready to be pushed to the OpenShift cluster. To do so, right-click the component and select Push.
   The component is now deployed to the cluster. Right-click for selecting additional actions, such as debugging and opening in a browser (requires port 8080 to be exposed).

8.5. CONNECTING SOURCE CODE FROM GITHUB TO AN OPENSHIFT COMPONENT USING OPENSHIFT CONNECTOR

When the user has a Git-stored source code that is wanted for further development, it is more efficient to deploy it directly from the Git repository into the OpenShift Connector Component.

This chapter describes how to obtain the content from the Git repository and connect it with a CodeReady Workspaces-developed OpenShift Component.

Prerequisites
- Have a running CodeReady Workspaces workspace.
- Be logged in to the OpenShift cluster using the OpenShift Connector.

Procedure
To make changes to your GitHub component, clone the repository into CodeReady Workspaces to obtain this source code:

1. In the CodeReady Workspaces main screen, open the Command Palette by pressing F1.
2. Type the **Git Clone** command in the Command Palette and press **Enter**.

3. Provide the GitHub URL and select the destination for the deployment.

4. Add source-code files to your Project by clicking the **Add to workspace** button.

For additional information about cloning Git repository, see: Section 2.2.2, “Accessing a Git repository using HTTPS”.
CHAPTER 9. TELEMETRY OVERVIEW

Telemetry is the transparent and ethical collection of usage data. By default, telemetry is not available in Red Hat CodeReady Workspaces, but there is an abstract API that allows enabling telemetry using the plug-in mechanism. This approach is used in the Hosted Che service where telemetry is enabled for every workspace.

This documentation includes a guide describing how to make your own telemetry client for Red Hat CodeReady Workspaces, followed by an overview of the Red Hat CodeReady Workspaces Woopra Telemetry Plugin.

9.1. USE CASES

Red Hat CodeReady Workspaces telemetry API allows tracking:

- Duration of workspace usage
- User-driven actions like file editing, committing, and pushing to remote repositories
- The list of plug-ins enabled in a workspace
- Programming languages and Section 3.1.1, “What is a devfile” used in workspaces

9.2. HOW IT WORKS

When a CodeReady Workspaces workspace starts, the che-theia container starts the telemetry plug-in, which is responsible for sending telemetry events to a back-end. If the $CHE_WORKSPACE_TELEMETRY_BACKEND_PORT environment variable was set in the workspace Pod, the telemetry plug-in will send events to a back-end listening at that port.

If the CodeReady Workspaces workspace has a telemetry back-end container running, and it is listening on $CHE_WORKSPACE_TELEMETRY_BACKEND_PORT, it takes the events sent from the telemetry plug-in, turns them into the back-end-specific representation of events, and sends them to the configured analytics back-end (for example, Segment or Woopra).
9.3. CREATING A TELEMETRY PLUGIN

This section shows how to create an AnalyticsManager class that extends AbstractAnalyticsManager and implements the following methods:

- `isEnabled()` - determines whether or not the telemetry back-end is functioning correctly. This could mean always returning `true`, or have more complex checks, for example, returning `false` when a connection property is missing.

- `destroy()` - cleanup method that is run before shutting down the telemetry back-end. This method sends the `WORKSPACE_STOPPED` event.
- `onActivity()` - notifies that some activity is still happening for a given user. This is mainly used to send `WORKSPACE_INACTIVE` events.

- `onEvent()` - submits telemetry events to the telemetry server, such as `WORKSPACE USED` or `WORKSPACE_STARTED`.

- `increaseDuration()` - increases the duration of a current event rather than sending multiple events in a small frame of time.

9.3.1. Getting Started

This document describes the steps required to extend the CodeReady Workspaces telemetry system to connect to a custom back-end:

1. Creating a server process that receives events
2. Extending CodeReady Workspaces libraries to create a back-end that send events to the server
3. Packaging the telemetry back-end in a container and deploying it to an image registry
4. Adding a plug-in for your back-end and instructing CodeReady Workspaces to load the plug-in in your workspaces

Optional: creating a server that receives events
This example shows how to create a server that receives events from CodeReady Workspaces and writes them to standard output.

For production use cases, consider integrating with a third-party telemetry system (for example, Segment, Woopra) rather than creating your own telemetry server. In this case, use your provider’s APIs to send events from your custom back-end to their system.

The following Go code starts a server on port 8080 and writes events to standard output:

```go
package main

import (
    "io/ioutil"
    "net/http"
    "go.uber.org/zap"
)

var logger *zap.SugaredLogger

func event(w http.ResponseWriter, req *http.Request) {
    switch req.Method {
    case "GET":
        logger.Info("GET /event")
    case "POST":
        logger.Info("POST /event")
    }
    body, err := req.GetBody()
    if err != nil {
        http.Error(w, "Error reading request body", http.StatusBadRequest)
        return
    }
    // Process the request body here
}
```
Create a container image based on this code and expose it as a deployment in OpenShift in the che project. The code for the example telemetry server is available at che-workspace-telemetry-example. To deploy the telemetry server, clone the repository and build the container:

```
$ git clone https://github.com/che-incubator/che-workspace-telemetry-example
$ cd che-workspace-telemetry-example
$ docker build -t registry/organization/che-workspace-telemetry-example:latest
$ docker push registry/organization/che-workspace-telemetry-example:latest
```

In manifest.yaml, replace the image and host fields to match the image you pushed, and the public hostname of your OpenShift cluster. Then run:

```
$ oc apply -f manifest.yaml -n <namespace to deploy>

### 9.3.2. Creating a new Maven project

**NOTE**

For fast feedback when developing, it is recommended to do development inside a CodeReady Workspaces workspace. This way, you can run the application in a cluster and connect to the workspaces front-end telemetry plug-in to send events to your custom back-end.

1. Create a new Maven Quarkus project scaffolding:

   ```bash
   $ mvn io.quarkus:quarkus-maven-plugin:1.2.1.Final:create \
   -DprojectGroupId=mygroup -DprojectArtifactId=telemetryback-end \
   -DprojectVersion=my-version -DclassName="org.my.group.MyResource"
   ```

2. Add a dependency to `org.eclipse.che.incubator.workspace-telemetry.back-end-base` in your `pom.xml`:

   ```xml
   <dependency>
   <groupId>org.eclipse.che.incubator.workspace-telemetry</groupId>
   <artifactId>backend-base</artifactId>
   <version>0.0.11</version>
   </dependency>
   ```

   ```xml
   <dependency>
   <groupId>org.apache.httpcomponents</groupId>
   <artifactId>httpclient</artifactId>
   <version>4.5.12</version>
   </dependency>
   ```

3. Add the Apache HTTP components library to send HTTP requests.

4. Consult the GitHub packages for the latest version and Maven coordinates of `back-end-base`. GitHub packages require a personal access token with `read:packages` permissions to download the CodeReady Workspaces telemetry libraries. Create a personal access token and copy the token value.

5. Create a `settings.xml` file in the repository root and add the coordinates and token to the `che-incubator` packages:

   ```xml
   <settings xmlns="http://maven.apache.org/SETTINGS/1.0.0"
   xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
   xsi:schemaLocation="http://maven.apache.org/SETTINGS/1.0.0 http://maven.apache.org/xsd/settings-1.0.0.xsd">
   <servers>
   <server>
   <id>che-incubator</id>
   <username>${env.GITHUB_USERNAME}</username>
   ```
<password>${env.GITHUB_TOKEN}</password>
</server>
</servers>

<profiles>
  <profile>
    <id>github</id>
    <activation>
      <activeByDefault>true</activeByDefault>
    </activation>
    <repositories>
      <repository>
        <id>central</id>
        <url>https://repo1.maven.org/maven2</url>
        <releases><enabled>true</enabled></releases>
        <snapshots><enabled>false</enabled></snapshots>
      </repository>
      <repository>
        <id>che-incubator</id>
        <name>GitHub navikt Apache Maven Packages</name>
      </repository>
    </repositories>
  </profile>
</profiles>
</settings>

This file is used when packaging the application in a container. When running locally, add the information to your personal settings.xml file.

9.3.3. Running the application

Run and test the application is in a CodeReady Workspaces workspace:

```bash
$ mvn quarkus:dev -Dquarkus.http.port=${CHE_WORKSPACE_TELEMETRY_BACKEND_PORT}
```

If CodeReady Workspaces is secured using a self-signed certificate, add the certificate to a trust store and mount it into the workspace. Also add the Java system property, -Djavax.net.ssl.trustStore=/<path/to/trustStore>, to the mvn command. For example, assuming the trust store is located in $JAVA_HOME/jre/lib/security/cacerts:

```bash
$ keytool -import -alias self-signed-certificate \
  -file <path/to/self-signed-certificate> -keystore $JAVA_HOME/jre/lib/security/cacerts
```

Followed by:

```bash
$ mvn quarkus:dev -Dquarkus.http.port=${CHE_WORKSPACE_TELEMETRY_BACKEND_PORT} \
  -Djavax.net.ssl.trustStore=$JAVA_HOME/jre/lib/security/cacerts
```

9.3.4. Creating a concrete implementation of AnalyticsManager and adding specialized logic

Create two new files in your project:
- **AnalyticsManager.java** contains the logic specific to our telemetry system.
- **MainConfiguration.java** is the main entrypoint that creates an instance of **AnalyticsManager** and starts listening for events.

### AnalyticsManager.java

```java
package org.my.group;

import java.util.Map;
import org.eclipse.che.api.core.rest.HttpJsonRequestFactory;
import org.eclipse.che.incubator.workspace.telemetry.base.AbstractAnalyticsManager;
import org.eclipse.che.incubator.workspace.telemetry.base.AnalyticsEvent;

public class AnalyticsManager extends AbstractAnalyticsManager {
    public AnalyticsManager(String apiEndpoint, String workspaceId, String machineToken,
                             HttpJsonRequestFactory requestFactory) {
        super(apiEndpoint, workspaceId, machineToken, requestFactory);
    }

    @Override
    public boolean isEnabled() {
        // TODO Auto-generated method stub
        return true;
    }

    @Override
    public void destroy() {
        // TODO Auto-generated method stub
    }

    @Override
    public void onEvent(AnalyticsEvent event, String ownerId, String ip, String userAgent,
                         String resolution,
                         Map<String, Object> properties) {
        // TODO Auto-generated method stub
    }

    @Override
    public void increaseDuration(AnalyticsEvent event, Map<String, Object> properties) {
        // TODO Auto-generated method stub
    }

    @Override
    public void onActivity() {
        // TODO Auto-generated method stub
    }
}
```

### MainConfiguration.java

```java
package org.my.group;
```
9.3.5. Implementing isEnabled()

For the purposes of the example, this method just returns true whenever it is called. Whenever the server is running, it is enabled and operational.

AnalyticsManager.java

```java
import javax.enterprise.context.Dependent;
import javax.enterprise.inject.Produces;

import org.eclipse.che.incubator.workspace.telemetry.base.AbstractAnalyticsManager;
import org.eclipse.che.incubator.workspace.telemetry.base.BaseConfiguration;

@Dependent
public class MainConfiguration extends BaseConfiguration {

    @Produces
    public AbstractAnalyticsManager analyticsManager() {
        return new AnalyticsManager(apiEndpoint, workspaceId, machineToken, requestFactory());
    }
}
```

9.3.6. Implementing onEvent()

onEvent() sends the event passed to the back-end to the telemetry system. For the example application, it sends an HTTP POST payload to our server. The example telemetry server application is deployed to OpenShift at the following URL: http://little-telemetry-backend-che.apps-crc.testing.

AnalyticsManager.java

```java
@Override
public boolean isEnabled() {
    return true;
}
```

It is possible to put more a complex login in isEnabled(). For example, the service should not be considered operational in certain cases. The hosted CodeReady Workspaces woopra back-end checks that a configuration property exists before determining if the back-end is enabled.

```java
@Override
public void onEvent(AnalyticsEvent event, String ownerId, String ip, String userAgent, String resolution, Map<String, Object> properties) {
    HttpClient httpClient = HttpClients.createDefault();
    HttpPost httpPost = new HttpPost("http://little-telemetry-backend-che.apps-crc.testing/event");
    HashMap<String, Object> eventPayload = new HashMap<String, Object>(properties);
    eventPayload.put("event", event);
    StringEntity requestEntity = new StringEntity(new JSONObject(eventPayload).toString(), ContentType.APPLICATION_JSON);
    httpPost.setEntity(requestEntity);
    try {
        HttpResponse response = httpClient.execute(httpPost);
```
This sends an HTTP request to the telemetry server and automatically debounces identical events in a small time period (the default is 1500 milliseconds, and it can be changed by subclasses.

### 9.3.7. Implementing `increaseDuration()`

Many telemetry systems recognize event duration. The `AbstractAnalyticsManager` merges similar events that happen in the same frame of time into one event, so that you do not get several identical events sent to the server in a small frame of time. This implementation of `increaseDuration()` is a no-op. This method uses the APIs of your telemetry provider to alter the event or event properties to reflect an increased duration of the event.

**AnalyticsManager.java**

```java
@Override
public void increaseDuration(AnalyticsEvent event, Map<String, Object> properties) {}
```

### 9.3.8. Implementing `onActivity()`

Set an inactive timeout limit, and use `onActivity()` to send a `WORKSPACE_INACTIVE` event if the last event time is longer than the inactivity timeout.

**AnalyticsManager.java**

```java
public class AnalyticsManager extends AbstractAnalyticsManager {

    ...

    private long inactiveTimeLimit = 60000 * 3;

    ...

    @Override
    public void onActivity() {
        if (System.currentTimeMillis() - lastEventTime >= inactiveTimeLimit) {
            onEvent(WORKSPACE_INACTIVE, lastOwnerId, lastIp, lastUserAgent, lastResolution, commonProperties);
        }
    }
}
```

### 9.3.9. Implementing `destroy()`

When `destroy()` is called, send a `WORKSPACE_STOPPED` event and shutdown any resources, such as connection pools.

**AnalyticsManager.java**

```java
@Override
```
Now when you run `mvn quarkus:dev` as described in Section 9.3.3, “Running the application”, you should see a `WORKSPACE_STOPPED` event sent to the server when you kill the Quarkus application.

9.3.10. Packaging the Quarkus application

See the quarkus documentation for the best instructions to package the application in a container. Build and push the container to a container registry of your choice.

9.3.11. Creating a `meta.yaml` for your plug-in.

Create a `meta.yaml` definition representing a CodeReady Workspaces plug-in that runs your custom back-end in a workspace Pod. For more information on `meta.yaml`, see Section 4.1, “What is a Che-Theia plug-in”.

```
manifests.yaml
```

```
public void destroy() {
    onEvent(WORKSPACE_STOPPED, lastOwnerId, lastIp, lastUserAgent, lastResolution,
            commonProperties);
}
```

Ordinarily, you would deploy this file to a corporate web server. For this guide, we create an Apache web server on OpenShift and host the plug-in there. Create a configMap referencing your new `meta.yaml` file.

```
$ oc create configmap --from-file=meta.yaml -n che telemetry-plugin-meta
```

Then create a deployment, a service, and a route to expose the web server. The deployment references this configMap and places it in the `/var/www/html` directory.

```
manifests.yaml
```

```
kind: Deployment
```
apiVersion: apps/v1
metadata:
  name: apache
namespace: <workspaces>
spec:
  replicas: 1
selector:
  matchLabels:
    app: apache
template:
  metadata:
    labels:
      app: apache
  spec:
    volumes:
    - name: plugin-meta-yaml
      configMap:
        name: telemetry-plugin-meta
        defaultMode: 420
    containers:
    - name: apache
      image: 'registry.redhat.io/rhscl/httpd-24-rhel7:latest'
      ports:
        - containerPort: 8080
          protocol: TCP
          resources: {}
      volumeMounts:
        - name: plugin-meta-yaml
          mountPath: /var/www/html
    strategy:
      type: RollingUpdate
      rollingUpdate:
        maxUnavailable: 25%
        maxSurge: 25%
        revisionHistoryLimit: 10
        progressDeadlineSeconds: 600
---
kind: Service
apiVersion: v1
metadata:
  name: apache
namespace: <workspaces>
spec:
  ports:
  - protocol: TCP
    port: 8080
    targetPort: 8080
  selector:
    app: apache
type: ClusterIP
---
kind: Route
apiVersion: route.openshift.io/v1
metadata:
  name: apache
namespace: <workspaces>
$ oc apply -f manifests.yaml

Wait a few minutes for the image to pull and the deployment to start, and then confirm that `meta.yaml` is available in the web server:

$ curl apache-che.apps-crc.testing/meta.yaml

This command should return the `meta.yaml` file.

9.3.12. Updating CodeReady Workspaces to reference your telemetry plug-in

Update the `CheCluster` Custom Resource, and add the `CHE_WORKSPACE_DEVFILE_DEFAULT__EDITOR_PLUGINS` environment variable to `spec.server.customCheProperties`. The value of the environment variable should be the URL of the location of the `meta.yaml` file on your web server. This can be accomplished by running `oc edit checluster -n che` and typing in the change at the terminal, or by editing the CR in the OpenShift console (Installed Operators → Red Hat CodeReady Workspaces → Red Hat CodeReady Workspaces Cluster → codeready-workspaces → YAML).

apiVersion: org.eclipse.che/v1
kind: CheCluster
metadata:
  creationTimestamp: '2020-05-14T13:21:51Z'
finalizers:
- oauthclients.finalizers.che.eclipse.org
generation: 18
name: codeready-workspaces
namespace: <workspaces>
resourceVersion: '5108404'
selfLink: /apis/org.eclipse.che/v1/namespaces/che/checlusters/eclipse-che
uid: bae08db2-104d-4e44-a001-c9affc07528d
spec:
  auth:
    identityProviderURL: 'https://keycloak-che.apps-crc.testing'
    identityProviderRealm: che
    updateAdminPassword: false
    oAuthSecret: ZMmNPRbgOJJQ
    oAuthClientName: eclipse-che-openshift-identity-provider-yrlcxys
    identityProviderClientId: che-public
    identityProviderPostgresSecret: che-identity-postgres-secret
    externalIdentityProvider: false
    identityProviderSecret: che-identity-secret
    openShiftoAuth: true
database:
Wait for the CodeReady Workspaces server to restart, and create a new workspace. You should see a new message saying that your plug-in is being installed into the workspace.

Perform a some operations in the workspace you started. You should see those events in the logs of the example telemetry server.

9.3.13. Summary

In this guide, you:

- Created a telemetry server to echo events to standard out.
- Extended the CodeReady Workspaces telemetry client and implemented your own custom back-end.

- Created a meta.yaml file to represent a CodeReady Workspaces workspace plug-in for your custom back-end.

- Told CodeReady Workspaces where to find your custom plug-in by changing the CHE_WORKSPACE_DEVFILE_DEFAULT__EDITOR_PLUGINS environment variable.

### 9.4. THE WOOAPRA TELEMETRY PLUGIN

The **Woopra Telemetry Plugin** is a plugin built to send telemetry from a Red Hat CodeReady Workspaces installation to Segment and Woopra. This plugin is used by Hosted Che, but any Red Hat CodeReady Workspaces deployment can take advantage of this plugin. There are no dependencies other than a valid Woopra domain and Segment Write key. The link:https://raw.githubusercontent.com/che-incubator/che-workspace-telemetry-woopra-plugin/master/meta.yaml [plugin’s meta.yaml] file has 5 environment variables that can be passed to the plugin:

- **WOOPRA_DOMAIN** - The Woopra domain to send events to.

- **SEGMENT_WRITE_KEY** - The write key to send events to Segment and Woopra.

- **WOOPRA_DOMAIN_ENDPOINT** - If you prefer not to pass in the Woopra domain directly, the plugin will get it from a supplied HTTP endpoint that returns the Woopra Domain.

- **SEGMENT_WRITE_KEY_ENDPOINT** - If you prefer not to pass in the Segment write key directly, the plugin will get it from a supplied HTTP endpoint that returns the Segment write key.

To enable the Woopra plugin on your Red Hat CodeReady Workspaces installation, deploy the meta.yaml file to an HTTP server with the environment variables set correctly. Then, edit the CheCluster Custom Resource, and set the spec.server.customCheProperties.CHE_WORKSPACE_DEVFILE_DEFAULT__EDITOR_PLUGINS field:

```yaml
spec:
  server:
    customCheProperties:
      CHE_WORKSPACE_DEVFILE_DEFAULT__EDITOR_PLUGINS: 'eclipse/che-machine-exec-plugin/7.20.0,https://your-web-server/meta.yaml'
```